Information and Communication Technology
Grade 11
2008

Teachers’ Instruction Manual

Department of Information Communication Technology
National Institute of Education
Sri Lanka
Message of the Director General

The first curriculum revision for the new millennium is based on the elimination of the several problems obtaining in the present education system. The present curriculum reforms have been planned having identified the problems that youth face consequent to the weakening of their thinking abilities, social abilities as well as personal abilities and step by step exploration of factors leading to this situation, to overcome which, the necessary background was prepared.

Compared to the other countries in the Asian region, our country took the lead in education in earlier years. But most countries in this region have surpassed Sri Lanka in education today. Some factors that influenced this deterioration are the action taken by educational institutions to continue to take steps to confirm the known, learn that which had been decided on earlier, and reconstruct that which was, in the same form itself.

All these matters have been taken into consideration by the educationists of the National Institute of Education who have endeavoured to prepare the new curriculum on the basis of a distinct philosophy. The primary objective here is to change that which is known, explore that which is new and develop that which is necessary for tomorrow and build up a generation of students who can display their readiness for a successful future. But there is no necessity to reiterate, the need for a visible change in the teacher’s role for the realization of this objective. In place of the obvious transactional teacher role presented in our classrooms so far, the Sri Lankan school teacher will have to understand and conform to a student-centered, competency based and activity focused, transformational role.

It is our firm belief that this Teacher Instruction Manual will serve you as an aid to become an effective teacher through the provision of numerous instructions that will help you adapt to the new situation. Through the study of these instructions you will be provided the opportunity of making your daily teaching as well as the evaluation task, easy. There is no doubt that instructions for student exploration and other quality inputs will help facilitate the teacher’s task. Similarly, the Teacher Instruction Manual will help convey to school principals valuable information they can use in time-tabling, sharing of limited resources and internal supervision.

My sincere thanks go to Dr. Mrs. I. L. Ginige, Assistant Director General (Curriculum Development) Science & Technology Faculty of National Institute of Education for her direct involvement in the preparation of this Teacher Instruction Manual that will serve an immense purpose in the task performed at school level by the sections above and also teacher educationist involved in beginning or continuous teacher educational matters, in-service advisors as well as officers at various levels, involved in external supervision plus monitoring programmes.

Professor J. W. Wickramasinghe
Director General
National Institute of Education
Preface

The first curriculum reform for the millennium implemented with the aim of preparing a powerful basis for a new Sri Lanka anticipates a visible transformation of the teacher’s role. The three main sections below are included in the Teachers Instruction Manual prepared with the objective of providing the teacher with the necessary support in this regard.

- Detailed Syllabus
- Activity Continuum that helps in the implementation of the syllabus
- Instruments for the extension of the learning teaching process.

Teachers have been provided the opportunity of understanding several basic matters that have been taken into consideration in the preparation of the curriculum for the detailed syllabus extending beyond subject topics and sub-topics. Competency levels that correspond to subject competency have been included in this section that commences with an introduction to the factors and subject aims that formed the basis of the new syllabus. One special features of this section is that, while the knowledge-base determined under competency level each student needs to develop has been introduced as the subject content the multiple learning and teaching methods employed in transmitting this section to the student has also been taken into consideration in determining the time frame with respect to each competency level.

The final part of the detailed syllabus presented under the heading “School Policy and Programs” needs to be studied very carefully and understood by every instructional leader. This section provides school managers a range of valuable instructions to assist them in the allocation for teaching, subject-teaching assigning functions to teachers, implementing co-curricular activities as well as supervision of the teacher’s task. The second section of the Teacher Instruction Manual has been prepared with the objective of providing teachers with clear understanding of the proposed learning-teaching methodology. This section commences with the introduction of the methods of planning activities under competency-based education as well as the change in the teacher’s role. Although the activity continuum necessary for the implementation of the curriculum has been introduced next, the implementation of the proposed activity in the very same manner is not expected of teachers. The teacher should endeavor to make use of his / her creative, as well as critical thinking abilities and adapt these activities in a manner that suits one’s class, best. Although instructions have been provided on the constitution of groups in keeping with the facets of the problems subject to exploration, the teacher is expected to take an intelligent decision on the number of groups based on number of students in the class.

Time has been allocated for activities to ensure achievement of the relevant competency levels. Therefore, teachers may have to exceed the 40-minute period. While each activity has been provided adequate time for the actualization of each competency level, the teacher is expected to make use of single or double periods in the time table and breakdown these activities, as suitable, in implementing them. For the success of the procedure, it is essential that every time an activity commenced the previous day is carried over to the following day, that a brief summary of the part of the activity completed the previous day is presented to the class. Similarly, this decision will provide the school community with the opportunity of involving students in effective learning where teachers obtain leave of absence. The final item in this section is a list of quality inputs necessary for the maintenance of the quality of subject learning and teaching, when taken as a whole. As such, the teacher has the choice of ordering out the necessary learning-teaching materials in time and having them on hard.

Included in the third part of the teacher Instruction Manual under the title “Assessment and evaluation” are a number of important hints to ensure that the expected results of the exercise are realized.
This section has been so structured as to introduce matters related to the assessment and evaluation that should take place under each activity, extension of the learning and teaching that takes place based on activity groups and the nature of the questions that might be expected in general examinations. It must be pointed out that the primary responsibility of the teachers is to identify instances where assessment and evaluation can be implemented in the course of each activity and to carry out this task successfully on the basis of common criteria. The set of instruments prepared with a range of activities as the objective for the purpose of extending learning and teaching provide students with the opportunity of involvement in continuous learning outside the recommended classroom sessions. While it is the task of the teacher to regularly examine the learning students receive, based on these instruments, and encourage them, arriving at a correct decision regarding the final results of the activities and communicating that decision to the relevant parties is expected of the teacher. It is essential that a visible change takes place in general examinations for the success of the learning-teaching process. The National Institute of Education, with the assistance of the Sri-Lanka Department of Examinations, has introduce several prototype questions for educational levels that terminate with these examinations. Since this change in examination question papers has been suggested in order to direct students to learn through practice and experience, instead of resorting to mechanical approaches like memorizing or answering model question papers, the education of school students and parents about this change should commence at the beginning itself.

All teachers should realize that various activities can be developed for the achievement of any particular competency level. Accordingly, they should be prepared for more successful teaching through the use of better approaches, exploration, as well as instruments for the extension of learning and teaching.

The present Teacher Instruction Manual will give teachers right throughout the country the courage to effect a visible change in the teacher’s role and prevent their becoming inactive in the presence of new approaches. Similarly, we expect to award certificates and provide numerous development opportunities to teachers who go beyond the activities to involve themselves in the innovation of novel creations. What teachers have to do in order to become eligible to the awards is to improve these activities, using their creative thinking, and present them. Learning-teaching plans prepared in this manner outside the basic activity plan, should be forwarded to Assistant Director General (Curriculum Development), Science and Technology faculty, National Institute of Education, Sri Lanka. Selection of those entitled to awards will be made subsequent to the study of these activities by the relevant subject committees.

We have endeavoured in this manner, to bring learning-teaching assessment and evaluation on to the same platform through new methodologies. According to this, teachers will be provided substantial latitude to meaningfully handle the learning-teaching process, school-based assessment, as well as assignment of home-work. It is our firm conviction that the school system of Sri Lanka will, make maximum use of this aid and depart from orthodox learning-teaching approaches to enhance the thinking abilities, social abilities as well as the individual abilities of the sons and daughters of the country.

Dr Indira Lilamani Ginige  
Assistant director general (Curriculum Development),  
Science and technology faculty,  
National Institute of Education,  
Sri Lanka
**Guidance:**
Prof. J. W. Wickramasinghe  
Director General  
National Institute of Education

Dr. I. L. Ginige  
Assistant Director General  
Faculty of Science and Technology  
National Institute of Education

Mr. Upul Dayaratna  
ISA (IT)  
Zonal Education Office  
Colombo.

Mr. S.K.N. Suriyaarachchi  
Lecturer  
Provicial ICT Centre  
Pannipitiya

**Consultancy:**
Dr. N. D. Kodikara  
Faculty Head  
University of Colombo

Mr. K. P. Niranjan Karunanyake  
Instructor - IT  
Zonal Computer Resource Centre  
Galahitlyaya

Mr. R. V. S. P. Rajapaksha  
Instructor - IT  
Zonal Computer Resource Centre  
Monaragala

**Supervision:**
Mr. H. Jayasinghe  
Director  
Department of Information Technology

Mrs. Chandavee Jayawardane  
ISA (IT)  
Zonal Education Office  
Piliyandala

Mrs. Kumari Jayathilaka  
ISA (IT)  
Zonal Education Office  
Kaluthara

Mr. S. N. Maduwage  
Chief Project Officer  
Department of Information Technology

Mr. Sisira Palihakkara  
Buddhist Girls’ M.V.  
Mount Lavinia

Dr. P.A.K.A.K Panditharathna  
Instructor  
Zonal Computer Resource Centre  
Kurunegala.

Mr. H. S. D. Kumarasinghe  
Centre Manager  
Zonal Computer Resource Centre  
Pelmadulla

**Co-ordination:**
Mrs. A. M. Kanthi  
Project Officer  
Department of Information Technology

Mrs. W.Hemawathi  
Instructor  
Zonal Computer Resource Centre  
Balangoda.

Mr. K.G. S. K. Perera  
Project Officer  
Department of Information Technology

Mr. K.M.P.U.Wimalaweera  
Instructor  
Zonal Computer Resource Centre  
Polonnaruwa.

**Resource Team:**
Mr. W. M. A. S. Wijesekera  
Centre Manager  
Zonal Computer Resource Centre  
Hali Ela

Mr. K. D. D. Percival  
Retired Lecture  
Govt. Training College  
Maharagama

Mr. N. Nobel Ravi  
Centre Manager  
Zonal Computer Resource Centre  
Nuwara Eliya

Mr. R. V. S. P. Rajapaksha  
Instructor - IT  
Zonal Computer Resource Centre  
Galahitlyaya

Mrs. Chandavee Jayawardane  
ISA (IT)  
Zonal Education Office  
Piliyandala

Mrs. Kumari Jayathilaka  
ISA (IT)  
Zonal Education Office  
Kaluthara

Mr. S. N. Maduwage  
Chief Project Officer  
Department of Information Technology

Mr. Sisira Palihakkara  
Buddhist Girls’ M.V.  
Mount Lavinia

Dr. P.A.K.A.K Panditharathna  
Instructor  
Zonal Computer Resource Centre  
Kurunegala.

Mr. H. S. D. Kumarasinghe  
Centre Manager  
Zonal Computer Resource Centre  
Pelmadulla

**Language Editing:**
Mr. K. D. D. Percival  
Retired Lecture  
Govt. Training College  
Maharagama

Copyright © 2008 National Institute of Education - Sri Lanka. All rights reserved.
# Table of Contents

1. Part 1: Syllabus
   - Subject content and time duration by competencies
     - and competency levels
     - Page 2

2. Part 2: Learning Teaching Methodology
   - Introduction
     - Page 16
   - Quality Inputs
     - Page 19
   - Activity Continuum
     - Page 21

3. Part 3: Assessment and Evaluation
   - Introduction
     - Page 367
   - Instruments for Extension of Learning and Teaching
     - Page 369
   - Prototype Questions
     - Page 380
Part 1

Syllabus
### Subject content and time duration by competencies and competency levels

<table>
<thead>
<tr>
<th>Competency</th>
<th>Competency Level</th>
<th>Content</th>
<th>Time</th>
</tr>
</thead>
</table>
| **Competency 10.** Writes programs to solve problems | 10.1 Develops algorithms to solve problems. | • Definition of algorithm.  
- Definition of problems  
  - Inputs  
  - Processes  
  - Outputs  
- Control structures used for developing algorithms  
  - Sequence  
  - Selection  
  - Repetition | 90 minutes |
| | 10.2 Uses different tools to present algorithms. | • Tools for developing algorithms  
  - Flow chart  
  - Pseudo code | 120 minutes |
| | 10.3 Explores the evolution of programming languages | • Generations of Languages  
  - First Generation  
  - Second Generation  
  - Third Generation  
  - Fourth Generation  
- Features of Languages  
- Mechanism (tools) used to convert source code to machine code  
  - Assembler  
  - Interpreters  
  - Compilers | 60 minutes |
| | 10.4 Demonstrates familiarity on the IDE of a selected Visual Programming Language | • Components of Integrated Development Environment (IDE)  
  - Tool Box  
  - Code window  
  - Design window  
  - Project explorer  
  - Properties window  
- Form layout window | 60 minutes |
| | 10.5 Manipulates features of controls | • Selection of controls  
  - Labels  
  - Text Boxes  
  - Command buttons  
- Setting properties  
  - Name  
  - Caption  
  - Background Color  
  - Font Color  
  - Font Type, Style and Size  
  - Alignment | 120 minutes |
| 10.6 | Converts simple algorithms into programs. | Controls for data Input  
  o Text Box  
  o Controls for data output  
  o Label  
  o Text Box  
  o Conversion process  
  o Coding  
  o Testing | 150 minutes |
| 10.7 | Uses constants and variables in programming. | Data Types  
  o Boolean  
  o Byte  
  o Integer  
  o Single  
  o Double  
  o Currency  
  o Date  
  o String  
  o Object  
  Variables and constants  
  o Naming  
  o Defining | 180 minutes |
| 10.8 | Uses operators in programming | Types of Operators  
  o Arithmetic operators  
  o Comparison operators  
  o Logical operators  
  o * And, Or, Not  
  o Concatenation operators  
  Operator Precedence | 90 minutes |
| 10.9 | Writes programs with objects and multiple forms | Calling Methods  
  o Show  
  o Hide  
  Events of control  
  o Single click  
  o Double click  
  o Mouse move  
  o Load  
  Scroll Bar  
  Combo box  
  Check Box  
  Option Button | 120 minutes |
| 10.10 Develops programs involving Single Condition | • Selection control structures  
  o If-Then  
  o If–Then-Else | 60 minutes |
|-------------------------------------------------|-------------------------------------------------|-------------|
| 10.11 Develops programs involving Multiple Conditions. | • Methods for using multiple conditions  
  o If –Then-Else-End If  
  o Select Case | 120 minutes |
| 10.12 Develops programs involving basic repetitions. | • No. of repetitions known  
  o For-Next loop | 60 minutes |
| 10.13 Develops programs with different methods of repetitions | • Repetition with  
  o Do-While  
  • Repetition with  
  o Do-Until | 120 minutes |
| 10.14 Develops programs using one dimensional arrays | • Definition of one dimensional array  
  • Array Operations  
  o Declaration  
  o Accessing values  
  o Assignment of values  
  o Editing | 120 minutes |
| 10.15 Manages programs through sub routines | • Sub Routine Techniques  
  o Functions  
  o Procedures  
  • Scope of variables  
  o Private  
  o Public | 120 minutes |
| 10.16 Controls programs using timer object | • Timer object  
  o Time Interval property  
  o Timer event | 45 minutes |
| 10.17 Develops programs to retrieve data from databases | • Tools for connecting databases to the application  
  o Data Environment  
  o ADO Control  
  • Controls for viewing single record  
  o Text Box  
  o Label | 180 minutes |
| 10.18 Updates records in databases | • Methods in Data Environment  
  o Add method  
  o Edit method  
  o Delete method | 90 minutes |
| 10.19 Handles data through Data Grids in Visual Programming | • Data Grid Control  
  o For viewing multiple records  
  o For updating multiple records | 90 minutes |
|----------------------------------------------------------|---------------------------------------------------------------|-----------|
| 10.20 Creates reports to retrieve data in databases. | • Report Tool  
  o For designing report  
  o For previewing report  
  o For printing report | 90 minutes |
<table>
<thead>
<tr>
<th>Competency</th>
<th>Competency level</th>
<th>Content</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>11: Designs and develops an Information System to manage information in</td>
<td>11.1 Selects suitable systems for automation</td>
<td>• Definition of system</td>
<td>120</td>
</tr>
<tr>
<td>efficient and effective manner</td>
<td>purposes</td>
<td>• Components of a system</td>
<td>minutes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o input</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o process</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o output</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Information systems</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Importance of Information</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>In decision making</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Manual systems</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Automated systems</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Organization as a system</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Independent elements of a computer based information systems</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Selecting a system to computerize</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Problem definition</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o User requirements</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o System boundary</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Resource limits</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Feasibility study</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Technical feasibility</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Operational feasibility</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Economical feasibility</td>
<td></td>
</tr>
<tr>
<td></td>
<td>11.2 Analyses systems, selected for automation</td>
<td>• Requirements of systems</td>
<td>120</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Detailed operations of the system</td>
<td>minutes</td>
</tr>
<tr>
<td></td>
<td>11.3 Designs and develops computerized systems</td>
<td>• Interface Design</td>
<td></td>
</tr>
<tr>
<td></td>
<td>for analyzed manual systems</td>
<td>• Database Design</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Selecting a Programming Language</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Coding</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| 11.4 Implements and tests for debugging of developed systems | • Testing and debugging the system for errors  
  • Implements the new system  
  o Direct Implementation  
  o Parallel Implementation  
  o Phase Implementation | 120 minutes |
|---------------------------------------------------------------|---------------------------------------------------------------|----------------|
| 11.5 Maintenance systems for smooth and continuous service     | • Operational level error handling  
  o Hardware compatibility  
  o Software compatibility  
  o Incompatible data  
  • Make changes to the system when required  
  Adding new user requirements  
  o Expansion of the organization  
  o Availability of New technology | 120 minutes |
<table>
<thead>
<tr>
<th>Competency</th>
<th>Competency levels</th>
<th>Content</th>
<th>Time</th>
</tr>
</thead>
</table>
| 12. Uses Internet for Effective Information Search and Communication     | 12.1 Uses Internet to access information               | • Introduction to Internet  
• Internet Services  
• Web site  
• Web page  
• IP address/Domain name  
• Search engines               | 120 minutes |
|                                                                          | 12.2 Communicates using email                          | • Email software  
• E-mail address  
• Domain name  
• Creating a free e-mail account  
• Sending and receiving mails               | 60 minutes |
|                                                                          | 12.3 Uses chat to exchange information                 | • Chat categories  
• Free chat services  
• Video chat/Video Conferencing  
  o Components (Web cam, Headset)  
  o Advantages and concerns               | 60 minutes |
<table>
<thead>
<tr>
<th>Competency</th>
<th>Competency Level</th>
<th>Content</th>
<th>Time</th>
</tr>
</thead>
</table>
| Competency 13: Develops Multimedia contents to express ideas effectively. | 13.1 Creates effective still graphics using suitable graphic software. | - Integrated development environment  
  - Tools options bar,  
  - Tool box,  
  - Drawing area,  
  - Pallets  
- Properties of a canvas  
  - Creating  
  - Setting properties  
  - Create a canvas  
  - Name  
  - Preset size  
  - Width  
  - Height  
  - Resolution  
  - Mode  
  - Contents  
- Use of toolbox.  
  - Elliptical Marquee Tool  
  - Move Tool  
  - Lasso Tool  
  - Crop Tool  
  - Brush Tool  
  - Clone Stamp Tool  
  - Eraser Tool  
  - Paint Bucket Tool  
  - Horizontal Type Tool  
  - Custom Shape Tool  
  - Setting background and foreground color.  
- Handling layers  
  - Concepts of layers.  
  - Operations of layers.  
  - Display and hide layers  
  - Setting opacity  
  - Setting fill  
  - Creating  
  - Deleting  
  - Duplication  
  - Setting the order  
  - Setting layer style.  
  - Drop shadow  
  - Inner shadow  
  - Stroke  
- Manipulations of images.  
  - Cut and paste  
  - Copy and paste  
  - Cropping  
  - Feather effect  
  - Cloning | 120 minutes |
## 13.2 Creates effective 2D animations using suitable 2D animations software
- **Components of working area**
  - Stage
- **Layers**
  - Insertion
  - Deletion
  - Renaming
- **Frames**
  - Blank frame
  - Key frame
  - Blank key frame
- **Property inspector**
  - Basic Tools
  - Arrow Tool
  - Text Tool
  - Oval Tool
  - Rectangle Tool
  - Eraser Tool
  - Free Transform Tool
- **Animation types**
  - Frame-by-Frame
  - Shape Tweening
  - Motion Tweening
- **File operations**
  - Creating
  - Saving
  - Opening
  - Publishing

### Components
- **Stage**
- **Layers**
- **Frames**
- **Property inspector**
- **Animation types**
- **File operations**

### Animation types
- Frame-by-Frame
- Shape Tweening
- Motion Tweening

**Time:** 120 minutes

## 13.3 Creates Audio contents using suitable sound editing software
- **Handling sound files**
  - Recoding
  - Saving
  - Editing
  - Deletion of part of the file
  - Mixing of sound files
- **Addition of special effects**
  - Changing Volume
  - Changing the speed of play
  - Addition of echo
  - Reversing of sound

**Time:** 90 minutes

## 13.4 Effectively integrates multimedia contents
- **Integration of background images with animations**
- **Integration of sound with animations**

**Time:** 120 minutes
<table>
<thead>
<tr>
<th>Competency 14: Develops simple websites incorporating Multimedia Technology.</th>
<th>Competency Level</th>
<th>Content</th>
<th>Time</th>
</tr>
</thead>
</table>
| 14.1 Structures information for development of websites |  | • Components of a web site  
  o Home Page  
  o Linked pages  
  • Text organization techniques  
  o Formats  
  o Columns  
  o Lists  
  o Tables  
  • Reasons for integrating multimedia  
  • Reasons for mouse pointer changes  
  • Links  
  • Ethical issues in provision of information  
  o Copyrights  
  o Harmless and moral. | 120 minutes |
| 14.2 Develops web sites using web development tools |  | • Web authoring tools  
  o Text Formatting  
  o Page Layout  
  o Multimedia Integration  
  o Hyperlinks | 120 minutes |
| 14.3 Develops simple web sites using HTML |  | • Feature of HTML  
  • HTML Tags  
  o Text Format  
  o Lists  
  o Tables  
  o Graphics  
  o Hyperlinks  
  • Differences between HTML and XML | 160 minutes |
| 14.4 Demonstrates preparedness to publish web sites |  | • Internet Service Providers for Web Publishing  
  o Fee levying  
  o Non Fee Levying  
  • Requirements for Web Publishing  
  o Web server  
  o Domain names  
  o Internet Protocol  
  o URLs | 120 minutes |
<table>
<thead>
<tr>
<th>Competency</th>
<th>Competency level</th>
<th>Content</th>
<th>Time</th>
</tr>
</thead>
</table>
| Competency 15: Compares and contrasts benefits and issues related to ICT in society | 15.1. Investigates the contribution of ICT to the health services | • ICT in Health services  
• Tele Medicine  
o Tele monitoring  
o Tele videconferencing  
• Computer controlled medical equipment  
o Computer Axial Tomography (CAT) scanner  
o Magnetic Resource Image (MRI)  
o Electroencephalograph (EEG)  
• Maintenance of medical history records.  
o Diagnosis  
o Medication  
o Test reports | 45 minutes |
| | 15.2. Investigates the contribution of ICT to education | • ICT in Education  
• Learning and teaching  
o Computer Assisted Learning (CAL)  
o eLearning  
• Learning Management System  
• School Management Information System | 45 minutes |
| | 15.3. Investigates the contribution of ICT to agriculture | • ICT in Agriculture  
• Computer controlled agricultural equipment  
o Green house  
• Information searching on agriculture  
• Virtual competitive market for agricultural products  
• Optimization of agricultural productivity  
o Detection and control of pests  
o Optimization of fertilizer use  
o Weather prediction | 45 minutes |
15.4. Investigates the contribution of ICT to industries

- ICT in Industries
- Computer Aided Design (CAD) and Computer Aided Manufacture (CAM)
- Robotics
- Computerized machines in production

| Time | 45 minutes |

15.5. Explores the contribution of ICT to Business

- On line shopping
- On line Share market transactions
- Advertising

| Time | 45 minutes |

15.6 Explores the contribution of ICT to Entertainment

- Movies and songs
- Games
- Simulations

| Time | 45 minutes |

15.7. Assesses issues related to ICT with respect to ethical and legal aspects

- Legal Issues
  - Software Piracy
  - Software theft
  - Unauthorized access to systems
  - Copyright
  - Patent
- Ethical issues

| Time | 45 minutes |

15.8. Explores issues and precautions related to ICT with respect to security aspects

- Physical Security
  - UPS
  - Surge protectors
  - lightening arrestors
- Environmental factors
  - Dust
  - Humidity
  - Temperature
- Logical Security
  - Passwords
  - Backups
- Protection against malicious codes
  - Viruses
  - Worms
  - Trojan Horse
  - Spy ware
  - Blended Threat
- Firewall

| Time | 90 minutes |
| 15.9. Investigates health and safety issues inherent in ICT use | Health and safety Issues  
Ergonomics and Health issues  
- Repetitive Strain Injuries  
- Eye strain  
- Back aches | 60 minutes |
| 15.10. Assesses Social issues inherent in ICT use | Social Issues  
- Digital divide  
- Digital bridge  
- Techno-rich employment Opportunities | 45 minutes |
Part 2

Learning – Teaching Methodology
Introduction

In deciding upon the learning teaching methodology relevant to the course, attention has been paid
to the planning of learning-teaching activities so as to facilitate building up of student competencies
based on exploration. In preparing for competency-based education, in this manner, an obvious
change in the role of the teacher is expected.

The transmission role practiced in our classroom from way back and the more recently introduced
transaction role is evident in the classroom even in the present day. When taking the deterioration
of the thinking skills, personal skills and social skills of school leavers into consideration, it needs no
effort to understand that there is a need for the development of the learning-teaching methodology
and some conception on how it should be effected.

In the transmission role while the teacher is considered an individual who knows everything, his task
has become that of considering the student as one who does not know anything and of transmitting
knowledge to him. This learning-teaching process that takes the guise of lectures is restricted only
to the flow of knowledge from the teacher to the student, does not make an adequate contribution
either to the stimulation of student thinking or to the development of his personal and social skills.

The dialogue initiated by teachers within the class is the initial stage of the transaction role apart
from the ideas that flow from the teacher to the class and from the class to the teacher. These
dialogues get gradually transformed into discussions as a result of the student-student interaction
that takes place subsequently. The teacher is continuously involved in the task of questioning in
order to take the student from the known to the unknown, from the simple to the complex and from
the concrete to the abstract.

While, in competency-based education, student tasks occupy a powerful position, the teacher
occupies the position of a resource person who mediates in order to provide every student in the
class with at least the competency proximate to each relevant competency. For this purpose, the
basic functions the teacher is expected to perform include planning of a learning environment
consisting of the materials and other facilities necessary for learning, close observation of how
students learn, identification of student abilities and inabilities and the promotion of student learning
through feedback and provision of feed-forward as well as the preparation of instruments of
assessment for the extension of learning beyond the classroom. The teacher’s role, based
eventually upon the tasks above, is called the transformation role.

The series of activities that can be used in the implementation of the descriptive curriculum
introduced in the first part of this course guide, has been included in its second part. Each of these
activities has been developed to contain a minimum of three steps. It is expected to get the student
involved in the learning process through the first step of the activities. As such, this step is called
the “Engagement” step. As an introduction to this step, the teacher assumes the Transaction role
and engages in a dialogue with the students. Later, along with the transformation of this dialogue to
discussion, the students engage in exploration and are provided the opportunity to recall the pre-
knowledge related to the basic competency they should develop and to acquire a clue regarding the
future of the activity. The teacher possesses a host of strategies that can be used in these
exchanges of ideas. Some of the devices at the disposal of the teacher for the exchange of these
ideas are questioning/stimulants like pictures, newspaper advertisements and flash cards/use of
puzzles or case studies/dialogues, role play, poems, songs and demonstrations, video tapes or
audio tapes. In summary, the first step of the activities is implemented with the objective of
actualizing the three objectives below.
• Winning over of the attention of the class.
• Providing the students with the opportunity for their recall of the necessary pre-knowledge.
• Introducing the elements of the explanation the students are expected to be directed to under the second step of the activity.

It is with the objective of providing the students with the opportunity of Exploration that the second step of the activity has been planned. Students base their exploration on a special leaflet prepared for the purpose. The teacher has to plan this explanation to enable the students to engage in cooperative learning through the exploration of various aspects of the problem, in groups. Some of the most important qualities of this step are involvement in the meaningful group discussions and the use of the resource materials provided. As a result of involvement in group activities through a long period of time, student will acquire the ability to develop a number of skills like self-discipline, listening to others, working co-operatively with others, helping them, management of time, effecting creations of high quality, honesty etc. In directing students to exploration, while the teacher should avoid taking decisions regarding leadership, he should build up the background necessary for leaders to surface. Accordingly, the students will have the privilege of taking on leadership when opportune, based on hidden abilities.

During the 3rd step of the activity, every group will get the opportunity of presenting the results of its exploration for the enlightenment of the others. What the teacher has to do here is to encourage students to group presentations. It would be effective if students are directed in order to ensure that every member is given responsibility in the planning of the presentation. An important quality of this step, related to the explanation of student findings, is the creation of the opportunity for the voice of students to be heard in the classroom where, mostly the voice of the teacher had dominated.

After the explanation of the findings in the third step of the activities, students should be directed to elaboration. Each group is given the opportunity to provide constructive suggestions on its findings first, and subsequently, members of other groups are given this opportunity. Anyway the final review is the responsibility of the teacher. The teacher is expected to touch on all the important points relevant to the students’ exploration.

The main responsibility of the teacher in this learning teaching process is to monitor continuously, whether the classroom learning-teaching process is implemented as effectively, as expected. While assessment and evaluation should be made use of for this purpose, the teacher is provided the opportunity, through planned activities, in the learning teaching process itself. The teacher is given the opportunity for assessment while the students are involved in exploration during the second stage of the activity and for evaluation when the students are involved in explanation and expansion during the third stage. A detailed inquiry into assessment and evaluation will be provided later on in this document.

The teacher is provided directions on the transformation role by the learning–teaching methodology described so far. While priority is given to group exploration here, the teacher is also afforded the opportunity for transaction, discussion and short lectures. While there is room for transaction and discussion, the teacher may also give a short lecture, under review, in the final stage. In the development of the learning-teaching methodology related to this curriculum, the first to be introduced under the curriculum reforms for the new millennium, the attention paid to the important features relevant to the transmission as well as the transaction roles of the teacher, apart from the transformation role, is a special feature of this methodology.

The learning-teaching process can be broadened through the improvement of the evaluation program. For this purpose the teacher has the opportunity of creating several evaluation situations through an activity continuum. The program of assessment can be made meaningful by dividing the activity continuum to several activity clusters to facilitate identification of evaluation points. It is necessary that the evaluation instrument being used with respect to each activity is introduced to the students at the beginning of every activity cluster. It is also necessary in the selection of learning
varieties, that are those activities where student motivation to learn are helped to blossom forth, is selected. Below is a list of the relevant activities.

- Concept maps
- Wall newspapers
- Quizzes
- Question and answer books
- Portfolios
- Exhibitions
- Debates
- Panel discussions
- Seminars
- Impromptu speeches
- Role-play
- Presentation of literature reviews
- Field books/ nature diaries
- Practical tests
Quality Inputs

A classroom environment replete with quality inputs is necessary for active education. The inputs referred to here can be utilized for purposes of Information and communication technology. Some of these equipment may be obtained from the various sections of the school. It is important that this equipment is introduced to the students. In the course of the lesson it becomes necessary for students to be introduced, physically, to certain peripherals. It is true that certain schools do have such equipment but there are others that don’t. The lesson can be, all the more enriched, if students are afforded the opportunity of viewing such material. It is left to the ingenuity of the teacher to find the necessary equipment, possibly on loan basis.

- Fully equipped computer lab with multimedia projector.
- Demy sheets
- Markers
- Half sheets
- A4 sheets
- Felt pens
- Diskettes
- Counter frames
- A simple circuit built on a circuit board.
- Scanners, digital cameras, printers, speakers and other peripherals available in the lab.
- Different types of machines. (Manually operated machine like coconut scraper, Grinder, Grater.)

Drawings or Diagrams

- Picture, illustrating the use of ICT in society.
- Picture on the evolution of the human being
- Pictures with descriptions of computer peripherals
- Labeled diagram of starting Window of Word Processing application
- Labeled diagram of Keyboard layout.
- Labeled diagram of Starting Window of Spreadsheet
- Labeled diagram of formatting tool bar
- Printouts of Home Page layouts
- A poster on hobbies
Activity Continuum
Competency Level 10.1: Develops algorithm to solve problems.


Time : 90 minutes.

Quality Inputs : ● Table in Annexe 10.1.1 presented on the board
● Four copies of group exploration instructions in Annexe 10.1.2
● Four copies of reading material in Annexe 10.1.2

Learning – Teaching Process:

Step 10.1.1 : ● Draw the attention of the class to the table on the board.
● Request a volunteer to interpret the columns in the table.
● Get another volunteer to complete the table and explain what has been done.
● Lead a discussion to highlight the following.

(15 minutes)

Step 10.1.2 : ● Divide the class into four groups.
● Provide each group with exploration instructions, demy sheet and pastel.
● Assign problems at random and involve them in the exploration.
● Prepare them for an innovative whole class presentation.

(30 minutes)
Step 10.1.3 :

- Get the groups to present their findings.
- Request the presenters themselves to fill in any gaps they have left.
- Invite constructive comments from other groups.
- Conclude the session by highlighting the following.

- Problem solving consists of inputs, process and outputs.
- The solution to a problem is output.
- To get the output, the input should be processed.
- The computer needs instructions to process data.
- The step-by-step description of solving a problem is known as an algorithm.
- The steps of an algorithm flows in a sequential manner

- Input, process and the output for the table in Annexe 10.1.1. are as follows.
  - **Input** : Marks obtained for Physics (Mark 1), Chemistry (Mark 2) and Biology (Mark 3)
  - **Process** : Total = Mark 1 + Mark 2 + Mark 3  
    Average = Total / 3
  - **Outputs** : Total and Average

(25 minutes)

Criteria for assessment and evaluation

- Names the three major components of the problem solving process and describes them.
- Accepts that algorithms lay the foundation for computer programming.
- Analyses problems to develop algorithms.
- Engages systematically in tasks to achieve success.
- Makes findings meaningful by using a variety of modes for representation.
Annexe 10.1.1

Instructions for the Group exploration

Let's develop a step-by-step method for solving of problems

- You will be working in four groups with the following four problems assigned randomly to the four groups.
  - Finding total marks of one student.
  - Finding the average marks of one student.
  - Finding the area of a rectangle of given length and width
  - Finding the balance Physics practical books required for students.

- Study the problem given and identify the inputs, process and output.
- Identify the steps that you take to convert the input to output.
- Write down the steps you take to solve the problem.
- Be prepared for an innovative presentation at the plenary.

Annexe 10.1.2

<table>
<thead>
<tr>
<th>Serial No</th>
<th>NAME</th>
<th>Biology</th>
<th>Chemistry</th>
<th>Physics</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>Amal</td>
<td>25</td>
<td>36</td>
<td>46</td>
</tr>
<tr>
<td>002</td>
<td>Bimal</td>
<td>59</td>
<td>66</td>
<td>69</td>
</tr>
<tr>
<td>003</td>
<td>Chamal</td>
<td>45</td>
<td>98</td>
<td>65</td>
</tr>
<tr>
<td>003</td>
<td>Dinithi</td>
<td>63</td>
<td>74</td>
<td>41</td>
</tr>
<tr>
<td>004</td>
<td>Erosha</td>
<td>89</td>
<td>65</td>
<td>23</td>
</tr>
</tbody>
</table>

Table-1

A

B

C

D

AB=18cm, AC=7cm

Figure-1

<table>
<thead>
<tr>
<th>Number of students</th>
<th>Number of Physics practical books</th>
</tr>
</thead>
<tbody>
<tr>
<td>45</td>
<td>31</td>
</tr>
</tbody>
</table>

Table-2
Annexe 10.1.3

Reading Material.

What is an algorithm?
Algorithm is the step-by-step method that is used to solve a problem.

Stages of solving a problem using a computer
- Analyzing the problem in terms of input, process and output.
- Developing an Algorithm for the problem
- Writing a Computer Program
- Testing the Computer program

Writing a computer program involves performing the above tasks.

Analyzing the problem.
Analyze the program very carefully. Understand the inputs, process and output of the program.

Developing an Algorithm for the problem
Suggests a solution for the problem that analyzed in the first stage. The method that is used to solve the problem is called the algorithm. An algorithm can be represented in two ways.
- Graphically (Flow chart method)
- Textually (Pseudocode method)

Writing a Computer Program
Converts the designed task (algorithm) into a Programming language. This is also called coding.

Testing the Computer program
Runs the program to test whether it performs the operations correctly. In case of errors with the code, the programmer must correct the code. This is called debugging.

An example for designing an algorithm for adding three marks.

1. Input: 1st mark, 2nd mark, 3rd mark
2. Process: Total = 1st mark + 2nd mark + 3rd mark
3. Display: Total

An example for Designing an algorithm for adding marks and dividing by number of subjects.

1 Input: 1st mark, 2nd mark, 3rd mark
2 Process: Average = (1st mark + 2nd mark + 3rd mark) / number of subjects
3 Display: Average

An example for Designing an algorithm to find the area of the rectangle, multiplying length and width
1 Input: The length and the width of rectangle
2 Process: Area of rectangle = length \times width
3 Display: Area

An example for Designing an algorithm to find the number of Physics practical books required for the class.

3 Input: Number of students in the class, number of Physics practical books available
4 Process: required books = Number of students in the class - number of Physics practical books
3 Display: Required books
Competency Level 10.2: Uses different tools to present algorithms.

Activity 10.2 : Let’s learn different design methods of solving problems.

Time : 120 minutes.

Quality Inputs : ● Four copies of group exploration instructions in Annexe 10.2.1.
● Four copies of reading material on Flow chart containing Flow chart & Pseudo code in Annex 10.2.2
● Demy sheets and markers.

Learning – Teaching Process:

Step 10.2.1 : ● On the board demonstrate the disordered steps of an algorithm

● Involving finding total, average of three subjects, area of the rectangle and number of Physics practical books required for the class.
● Get students to suggest the correct order of the flow.
● Conduct a discussion to highlight the following.

(20 minutes)

Step 10.1.3 : ● Divide the class into 4 groups.

● Provide each group with group exploration instructions, reading material, demy sheet and marker.
● Involve the groups in the exploration.(40 minutes)
Step 10.2.3:

- Get the groups to present its algorithm.
- Invite the groups to submit their constructive comments.
- Conclude the session by highlighting the following.

Criteria for assessment and evaluation

- Describes the ways of presenting an algorithm & the difference between Flowchart & Pseudo code.
- Accepts that the design of an algorithm helps the programmer to develop the program.
- Designs algorithms
- Demonstrates ability to think logically.
- Analyzes problems.
Annexe 10.2.1

Instructions for the Group exploration
Let’s learn different tools of presenting an algorithm.

- You will be working in four groups with the following problems assigned randomly to the groups.
  
  1. Represent graphical and textual representations for the total marks of three subjects for one student.
     
     Refer to figure1 in Annexe 10.1.2.
  
  2. Represent graphical and textual representations for the average marks of three subjects for one student.
     
     Refer to figure1 in Annexe 10.1.2.
  
  3. Represent graphical and textual representations for surface area of the rectangle.
     
     Refer to figure2 in Annexe 10.1.2.
  
  4. Represent graphical and textual representations for number of Physics practical books required for the class.
     
     Refer to figure3 in Annexe 10.1.2.
  
- Read carefully and understand.
- Discuss the task assigned to your group with the others in the group.
- Find out what the Input, Output and Process of each problem is.
- Design algorithms using a flow chart & Pseudocode on the demy sheets given.
- Be prepared to present your findings at the plenary session.
Reading Material

Flowchart

A graphical representation of the sequence of operations in a program is called Flow Chart. A flowchart shows how data flows and operates.

Symbols used in a flow chart

1. Flow chart to add two numbers
Pseudocode

Pseudocode is a shorthand way of describing a computer program. Rather than use the specific syntax of a computer language, a more general wording is used. Using pseudocode, it is easier for a non-programmer to understand the general workings of the program.

1. Pseudo Code for adding two numbers

   Begin
   Input first number and second number
   Total = first number+ Second number
   Output Total
   End
Competency Level 10.3: Explores the evolution of programming languages

Activity 10.3.: Let's explore the evolution of programming languages.

Time: 60 minutes.

Quality Inputs:
- Four copies of group exploration instructions in Annexe 10.3.1
- Four copies of reading material on stages of solving problem in Annexe 10.3.2
- Four copies of A table with headings in Annexe 10.3.3

Learning – Teaching Process:

Step 10.3.1:
- Ask volunteers to name what human languages are used to communicate with the world.
- Request a volunteer to reason out why we use human languages.
- Conduct a discussion to highlight the following.

(10 minutes)

Step 10.3.2:
- Divide class into 4 groups.
- Distribute copies of the exploration instructions, a table including some headings.
- Ask them to complete the table.
- Involve the groups in the exploration.

(25 minutes)

Step 10.3.3:
- Get the groups to present their findings.
- Request the presenters themselves to fill in any gaps they have left.
- Invite constructive comments from the other groups.
- Conclude the session by highlighting the following.
Criteria for assessment and evaluation

- Describes and lists out the evolution of programming languages.
- Accepts the need to study the past and the present to be prepared for the future.
- Traces the evolution of the programming language generation.
- Learns from peers.
- Organizes information systematically.
Annexe 10.3.1

Instructions for the Group exploration
Let's explore the evolution of programming languages.

• You will be working in four groups with the following four tasks assigned randomly to the four groups. See the Annexe 10.3.3 and fill the table.
  o Finding the special features or changes in First Generation Computer Language.
  o Finding the special features or changes in Second Generation Computer Language.
  o Finding the special features or changes in Third Generation Computer Language.
  o Finding the special features or changes in Fourth Generation Computer Language.
• Go through the reading material and identify the features or changes in relevant programming language generation.
• Be prepared to present your findings at the plenary session.
Annexe 10.3.2

Reading Material

Computer programming Languages

A programming language is a set of rules that provides a way of telling a computer what operations to perform.

Evolution of Computer Languages.

1. First Generation Computer language (Machine Language).
   - Program written in machine code (using 0 and 1)
   - Too many instructions
   - Machine dependent language
   - Programmer should know the hardware of computer too.
   - Translator was not wanted.
   - Program processing speed is fast.

2. Second Generation Computer Languages (Assembly Languages).
   - Less instructions
   - Called Symbolic Languages as symbols were used in the program.
   - A special translator called assembler is used to convert the symbols into zeros and ones.
   - It is too machine dependant.
   - Processing speed slow than 1st GL

3. Third Generation Computer Languages (High Level Languages).
   - Program writing is less complex because of the vocabulary which is easy and simple to learn.
   - It can be called a procedural language.
   - FORTRAN, COBOL, Pascal, C, Java.
   - Error diagnostic messages given and easy to test.
   - It is machine independent.
   - Training a programmer is easy.
   - Needs a translator.

   - Used to program computers to make decisions in real-life situations
   - Used to build expert systems.
   - Programming computers to understand natural human languages.
   - Used in robotics to program computers to see and hear and react to other sensory stimuli.
   - The two most common are LISP and Prolog.

Programming language translators
Translators are computer programs that translate text written in a computer language into machine language. The original program is called the source code and the translated program called object code. There are three types of language translators.

**Compiler**
A compiler translates all the programming statements of the source program into a machine language program, which is then executed at once.

**Interpreter**
Interpreter translates interactively each programming statement into an immediately usable machine language instruction. An interpreter slows down the execution speed of a program to some extent.

**Assembler**
Assembler creates object code by translating assembly instruction mnemonics into machine language.

**Source Program and Object Program**

**Source Program**
The original program which was written by the programmer using a computer language is called source Program.

**Object Program**
The source program after it has been translated into machine language is called Object Program.
Any high-level language can either be interpreted or compiled.

Assembly language program is translated into machine code using an assembler.

```
Begin
Input hw * hr
Sal=hw*hr
Display Sal
End.
```

```
MOV r0, #0C ;
LOAD: MOV
r1,(r0) ;
CALL PRINT ;
INC r0 ;
JMP LOAD ;
```
## Annexe 10.3.3

### A Table

<table>
<thead>
<tr>
<th>Language Generation</th>
<th>Special features or changes.</th>
<th>Languages</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| ...                |                             |           |
Competency Level 10.4: Demonstrates familiarity with the IDE of a selected Visual Programming language.

Activity 10.4. : Let’s familiarize ourselves with the components of Integrated Development Environment.

Time : 60 minutes.

Quality Inputs : ● Four copies of group IDE components in Annexe 10.4.1
● Four copies of group exploration instructions in Annexe 10.4.2
● Four copies of reading material in Annexe 10.4.3

Learning – Teaching Process:

Step 10.4.1 : ● Attention of the class to the IDE components in Annexe 10.4.1
● Get students to name the tools in the Window IDE in Visual Basic.
● Conduct a discussion to highlight the following.

- Any Integrated Development Environment has its own components.
- Each component plays a specific task and the Integration of each component helps to complete a task.
- Main Menu, toolbar, toolbox … available in the Visual Basic IDE

(10 minutes)

Step 10.4.2 : ● Divide class into 4 groups.
● Provide the groups with copies of the exploration instructions and reading material.
● Get the group to do the practical in the lab.

(40 minutes)

Step 10.4.3 : ● Move around the computer lab, monitor progress and help.
● Conclude the session by highlighting the following.
Components of Integrated Development Environment of Visual Basic are

- Tool box
- Code window.
- Design window (Form)
- Project Explorer.
- Properties window.
- Form Layout window.
- The Form Window is the basis of developing Visual Basic applications.
- The Tool Box contains tools to create controls on the form window.
- The Properties Window shows all the characteristics of the selected control.
- The Project Explorer Window displays the contents of the entire application.
- The Form Layout Window shows where the form is located in the screen.
- Code Editor window is used to write your visual basic program.

Criteria for assessment and evaluation

- Names and describes the components of Visual Basic IDE.
- Handles the components of IDE skillfully.
- Use Visual Basic IDE to create projects for problem solving.
- Searches for things carefully.
- Works carefully sharing in the tasks.
Annexe 10.4.1

Visual Basic Integrated Development Environment

- Title Bar
- Menu Bar
- Tool Bar
- Form Window
- Project Explorer
- Tool Box
- Label
- Command Button
- Properties Window
- Form Layout Window
Annexe 10.4.2

Instructions for the Group exploration

Let's familiarize ourselves with the IDE of a selected Visual Programming language.

- You will be working in four groups with the following four tasks assigned randomly to the four groups.
  - Find the properties of a form and list it.
  - Create a Label on the Form and list its properties.
  - Identify the tools in the Tool Box and list them with their functionalities.
  - Find how to open project explorer window and then using it to open view code and view object one at a time.
- Open Visual Basic.
- Find out the relevant component assigned to your group.
- Be prepared to present your findings at the plenary session.
Annexe 10.4.3

Reading Material

What is Visual Basic?

Visual Basic is a programming tool that allows you to develop Windows (Graphical User Interface - GUI) applications.

How to start the Visual Basic.

- Click on the **Start** button on the Windows task bar.
- Select **Programs**, then **Microsoft Visual** Basic 6.0
- Click on **Visual Basic 6.0**
- Next select Standard EXE and Click OK.

Visual Basic Integrated Development Environment (IDE).

When you first start Visual Basic, you see the interface of the integrated development environment, as shown in following Figure. IDE integrates many different functions such as design, editing, compiling, and debugging within a common environment. First we will start with labeling the components of the Integrated Development Environment.

![Visual Basic IDE Interface](image)

1. Form Design Window
2. Tool Box
3. Properties Window
4. Project Explorer Window
5. Form Layout Window
6. Code Window
The Form Design serves as a window that you design the interface of your application. You add controls, graphics, and pictures to a form to create the look you want.

The Toolbox

The Toolbox Provides a set of tools that you use at design time to place controls on a form.
The Properties Window

The Properties Window lists the property settings for the selected form or control. A property is a characteristic of an object, such as size, caption, or color. This Window is used to change initial property values of form or control. The drop-down box at the top of the window lists all objects in the current form. Two views are available: Alphabetic and Categorized.

The Form Layout Window

The Form Layout window allows you to position the forms in your application using a small graphical representation of the screen.

Code Window

Serves as an editor for entering application code. A separate code editor window is created for each form or code module in your application.
Project Explorer

Displays a hierarchical list of the projects and all of the items contained in a project.

Window Elements

Displays the Code window so you can write and edit code associated with the selected item.

Displays the Object window for the selected item, an existing form, module, ActiveX object, or user control

Toggle Folders

Hides and shows the object folders while still showing the individual items contained within them.

List window

Lists the all loaded projects and the items included in each project.

- Project

  The project and items contained within it. (form, modules, classes, Class Modules, user controls etc…….)
Run

Properties Window

Tool Box

Project Explorer

Run

End

Run → Star
Competency 10: Writes programs to solve problems

Competency Level 10.5: Manipulates features of Controls.

Activity 10.5. : Let’s manipulate features of controls.

Time : 120 minutes.

Quality Inputs : ● Four copies of Annexe 10.5.1.
• Four copies of group exploration instructions in Annexe 10.5.2.
• Four copies of reading material in Annexe 10.5.3.

Learning – Teaching Process:

Step 10.5.1 : ● Draw the attention of the class towards the IDE components of Visual Basic
● Conduct a discussion to highlight the following.

- The Form Window is the basis of developing Visual Basic applications.
- The Toolbox Window is the selection menu for controls used in your application.
- The Properties Window is used to establish initial property values for controls.

(15 minutes)

Step 10.5.2 : ● Divide class into four groups.
● Provide them with copies of the exploration instructions and reading material.
● Get the groups to do the practical in the lab.

(80 minutes)

Step 10.5.3 : ● Move around the computer lab, monitor progress and help..
● Conclude the session by highlighting the following.
The controls probably used in Visual Basic are
  o Label
  o Text box
  o Command button

A label is a control that displays information the user cannot edit directly. It is often used to provide titles for other controls. Or, it is used to display the results of some computer operation.

The text box control lets the user input data while the program is running.

The command button is used to direct the program execution to a particular process.

The properties window displays all the properties of the selected controls.

In Visual Basic programming, there are rules to name controls.

Criteria for assessment and evaluation

- Applies the controls help to buildup the user interface.
- Designs the interface by using controls with necessary properties.
- Writes simple programs through Visual Basic IDE.
- Plans a work properly.
- Appreciates and respects ideas of peers.
Annexe 10.5.1

Instructions for the Group exploration
Let’s manipulate features of controls

- You will be randomly assigned one of the following four tasks which are explained in the Annexe 10.5.4.
  1. Draw a label and command button on the form and change its properties as table1.
  2. Draw a text box and command button on the form and change its properties as table 2.
  3. Draw a text box and label on the form and change its properties as table 3.
  4. Draw a text box on the form and change its properties as table 4.

- Place the controls on the form as shown in the Fig1.
- Go through the properties in relevant controls carefully.
- Create a form and controls and change the properties according to the relevant table.
- Be prepared to present your designed interface at the plenary session.
### Properties of Labels and Text Boxes

1. **Properties**
   - **Label**: LblName
   - **Text Box**: TxtName
   - **Command**: CmdExit
   - **Caption**: Enter Your Name
   - **Background Color**: Blue
   - **Font Color**: Red
   - **Font Type, Style, and Size**: Arial, Bold, 12

2. **Properties**
   - **Label**: LblNumber
   - **Text Box**: TxtNumber
   - **Command**: CmdDelete
   - **Caption**: Enter Number
   - **Background Color**: Black
   - **Font Color**: White
   - **Font Type, Style, and Size**: Impact, Bold, 14

3. **Properties**
   - **Label**: LblPassword
   - **Text Box**: TxtPassword
   - **Command**: CmdOK
   - **Caption**: Enter Password
   - **Background Color**: Green
   - **Font Color**: Red
   - **Font Type, Style, and Size**: Courier, Bold, 12

4. **Properties**
   - **Label**: LblAddress
   - **Text Box**: TxtAddress
   - **Command**: CmdClear
   - **Caption**: Enter Address
   - **Background Color**: Magenta
   - **Font Color**: Yellow
   - **Font Type, Style, and Size**: MS Serif, Bold, 12
Annexe 10.5.3

Reading Material

Steps in Building a Visual Basic Project

There are three primary steps in building a Visual Project:
1. Place (or draw) controls on the form.
2. Assign properties to the controls.
3. Write event procedures for the controls.

Three probably used controls in Visual Basic

- Label control
- Text Box control
- Command Button

Common rules of naming controls in VB

- The first three letters of the control name (called a prefix) specify the type of control. Some of these prefixes are

<table>
<thead>
<tr>
<th>Name of the Control</th>
<th>prefix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>lbl</td>
</tr>
<tr>
<td>Textbox</td>
<td>txt</td>
</tr>
<tr>
<td>Command button</td>
<td>cmd</td>
</tr>
<tr>
<td>Check box</td>
<td>chk</td>
</tr>
<tr>
<td>Option button</td>
<td>opt</td>
</tr>
<tr>
<td>List box</td>
<td>lst</td>
</tr>
<tr>
<td>Combo box</td>
<td>cmb</td>
</tr>
<tr>
<td>Timer</td>
<td>tmr</td>
</tr>
</tbody>
</table>

The Form Control

We have seen that the form is the central control in the development of a Visual Basic project. Without a form, there can be no project! Let's look at some important properties and events for the form control. The form appears when you begin a new project.
Properties

Like all controls, the form has many (over 40) properties. Fortunately, we only have to know about some of them. The properties we will be concerned with are:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name used to identify form. Three letter prefix for form names is frm.</td>
</tr>
<tr>
<td>Caption</td>
<td>Text that appears in the title bar of form.</td>
</tr>
</tbody>
</table>

Placing Controls on the Form
Controls are selected from the Visual Basic Toolbox window. There are two ways to place a control on the form:

1. Double-click the desired control in the toolbox window. The control will be created with a default size and put in the middle of the form.
2. Single-click the desired control in the toolbox window. Then, move the mouse cursor over the form. Notice the cursor changes to a crosshair (+). Place the crosshair where you want the upper left corner of your control to be. Click the left mouse button and hold it down. Now, drag the cursor toward the desired lower right corner of the control. A rectangular outline will be seen. When the outline represents your choice of the control, release the mouse button and the control will appear.

Label Control
A label is a control that displays information the user cannot edit directly. It is often used to provide titles for other controls. Or, it is used to display the results of some computer operation. The label control is selected from the toolbox. It appears as:

In Toolbox:  

On Form (default properties):  

Label1
Properties

A few useful properties for the label are:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name used to identify label. The three letter prefix for label names is <em>lbl</em>.</td>
</tr>
<tr>
<td>Caption</td>
<td>Text (string type) that appears in the label.</td>
</tr>
<tr>
<td>Font</td>
<td>Sets style, size, and type of Caption text.</td>
</tr>
<tr>
<td>Alignment</td>
<td>Sets whether Caption text is left-justified, right-justified, or centered in label.</td>
</tr>
<tr>
<td>BackColor</td>
<td>Sets label background color.</td>
</tr>
</tbody>
</table>

Text Box Control

The *text box* control is used mainly to input data by a user at run time. The text box is selected from the Visual Basic toolbox. It appears as:

*In Toolbox:*  
*On Form (default properties):*

![Text Box Control](image)

Properties

The text box has a wealth of useful properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name used to identify text box. The three letter prefix for text box names is <em>txt</em>.</td>
</tr>
<tr>
<td>Text</td>
<td>Text (string value) that appears in text box.</td>
</tr>
<tr>
<td>Font</td>
<td>Sets style, size, and type of Text.</td>
</tr>
<tr>
<td>Alignment</td>
<td>Sets whether Text is left-justified, right-justified, or centered in text box (only works when <em>MultiLine</em> property is <em>True</em>).</td>
</tr>
<tr>
<td>MaxLength</td>
<td>Maximum length of displayed Text. If 0, length is unlimited.</td>
</tr>
<tr>
<td>BackColor</td>
<td>Sets text box background color.</td>
</tr>
</tbody>
</table>
**Command Button Control**

The **command button** is one of the more widely used Visual Basic controls. Command buttons are used to start, pause, or end particular processes. The command button is selected from the toolbox. It appears as:

<table>
<thead>
<tr>
<th>In Toolbox:</th>
<th>On Form (default properties):</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="command button" /></td>
<td><img src="image" alt="Command1" /></td>
</tr>
</tbody>
</table>

**Properties**

A few useful properties of the command button are:

<table>
<thead>
<tr>
<th><strong>Property</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name used to identify command button. The three letter prefix for command button names is <code>cmd</code>.</td>
</tr>
<tr>
<td><strong>Caption</strong></td>
<td>Text that appears on the command button</td>
</tr>
</tbody>
</table>
### Annexe 10.5.4

<table>
<thead>
<tr>
<th><strong>Properties</strong></th>
<th><strong>Label</strong></th>
<th><strong>Command</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>lblName</td>
<td>cmdExit</td>
</tr>
<tr>
<td>Caption</td>
<td>Enter Your Name</td>
<td>Exit</td>
</tr>
<tr>
<td>Background Color</td>
<td>yellow</td>
<td></td>
</tr>
<tr>
<td>Font Color</td>
<td>Red</td>
<td></td>
</tr>
<tr>
<td>Font Type, Style, and Size</td>
<td>Arial, Bold, 12</td>
<td>Arial, Bold, 14</td>
</tr>
</tbody>
</table>

**Table 1**

<table>
<thead>
<tr>
<th><strong>Properties</strong></th>
<th><strong>Text box</strong></th>
<th><strong>Command</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>txtNumber</td>
<td>cmdOk</td>
</tr>
<tr>
<td>Caption</td>
<td>-</td>
<td>Ok</td>
</tr>
<tr>
<td>Back Color</td>
<td>Light blue</td>
<td>Yellow</td>
</tr>
<tr>
<td>Font Color</td>
<td>Dark Blue</td>
<td></td>
</tr>
<tr>
<td>style</td>
<td>-</td>
<td>Graphical</td>
</tr>
<tr>
<td>Font</td>
<td>Impact, Bold, 14</td>
<td>Arial, Bold, 16</td>
</tr>
</tbody>
</table>

**Table 2**

<table>
<thead>
<tr>
<th><strong>Properties</strong></th>
<th><strong>Label</strong></th>
<th><strong>Text box</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>lblPassword</td>
<td>txtPassword</td>
</tr>
<tr>
<td>Caption</td>
<td>Enter Password</td>
<td></td>
</tr>
<tr>
<td>Back Color</td>
<td>Green</td>
<td>Pink</td>
</tr>
<tr>
<td>Font Color</td>
<td>Red</td>
<td>Black</td>
</tr>
<tr>
<td>Font Type, Style, and Size</td>
<td>Comic, Bold, 12</td>
<td>Courier, Bold, 12</td>
</tr>
</tbody>
</table>

**Table 3**

<table>
<thead>
<tr>
<th><strong>Properties</strong></th>
<th><strong>Text box</strong></th>
<th><strong>Form</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>txtAddress</td>
<td>cmdMyfirst</td>
</tr>
<tr>
<td>Caption</td>
<td>-</td>
<td>My First Program</td>
</tr>
<tr>
<td>Back Color</td>
<td>Magenta</td>
<td>White</td>
</tr>
<tr>
<td>Font Color</td>
<td>Yellow</td>
<td></td>
</tr>
<tr>
<td>Font Type, Style, and Size</td>
<td>MS Serif, Bold, 12</td>
<td>MS Serif, Bold, 14</td>
</tr>
</tbody>
</table>

**Table 4**
Activity 10.6.1 : Let’s use algorithms for programming

Time : 150 minutes.

Quality Inputs :
- The sample programs of the folder 10.6 in the CD.
- Four copies of the group exploration instructions in Annexe10.6.1
- Four copies of the graded directions in Annexe10.6.2
- Demy sheets & markers

Learning – Teaching Process:

Step 10.6.1 :
- Run the sample program.
- Get students to comment on the program.
- Conduct a discussion to highlight the following.
  - Two numbers are entered to deal with the problem.
  - Total value can be gained by adding these numbers.
  - The total has to be displayed.
  - Text boxes are used to input numbers in the interface.
  - A label is used to display the total.
  - A command button is used to perform an action.
  - Label, Text Box and Command Button help to develop a program.
  - An algorithm is useful to develop a program.

(15 minutes)

Step 10.6.2 :
- Divide the class into Four groups.
- Provide each group with copies of group instructions and graded directions.
- Assign the four tasks randomly across the groups and involve the groups in the exploration.
- Request the groups to follow the instructions given.
- Prepare the groups for an innovative, whole-class, team presentation.

(45 minutes)
Step 10.6.3 : ● Get the groups to present their programs and learning experiences.
  ● Request the presenters themselves to make the first elaboration.
  ● Encourage the other groups to submit their constructive comments.
  ● Fill any gaps indicated.
  ● Conduct a discussion to highlight the following.

(45 minutes)

- An algorithm is written relevant to the given problem.
- Controls are selected in the interface to match the algorithm.
- Codes are written to the click event of the command button.
- Program should be executed to get the work done.
- It is required to input values to the text boxes
- Final output is received by using the command button.
- Forms and the project are saved for the future use.

(45 minutes)

Criteria for assessment and evaluation:
- Describes the method of solving a problem.
- Converts an algorithm into a computer program and checks it for accuracy.
- Writes algorithms as an initial stage of problem solving.
- Makes the output attractively
- Shares the experience among peer groups.
Annex 10.6.1

Instructions for the Group Exploration.

Let's use algorithms for programming

- You will be working in four groups with the following problems randomly distributed among the groups.
  - Find the difference between two numbers.
  - Find the product of two numbers.
  - Find the answer by dividing one number from another, when the divisor is not equal to zero.
  - Find the sum of three numbers.
- Go through the graded directions for
  - writing an algorithm
  - designing a suitable interface
  - writing a program
- Save the form and the project in a suitable place.
- Be prepared to make an innovative presentation at the plenary.
Graded Directions

Let's consider the sample algorithm to find the total of two numbers
   Enter the first number
   Enter the second number
   Add two numbers
   Display the total

Now write an algorithm for the problem given to you.

Open a new project of Visual Basic

Start → Programs → Microsoft Visual Studio → Visual Basic 6.0 → Standard Exe → Open

For the sample algorithm, interface can be designed as follows

First controls are placed in the form.
Then the caption properties are changed as shown below.

![Image of a form with text boxes and a command button]

Then name properties are changed as,

- Text1 → txtFirst
- Text2 → txtSecond
- Label1 → lblAns
- Command1 → cmdAdd

The value in the text property of each Text box is erased.
The caption in Label1 is also erased.
The caption of the Command1 button is changed.
The Font size of each control is increased.

Next the code is written in the code window by double clicking on the command button. Following is the code for the sample algorithm.
o Design the interface relevant to your problem using textboxes, labels, command button and write the code in the code window to the event controls.

o Run your program by clicking the start button or using F5 key
   Enter the values for the Text boxes
   Click on the command button

o Answer will be displayed on the label. Check the accuracy.
Competency Level 10.7: Uses constants and variables in programming

Activity 10.7.1: Let’s use suitable data types for variables and constants.

Time: 180 minutes.

Quality Inputs:
- Table of variables in Annexe 10.7.1
- Four copies of the group exploration instructions in Annexe 10.7.2
- Four copies of data types list in Annexe 10.7.3
- Four copies of the reading material in Annexe 10.7.4
- Demy sheets & markers

Learning – Teaching Process:

Step 10.7.1:
- Get a volunteer to draw the table in annexe 10.7.1 on the board
- Ask him/her to complete the table with the support of the whole class.
- Get the students to comment on how Y changes when X varies
- Conduct a discussion to highlight the following.

- A variable represents an unknown quantity that has the potential to change.
- Similarly variables can be selected as required in terms of X and Y
- A constant is a value that does not change
- Each variable has a unique name
- We can use both variables and constants in programming

  (15 minutes)

Step 10.7.2:
- Divide the class into Four groups.
- Provide each group with the group exploration instructions, reading material and list of data types.
- Involve them in the exploration
- Prepare them for a innovative whole class presentation

  (60 minutes)

Step 10.7.3:
- Get each group to present its findings.
- Request the presenters themselves to fill in any gaps they have left.
- Encourage the other groups to submit their constructive comments.
● Fill any gaps indicated.
● Conduct a discussion to highlight the following.

(60 minutes)

- In naming a variable and a constant, it
  - Must begin with a letter
  - Can have up to 255 characters.
  - Can be used Alpha numeric characters from the second character of the name.
    - Cannot have a period;
    - May include only letters, numbers and underscores.
  - Must be unique within the same scope.
- Variables are used memory locations in the computer main memory to store values.
- There are several data type to declare variables and constants.
- Declaration syntax of a constant is
  ```constant VariableName As Data Type```
- Declaration syntax of a variable is
  ```Dim/Public VariableName As Data Type```
- Dim or Public can be used.
- Mentioning Data Types in the above declarations are optional.
- The data types of variables determine the nature of its value.
- Visual basic uses the variant data type by default.
- There are a number of other available data types like Boolean, Byte, Integer, Single, Double, Currency, Date and String.

(45 minutes)

**Criteria for assessment and evaluation**
- Names and describes data types
- Accepts the importance of data types
- Uses variables and constants in programming
- Solves problems in day to day life methodically.
- Selects suitable objects for a given task.
Annexe 10.7.1

<table>
<thead>
<tr>
<th>$X$</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>$+3$</td>
<td>+3</td>
<td>+3</td>
<td>+3</td>
<td>+3</td>
<td>+3</td>
</tr>
<tr>
<td>$Y = X + 3$</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

I. Complete the chart
II. Observe $Y$ when $X$ is varying
Annexe 10.7.2

Instructions for the Group Exploration.
Let's use data types for variables and constants.

- Go through the list of data and categorize them on the basis of reading material.
- You will be working in four groups with the following problems randomly distributed among students.
- Write a program to solve the problem assigned to your group using variables and constants
  - Find the area of any rectangle when the length and width are given.
  - Find the velocity of a vehicle when the distance and time are given
  - Find the area of a circle when the radius is given
  - Display your full name when your first name and last name are given separately.
- Design your interface in Visual Basic similar to the one given to you.
- Write suitable codes to command button for your solution declaring variables/Constants as required.
- Run the program to check its accuracy.
- Be prepared to make an innovative presentation at the plenary session.
Annexe 10.7.3

- Design the interface according to your problem given to you as follows

![Interface Designs]

Annexe 10.7.4

Data Types list
- 125
- 2346%
- 2345678
- 34568902334555
- ¾/2005
- 345568889904433221
- Rs235.00
- 345
- Rs456.00
- Palitha
- Kalutara
- 2/5/1980
- 266123.45
Annexe 10.7.5

Reading Material

What is a variable?

A variable is a memory location in the computer's memory where you can store data.

Naming a variable

As stated already, a variable is an area of computer memory you use in your program. To use a variable, you must give it a name. There are rules you should, and usually must, follow when naming your variables. The name of a variable:

- Must begin with a letter
- Cannot have a period;
- Can have up to 255 characters.
- May include only letters, numbers and underscores.
- Must be unique within the same scope.
- Cannot be in reserved words

Once a variable has a name, you can use it as you see fit.

For example, you can assign it a value and then use the variable in your program as if it represented that value.

A constant used to store value cannot be changed once it is initially bound a value,

Eg:- Pi= 3.142

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Storage Size</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Byte</td>
<td>1 Byte</td>
<td>0-255</td>
</tr>
<tr>
<td>Integer</td>
<td>2 Bytes</td>
<td>-32,768 to 32,768</td>
</tr>
<tr>
<td>Long</td>
<td>4 Bytes</td>
<td>-2,147,483,648 to 2,147,483,647</td>
</tr>
<tr>
<td>Single</td>
<td>4 Bytes</td>
<td>-3,402823E38 to -1,401298E-45 for negative values; 1,401298E-45 to -3,402823E38 positive values</td>
</tr>
<tr>
<td>Double</td>
<td>8 Bytes</td>
<td>-1.79769313486232E308 to 9.4065645841247E-324 for negative values; 9.4065645841247E-324 to 1.79769313486232E308 for positive values</td>
</tr>
<tr>
<td>Currency</td>
<td>8 Bytes</td>
<td>-922,337,203,685.477.5808 to 922,337,203,685.477.5807</td>
</tr>
<tr>
<td>Boolean</td>
<td>2 Bytes</td>
<td>True or False</td>
</tr>
<tr>
<td>Date</td>
<td>8 Bytes</td>
<td>January 1,100 to December 31,9999</td>
</tr>
<tr>
<td>String</td>
<td>10 Bytes</td>
<td>Zero to approximately two billion characters</td>
</tr>
<tr>
<td>Object</td>
<td>4 Bytes</td>
<td>Any object reference</td>
</tr>
<tr>
<td>Variant</td>
<td>10 Bytes</td>
<td>Any numeric value up to the range of a double</td>
</tr>
</tbody>
</table>
**Variable Declaration**

Dim <variable name >as <data type>

Eg:

- Dim x as integer
- Dim bdate as date
- Dim num as double
- Dim IsMarried As Boolean
- Dim StudentAge As Byte
- Dim cost as currency

If you have many variables of the same data type, you can declare them on the same line, each separated with a comma. Remember to specify their common type. Here is an example:

- Dim CountryName, Address, City, State As String
- Variables declared with the Dim statement within a procedure exist only as long as the procedure is executing.

- When the procedure finishes, the value of the variable disappears.
- In addition, the value of a variable in a procedure is local to that procedure — that is, you can't access a variable in one procedure from another procedure.

- These characteristics allow you to use the same variable names in different procedures without worrying about conflicts or accidental changes.

**Constant Declaration**

Const pi=3.14

Example:- Find the area of a cylinder(Programming codes)
Competency 10: Writes programs to solve problems

Competency Level 10.8: Uses operators in programming

Activity 10.8.1 : Let’s use operators in programming.

Time : 90 minutes.

Quality Inputs : ● Four copies of the Group Exploration instructions in Annex10.8.1
• Four copies of operator list in Annexe10.8.2
• Four copies of the reading material in Annexe .10.8.3
• Demy sheets & markers

Learning – Teaching Process:

Step 10.8.1 : ● Pose the following questions to the whole class and get the answers and how they arrived at the answer.
  o 4*3+2*5-6/2=
  o 2(5+3)-3(12/2-5)=

● Conduct a discussion to highlight the following.

• There are various operators.
• Operators have precedence levels.
• When multiplication and division occur together in an expression, each operation is evaluated as it occurs from left to right
• When addition and subtraction occur together in an expression, each operation is evaluated as it occurs from left to right
• Parentheses can be used to override the order of precedence and require some parts of an expression to be evaluated before others.
• Within parentheses, however, operator precedence is maintained.
• Operators are used in Visual basic programming.

(10 minutes)

Step 10.8.2 : ● Divide the class into four groups.
● Provide each group with the group exploration instructions, operator list, and reading material.

● Request the groups to follow the given instructions

**Step 10.8.3**

- Get each group to present its findings.
- Request the presenters themselves to fill in any gaps they have left.
- Encourage the other groups to submit their constructive comments.
- Fill any gaps indicated.
- Conduct a discussion to highlight the following.

<table>
<thead>
<tr>
<th>30 minutes</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>20 minutes</th>
</tr>
</thead>
</table>

- An operator is a code element that performs an operation on one or more code elements that hold values.

- Operators are classified into four groups
  - Arithmetic operators perform familiar calculation on numeric values.
  - Comparison operators compare two expressions and return a Boolean value.
  - Logical operators combine logical or numeric values and return a result of the same data type as the values.
  - Concatenation operators join multiple strings into a single string.

- When several operations occur in an expression, each part is evaluated and resolved in a predetermined order called operator precedence.

- When expressions contain operators from more than one category:
  - Arithmetic operators are evaluated first.
  - Comparison operators are evaluated next.
  - Logical operators are evaluated last.
  - All Comparison operators have equal precedence. They are evaluated in the left to right order in which they appear
  - To concatenate strings, use the & symbol or the + symbol

(30 minutes)
Criteria for assessment and evaluation

- Names operators in visual basic
- Accepts that operators have precedence
- Uses different operators for different purposes as required.
- Solves problems step by step.
- Uses precedence in day-to-day life.
Annex 10.8.1

Instructions for the Group Exploration

Let's use operators in programming

Part 1

- On the basis of the reading material provided, solve the problems in the operators list manually.
- Next solve the problem using the computer.
  - Start Microsoft Visual Basic and create a new application using Standard EXE
  - Double click the form and click View Code
  - In the Code Editor, select Form from the Object combo box and select Activate from the event combo box
- Compare the answers.

Part 2

- You will be working in four groups with the following problems randomly distributed among you.
  - Find the integer quotient of a division (using \ operator)
  - Find the remainder of a number (using Mod operator)
  - Find the power of a number (using ^ operator)
  - Concatenate two strings (using & operator)
- Solve your problem using the computer.
  - Start Microsoft Visual Basic and create a new application using Standard EXE
  - Design a suitable interface (using labels, text boxes and command buttons).
  - In the Code Editor write the relevant codes.
- Run the program.
- Edit the program.
- Save the form and the project
- Be prepared to make an innovative presentation at the plenary session.
Annexe 10.8.2

Operators List (Arithmetic, Comparison, Logical, Concatenation)

Part 1

- Arithmetic Operators

1) Print $7^2$
2) Print $7*2$
3) Print $7/2$
4) Print $7\div2$
5) Print $7 \text{ Mod } 2$
6) Print $7+2$
7) Print $7-2$
8) Print $(7^2+3 \text{ Mod } 2)$
9) Print $(7*2+25 \text{ Mod } 7*2)$
10) Print $(3+5^2 \text{ Mod } 3*2/3)$

- Comparison Operators

When $A=10$ Find the answer

1) Print $A<20,A<5$
2) Print $A<=10,A<=5$
3) Print $A>20,A>5$
4) Print $A>=10,A>=5$
5) Print $A=20,A=10$
6) Print $A<>10,A<>5$

- Concatenation Operators

1) Print "2"+"4"
2) Print 2+4
3) Print "Information" + "Technology"
4) Print "Information" & "Technology"
5) Print "Information" & "" & "Technology"
6) Print 2 & 4

- Logical Operators

1) Print $(2>3) \text{ AND } (3>2)$
2) Print $(2>3) \text{ OR } (3>2)$
3) Print $\text{NOT } (3>2)$
4) Print $\text{NOT } (5>4) \text{ AND } (3<2)$
5) Print $\text{NOT } (5>4) \text{ OR } (3<2)$
6) Print $(2<3) \text{ AND } (5<4) \text{ OR } (7>6)$
7) Print $(4+5>2) \text{ AND } (9-3<3)$
8) Print $(9-4<8) \text{ OR } (8+3>5)$
Arithmetic Operations

- The ^ Operator raises a number to the power of an exponent. The result is the first operand raised to the power of the second.

  Eg:–
  - $2^3 = 8$ (the cube of 2)
  - $10^3 = 1000$ (the cube of 10)
  - $15^2 = 22$

- The * Operator Multiplies two numbers

  Eg:–
  - $25 \times 2 = 50$
  - $15 \times 3 = 45$

- The / Operator returns the full quotient, including the remainder.

  Eg:–
  - $14 \div 4 = 3.5$
  - $23 \div 2 = 11.5$

- The \ Operator returns the integer quotient of a division.

  Eg:–
  - $14 \div 4 = 3$
  - $25 \div 2 = 12$

- Mod Operator divides two numbers and returns only the remainder

  - $(\text{number1 Mod number2})$

  Eg:–
  - $15 \mod 4 = 3$
  - $25 \mod 2 = 1$
  - $10 \mod 2 = 0$

- You can add two values in an expression together with the + Operator or subtract one from another with the - Operator

  Eg:–
  - $25 + 15 = 40$
  - $25 - 15 = 10$
• Concatenation operator

  o Concatenation operators join multiple strings into a single string
  o To concatenate string, use the & symbol or the + symbol
  o The string concatenation operator is not an arithmetic operator, but in precedence it does follow all arithmetic operators and precedes all comparison operators.

  Eg:
  Print "Con" & "caten" & "ation"
  Print "Con" + "caten" + "ation"

  The preceding statements set both to "Concatenation".

  **VB comparison operators (all of equal precedence):**

  • Operator -- Operation:
    o = -- equals
    o <> -- is not equal
    o < -- less than
    o > -- greater than
    o <= -- less than or equal
    o >= -- greater than or equal

  • The comparison operators are lower in precedence than the arithmetic operators and higher in precedence than the Boolean operators.

  **Logical operators**

  • Logical operators compare **Boolean** expressions and return a **Boolean** result.
  • **And, Or**, operators are **binary** because they take two operands.
  • Not operator is unary because it takes a single operand.

  Eg:-
  o (23 > 14) And (11 > 8) Out put→True
  o (23 < 14) And (11 > 8) Out put→False
  o (23 > 14) And (11 < 8) Out put→False
  o (23 < 14) And (11 < 8) Out put→False

  o (23 < 14) Or (11 > 8) Out put→True
  o (23 < 14) Or (11 > 8) Out put→True
  o (23 > 14) Or (11 < 8) Out put→True
  o (23 < 14) Or (11 < 8) Out put→False

  o Not (23 > 14) Out put→False
  o Not (23 > 67 ) Out put→.True'
## Operator Precedence

<table>
<thead>
<tr>
<th>Arithmetic</th>
<th>Comparison</th>
<th>Logical</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exponentiation (^)</td>
<td>Equality (=)</td>
<td>Not</td>
</tr>
<tr>
<td>Multiplication and Division (*,/)</td>
<td>Inequality (&lt;&gt;)</td>
<td>And</td>
</tr>
<tr>
<td>Integer division ()</td>
<td>Less than (&lt;)</td>
<td>Or</td>
</tr>
<tr>
<td>Modulus arithmetic (Mod)</td>
<td>Greater than (&gt;)</td>
<td></td>
</tr>
<tr>
<td>Addition and Subtraction (+,-)</td>
<td>Less than or equal to (&lt;=)</td>
<td></td>
</tr>
<tr>
<td>String concatenation (&amp;,+)</td>
<td>Greater than or equal to (&gt;=)</td>
<td></td>
</tr>
</tbody>
</table>
Competency Level 10.9: Develop programs with objects and multiple forms.

Activity 10.9 : Let’s develop programs with objects and multiple forms.

Time : 120 minutes.

Quality Inputs :
- Presentation screens in Annexe 10.9.1
- A soft copy of a sample program.
- Four copies of the group exploration instructions in Annexe 10.9.2
- Four copies of the reading material in Annexe 10.9.3
- 4 Computers
- Demy sheets & markers

Learning – Teaching Process:

Step 10.9.1 :
- Get a volunteer to make the presentation with the help of the whole class and show the relevant objects on the presentation screen.
- Ask him to present
  - Microsoft Word screen,
  - Microsoft Access opening screen,
  - Task bar and Start menu properties
- Conduct a discussion to highlight the following.
  - We use combo box, check box and scroll bars in Microsoft office packages.
  - We use mouse control events in Microsoft office packages.
    - Single click
    - Double click
  - We can write programs with objects.
Step 10.9.2 :  
- Divide the class into four groups.
- Provide each group with the soft copy of a sample program, group exploration instructions and the reading material.
- Involve them in the exploration
- Prepare them for a innovative whole class presentation

(55 minutes)

Step 10.9.3 :  
- Get each group to present its findings.
- Request the presenters themselves to fill in any gaps they have left.
- Encourage the other groups to submit their constructive comments.
- Fill any gaps indicated.
- Conduct a discussion to highlight the following.

(30 minutes)

- Describes calling methods of forms
  - Using `show`.
  - Using `hide`.

- Describes how to apply the following objects in programming.
  - Combo box
  - Scroll bars
  - Option button
  - Check box

- Describes how to apply events of controls in programming.
  - Single click
  - Double click
  - Mouse move
  - Load

Criteria for assessment and evaluation

- Names and describes actions of objects in the toolbox.
- Accepts that by using calling methods we can handle multiple forms.
- Uses objects in the toolbox in programming
- Selects the correct person for a relevant task.
- Selects suitable objects for a given task.
Annexe 10.9.2

Instructions for the Group Exploration.

Let's develop programs with objects and multiple forms

- Study the soft copy of the program and go through the reading material given you.
- You will be working in four groups with the following problems randomly distributed (One from task 1 & One from task 2) among you.
- Develop a program to solve the problem assigned to your group using objects in the toolbox
- Task1 (Form1)
  - Input the temperature in Centigrade (C) and convert it to Fahrenheit (F) by using the formula $C = \frac{5}{9}(F-32)$ (Use Scrollbar, two text boxes and a label)
  - Select a food and a drink from the list given, and print it (Use Two combo boxes and two labels)
  - Italic a text in a label and undo it (Use two check boxes and a label)
  - Color the form in three colors (Use three option buttons and a label)
- Task2 (Form2)
  - Display your name and change the colour on a label when click on the label.
  - Display your name and change the colour on a label when double click on the label.
  - Display your name on a label and erase it by using mouse move
  - Display your name and change the colour on a label when the form is loading
- Design the interface in Visual Basic.
- Design two forms for given tasks using suitable buttons.
- Run the program to check its accuracy.
- Be prepared to make an innovative presentation at the plenary session.
Annexe 10.9.3

Reading Material

Option Button

- Option button s or Radio buttons appear in groups
- The user can only chose only one of them.
- The main property is checked, and it is true if the control is checked and false otherwise.

Check box

- Check box control presents one or more choices that the user can select.
- The Main property is value, and it is zero if the check box is cleared and false otherwise

Combo box

- This control contains a list of options from which the user can chose one or more unlike a group of check boxes or option buttons
- The user can scroll the list to locate an item.
- The user can either chose an item from the list or enter a new string in the edit field.
- The item selected from the list is given by the controls text property.

Horizontal and Vertical ScrollBars

- The horizontal and vertical scroll bars let the user specify a magnitude by scrolling the controls button between its minimum and maximum value.
Forms in sample program

Option buttons

Check Boxes

lblHead

optBold
Form1 Coding

• codes for Option buttons
Private Sub optBold_Click()
    lblHead.FontBold = True
End Sub

Private Sub optReg_Click()
    lblHead.FontBold = False
End Sub

• codes for Check boxes
Private Sub chnormal_Click()
    lblHead.FontUnderline = False
End Sub

Private Sub chUnder_Click()
    lblHead.FontUnderline = True
End Sub

• codes for Scrollbar
Private Sub HScroll1_Change()
    txtFont.Text = HScroll1.Value
    lblHead.FontSize = HScroll1.Value
End Sub

• codes for Form Load
Private Sub Form_Load()
    optBold.Value = False
    optReg.Value = False
    chUnder.Value = 0
    chnormal.Value = 0
End Sub

• codes for Show &Hide forms
Private Sub cmdMove1_Click()
    Form2.Show
    Me.Hide
End Sub
How to add items to a Combo Box

1) Private Sub Form_Load()
    cmbCapital.AddItem "Kathmandu"
    cmbCapital.AddItem "Colombo"
    cmbCapital.AddItem "Newdilly"
    cmbCapital.AddItem "Beegin"
End Sub

2) You can add items to combo box by using the list property in Property Window.

Codes for Combo box

Private Sub cmbCapital_Click()
    lblCap.Caption = cmbCapital.Text
End Sub
Private Sub cmbCountry_Click()
    lblCoun.Caption = cmbCountry.Text
End Sub

**Codes for mouse move**

Private Sub lblCap_MouseMove(Button As Integer, Shift As Integer, X As Single, Y As Single)
    lblCap.Caption = " "
End Sub

Private Sub lblCoun_MouseMove(Button As Integer, Shift As Integer, X As Single, Y As Single)
    lblCoun.Caption = " "
End Sub

Codes for mouse single click

Private Sub lblMessage_Click()
    lblMessage.Caption = "You have clicked once"
    lblMessage.BackColor = vbWhite
    lblMessage.ForeColor = vbRed
End Sub

**Codes for mouse double click**

Private Sub lblMessage_DblClick()
    lblMessage.Caption = "You have double clicked"
    lblMessage.BackColor = vbBlue
    lblMessage.ForeColor = vbWhite
End Sub
Competency 10: Writes programs to solve problems.

Competency level 10.10: Develops programs involving single condition.

Activity 10.10: Let’s use If.. Then… Else… End If Control structure.

Time: 60 minutes.

Quality inputs:
- Four copies of the group exploration instruction sheet in Annexe 10.10.1
- Two sample programs stored in Folder 10.10. Of the CD.
- Four copies of reading material in Annexe 10.10.2.

Learning – Teaching Process:

Step 10.10.1:
- Let the students run sample program 1 given in the CD entering marks below and over 40.
- Get students to comment on the output of the program.
- Do the same with the sample program 2.
- Get the students to compare the coding of the two programs.
- Conduct a discussion to highlight the following.

- The two programs used can assess a person’s performance.
- A criterion has been used to decide the person’s performance.
- The first program can output only pass where as the second program can output both pass and fail.
- If … Then… Else structure is used to output both pass and fail.
- If the condition becomes true we get one decision or else we have to come to the alternative decision.
- If we omit the Else part we can get only one decision.

(15 minutes)
Step 10.10.2 : 
- Divide the class into four groups.
- Distribute copies of group exploration instructions and reading material to each group.
- Involve the groups in the exploration

(30 minutes)

Step 10.10.3 : 
- Get the groups to present their software.
- Get the other students to move around and use the software to make Decisions.
- Invite constructive comments from the other groups.
- Conclude the session by highlighting the following.

<table>
<thead>
<tr>
<th>Criteria for Assessment and evaluation</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Describes the syntax of a program that can be used to make decisions to Fulfill a single condition.</td>
</tr>
<tr>
<td>- Identifies the format of If …Then…Else …End If control structure.</td>
</tr>
<tr>
<td>- Describes the role played by the Else part of the program.</td>
</tr>
<tr>
<td>- Writes programs for decision-making.</td>
</tr>
<tr>
<td>- Works cooperatively with others in decision-making.</td>
</tr>
</tbody>
</table>

(15 minutes)
Annexe 10.10.1

Instructions for the Group Exploration.
Let's use If - Then - Else-End If conditions to make decisions

- You will be working in four groups with the following four simple programs assigned randomly to the four groups.
  - State "correct / wrong " when the addition of two numbers is given.
  - State whether a person has the right to vote when his/her age is given.
  - State "correct “for a given odd number and “wrong” for an even number.
  - State "correct / wrong “ when the area of a rectangle with specified dimensions is given.
- Go through the reading material and examine figures 1, 2 and 3
- See how the If…Then…Else…End If condition has been used to output a person’s performance.
- Now focus on the program you are assigned.
- Take clues from the example given and write the program code.
- Develop a form for the program.
- Try to identify a method to illustrate the output.
- Run the program, assign different values and check for the accuracy of the output.
- List the problems you encountered and the solutions you used to overcome them.
- Be prepared to for innovative whole class group presentation.
Annexe 10.10.2

Reading Material

If Then Else Condition.

Look at the following program, which consists of a form, program code and a syntax developed to evaluate a person’s performance.

When you type your marks in Tmark Textbox of the form and click the CResult command button, a massage in Lresult Label will tell you whether you have passed or failed.

This type of program is developed to represent a decision with two options.

Form

![Form Diagram]

Program Code
The following code can output both pass and fail because it has both the If…Then part and the Else part.

```plaintext
Private Sub CResult_Click()
If Val(TMark) > 39 Then
    LResult.Caption = "Pass"
Else
    LResult.Caption = "Fail"
End If
End Sub
```
Figure 2

Code 2

If you omit writing the Else part the program can still comment on your performance, but it can output only Pass. From this you can learn that Else part is not compulsory where as the word If ... then is essential.

Both the examples show that If …Then Statement should be closed with End If.

Syntax

If Condition Then Statement(s) End If

Condition must render a Boolean value (either true or False)

These statements run when condition renders True

Else Statement(s) End If

These statements run when the condition renders false.

Figure 4

Above structure shows how the syntax should be written.
Competency Level 10.11: Develops programs involving multiple conditions.

Activity 10.11: Let's use multiple conditions to make multiple decisions.

Time: 120 minutes.

Quality inputs:
- The sample programs of the folder 10.11 in the CD.
- Four copies of the group exploration instruction sheet in Annexe 10.11.1
- Four copies of the reading material in Annex 10.11.2.

Learning – Teaching Process:

- **Step 10.11.1**:
  - Run the two sample programs one at a time.
  - Get students to comment on the process for running the program
  - Get them to explain the products
  - Conduct a discussion to highlight the following.

  - Marks can be graded as Excellent, Very Good, Good and Weak or A, B, C, S and F.
  - The graded marks are used to indicate the performance level of students.
  - Each grade corresponds to a value range.
  - Value ranges are used to construct conditions.
  - The two programs run consist of a number of conditions.
  - These conditions have been structured in two different ways.
  - Computer programs run facilitate day–to–day decisions.

(15 minutes)

- **Step 10.11.2**:
  - Divide the class into four groups.
  - Provide each group with a copy of the group exploration sheet, tables and reading material.
  - Assign the four tables randomly across the groups and involve the groups in the exploration.
  - Prepare the groups for an innovative, whole-class, team presentation.

(60 minutes)
Step 10.11.3 : ● Get the groups to present their programs and learning experiences.
   • Request the presenters themselves to make the first elaboration.
   • Invite constructive comments from the other groups.
   • Let children more around the class to get firsthand experience on what the others have produced
   • Conclude the session by highlighting the following.
- Two control structures – nested If and Case - have been used to develop the programs.
- Nested if and case conditions are used to make decisions when more than one condition exists in the given situation.
- Nested if structure consists set of If Then ... End If structures.
- If ..Then.. Else ..End If paths can be nested (Smaller one inside larger one)
- All the If statements should be closed with End If.
- The program runs from top to bottom checking the conditions one after the other.
- If the first condition is true the command which is written after the first If (condition) then is executed and go to its End If.
- If it is false it moves to the next condition, which appears after Else and checks whether it fulfils the second condition.
- If the second condition is also false the program runs until it finds a condition, which is true and executes the command after it.
- Select Case statement can also be used to make multiple decisions.
- Unlike in the Nested If type the Case type can evaluate only one variable.
- The program starts with the Select Case statement.
- The Select Case statement specifies the variable, which should be evaluated.
- The other case statements, which follow the Select Case statement, specifies the values or value ranges of the variable making conditions.
- VB compares each case statement with select case statement until it finds a match.
- When it finds a match it executes the commands that follows immediately .
- The program runs from top to bottom.
- It ignores the statements that do not match.
Criteria for Assessment and Evaluation

- Differentiates between the two conditional control structures used in programming
- Selects suitable structure for given problems
- Writes programs with the two conditional control structures and checks them for accuracy.
- Learns from the peers.
- Thrives to make the products attractive.
Annexe 10.11.1

Instructions for Group Exploration

Let’s use ‘Nested IF’ and ‘Select Case’ to make decisions

- You will be working in four groups with the following four tables in Anexe 10.11.2 randomly distributed among the groups.
  - Determining various states of water by temperature
  - Determining university selection by Z Score
  - Determining discount level by customer status and goods purchased
  - Determining people categories by age group

- Study the table to identify the following
  - Variables to be manipulated in making decisions.
  - Conditions and the corresponding value ranges.

- Select the relevant program out of the two programs run and study its syntax and form.
- Go through the reading material to know more about writing syntax.
- Now use what you have learn to write a program using the variables and condition you have previously identified.
- Run the program developed
- Input different values selected from different value ranges to check the accuracy of the program.
- Be prepared to make a whole-class, innovative, team presentation on your experiences, problems you have encountered and solutions tried out.
Reading Material

Nested If Control Structure
Look at the following programs.

These programs are similar to the programs you developed in the previous lesson but this lets you take multiple decisions where you can use multiple conditions.

When you click on the CResult button after entering a mark in the text box of TMark your performance level will be displayed in Lgrade label.

The Form

When you see the code you can identify how the learnt if structure has been applied several times to get multiple decisions.

The program runs from top to bottom. It checks conditions one after the other until it finds a condition which return true. If such a condition is found it executes lines after the condition.

The Code
In this program if the given mark is less than 40 it outputs the statement “Weak” and immediately comes to the End If relevant to it and finishes the program.

If it doesn't fulfill that condition, that is, if it is greater than 40, it checks the next condition. This checks whether it is less than 50. If the given number fulfills the second condition it outputs the statement “Good” and comes to the relevant End If and finishes the program.

Syntax

If … Then … else … End If paths can be nested (Smaller one inside a larger one) either in the “then “ statement or in the “Else” statements or in both as long as they do not overlap.

The following diagram shows how paths are nested in the Else statement in the program described above.

Path 2 has been embedded in path 1 and in the same way path 3 has been embedded in path 2 and path 4 has been embedded in path 4.

Figure 3
Example 2
Making multiple decisions using more than one variable.
You can evaluate more than one variable using **Nested If** type in the following manner.

Form

![Form](image)

**Figure 4**

Code

![Code](image)

**Figure 5**

The program above can give the following decisions.
If the user gets more marks than 49 in any of the two tests he is selected. (Either through test 1 or test 2.)

Code 2
The second type of coding helps the user to come to the following decisions
- If the user gets more marks higher than 74 for both the tests he is selected to the advanced course.
- If he gets marks between 50 to 75 he is selected for the basic course.
- If he can’t score over 49 for both tests he is not selected.

Case Statement
The following program is similar to the program you have worked with.

This program also can be used to get multiple decisions but there are differences in the application of case statement.
- The coding is different from nested if conditions.
- Case statement can evaluate only a single variable whereas the nested if type can evaluate multiple variables.
- The same examples you used in part one can be used for Case statement because you evaluated only one variable.

This is used when we have to evaluate a single variable whereas in Nested if conditions different variables can be evaluated.
Code

```
Private Sub CGrade_Click()
    Select Case Val(TMark)
        Case 0 To 40
            LGrade.Caption = "F"
        Case 41 To 50
            LGrade.Caption = "S"
        Case 51 To 65
            LGrade.Caption = "C"
        Case 66 To 75
            LGrade.Caption = "B"
        Case 76 To 100
            LGrade.Caption = "A"
    Case Else
        Val(TMark) > 100 Or Val(TMark) < 0
            LGrade.Caption = "Error"
    End Select
End Sub
```

Figure 8

**Syntax**
Select Case `<Expression>`
    Case `<Value>`
    One or more VB statements
    Case `<Value>`
    One or more VB statements
        Case `<Value>`
        ..........  
    Case `<Value>`
    One or more VB statements
    Case `<Value>`
Case Else
    One or more VB statements
End Select

`<Expression>` can be any VB expression – such as a calculation, a string value, or a numeric value, provided that it results in an integer or a string value.

**Ex** – Select Case Text1  (This gives a String Value)
    Select Case Val(Text1) (This gives a numeric value)

    Each `<value>` must be compatible with `<Expression>`, that is , if `<Expression>` results in an integer, then all all `<Value>`s must be integers as well.

    VB compares `<Expression>` to each `<Value>` until it finds a match. It executes the statements that immediately follow it. It ignores the rest of the case statements.

    In the event where no matches have been found, then the statements following Case Else are executed.
Determining various states of water by temperature.
The following table shows various states of water along with change of temperature. Design an Interface to enter the temperature. Use Nested If control Structure to determine the states in your program. Study figures 1 and 2 in the reading material for this.

<table>
<thead>
<tr>
<th>Temperature in Celsius</th>
<th>State of water</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal to or less than 0°C</td>
<td>Ice</td>
</tr>
<tr>
<td>Less than 27°C and greater than 0°C</td>
<td>Cool water</td>
</tr>
<tr>
<td>Less than 100°C and greater than 26°C</td>
<td>Hot Water</td>
</tr>
<tr>
<td>Greater than or Equal to 100°C</td>
<td>Steam</td>
</tr>
</tbody>
</table>

Determining University Selection by Z Score
The following table shows the criteria for selection to university in a particular district. Design an interface to enter the Z score. Use Select Case control structure to determine the course selected. Study figures 7 and 8 in the Reading Material for this.

<table>
<thead>
<tr>
<th>Z Score</th>
<th>Nature of Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>From 0 to 1.5</td>
<td>Not Selected</td>
</tr>
<tr>
<td>1.6 to 1.9</td>
<td>Bio Science</td>
</tr>
<tr>
<td>2.0 to 2.4</td>
<td>Veterinary</td>
</tr>
<tr>
<td>Greater than 2.5</td>
<td>Medicine</td>
</tr>
</tbody>
</table>

Determining Discount Levels by the status of the customer and by the goods purchased.
The following table shows how Sahan Industries offer discounts. Design an Interface to select customer status and to enter the total amount of purchases. Use Nested If Control Structure to get the necessary output. As you have to check more than one variable you can use the operator And. Study figures 4, 5 and 6 for this.

<table>
<thead>
<tr>
<th>Status</th>
<th>Total amount of Purchases in rupees</th>
<th>Discount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registered Customer</td>
<td>More than 100,000</td>
<td>10%</td>
</tr>
<tr>
<td></td>
<td>Less than 100,000</td>
<td>5%</td>
</tr>
<tr>
<td>Other customer</td>
<td>More than 100,000</td>
<td>5%</td>
</tr>
<tr>
<td></td>
<td>Less than 100,000</td>
<td>No Discount</td>
</tr>
</tbody>
</table>

Categorizing people by their age.
Following table shows one accepted way of categorizing people considering their age. Use Select Case control structure to output the age group when the age is entered in your interface. To separate the old group you can use Case Else Statement. Study figures 7 and 8 for this.
<table>
<thead>
<tr>
<th>Age</th>
<th>Age group</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 to 17 years</td>
<td>Child</td>
</tr>
<tr>
<td>18 to 40 years</td>
<td>Young</td>
</tr>
<tr>
<td>41 to 60 years</td>
<td>Middle aged</td>
</tr>
<tr>
<td>Above 60</td>
<td>Old</td>
</tr>
</tbody>
</table>
Competency 10: Writes programs to solve problems.

Competency Level 10.12: Develops programs involving basic repetitions.

Activity 10.12: Let’s write programs for repetitive tasks using the For-Next Loop.

Time: 60 minutes

Quality Inputs:
- A program of 10 statements to print a name of a person 10 times.
- Four copies of group exploration instructions in Annexe 10.12.1
- Four copies of the reading material in Annexe 10.12.2
- Demy sheets and markers

Learning - Teaching Process:
Step 10.12.1:
- Expose the program to the class.
- Get students to comment on the program and suggest ways and means of simplifying it.
- Conduct a discussion to highlight the following.
  - Writing the same statement 10 times is difficult.
  - Having to repeat it over 10 times is even more difficult.
  - The computer program observed can be revised to make this type of repetitive task simple.
  - A control structure called “Repetitions” is used in programming for this purpose.

(10 minutes)

Step 10.12.2:
- Divide the class into four groups.
- Distribute copies of group exploration instructions, reading material, demy sheets and pastels among the groups.
- Assign the four areas randomly to the four groups and involve them in the group exploration.
- Prepare them for an innovative whole class presentation.

(30 minutes)
Step 10.12.3:

- Get each group to present its findings.
- Request the presenters themselves to elaborate their findings.
- Get the other groups to submit constructive comments.
- Conclude the session by highlighting the following.

| The For-Next loop is one of the control structures used for repetitive tasks in programming. |
| The statements between For and Next in the program are made to repeat a specified number of times. |
| The first line of the For statement provides this specification. |
| The variable after For specifies the start value and end value for the repetition. |
| The program assigns the first value of the series to the variable and execute the lines up to the Next. |
| Then it assigns the next value and repeat the again. |
| This process continues up to the End value. |

(25 minutes)

Criteria for assessment and evaluation:

- Analyses the syntax of the For Next loop structure in relation to the repetitive task to be performed.
- States problems that can be solved by the For-Next loop structure.
- Writes programs to solve problems dealing with single repetition.
- Enriches discussions by sharing experiences with others.
- Develops structures to perform repetitive tasks efficiently and effectively.
Annex 10.12.1

Instructions for the Group Exploration

Let's write programs for repetitive tasks using the For-Next loop

- You will be working in four groups with the following four tasks assigned randomly to the four groups.
  - Write and execute a program to display numbers from 1 to 9.
  - Write and execute a program to print your name 10 times.
  - Write and execute a program to display numbers from 9 to 1.
  - Write and execute a program to print "*" 8 times.
- Go through the first part of the reading material to familiarize yourself on the For-Next loop, the syntax of the loop structure, and the code for the program developed.
- Now go through the second part of the reading material to gain knowledge and skills needed to write a program for the task given.
- Run the program to check its accuracy.
- Be prepared for an innovative, whole-class team presentation at plenary.
Part 1

Loop structures are statements that execute instructions repeatedly. Counter controlled repetition requires a counter variable (Loop counter). A Loop terminates when the counter value reaches a particular value.

A For loop is used when the number of repetitions is known. The For loop will loop from the given start value to the given stop value. The statements enclosed by For –Next loop, called the loop body are executed repeatedly until the loop terminates.

Syntax:
For <CounterVar> = <Start Value> To <End Value> step <increment or decrement value>
Statement
Next<CounterVar>

CounterVar is the counter variable

The number of iterations in For loop are determined by <Start Value> and <End Value>
Initially the counter variable receives the start value. Then it is incremented or decremented by the value of <increment/decrement value>. When the <CounterVar> is greater than <End Value> the loop terminates.

For X=1 To 4
Loop body
Next X

Value of x is incremented by one in every iteration (X=X+1)
In the first iteration  X is 1.
Second iteration $X$ is 2.
$X$ is 4 in the last iteration. Next $X$ assigns the value 5 to $X$. Since it is greater than 4 the
<End Value> loop terminates.

```
For $X = 1$ To 9 Step 2
    Loop Body
Next $X$
```

Here the value of $x$ is decremented by two in every iteration ( $X=X+2$)
In the first iteration $X$ is 1.
Second iteration $X$ is 3.
$X$ is 9 in the last iteration. Next $X$ assigns the value 11 to $X$. Since it is greater than 9 the
<End value> loop terminates.

```
For $X = 9$ To 1 Step -2
    Loop Body
Next $X$
```

Here the value of $x$ is incremented by two every iteration ( $X=X-2$)
In the first iteration $X$ is 9.
Second iteration $X$ is 7.
$X$ is 1 in the last iteration. Next $X$ assigns the value -1 to $X$. Since it is less than 1 the
<End value> loop terminates.

**Part 2**

Lets apply for-next loop to a program to display the numbers from 0 to 8 on the form when you click a command button.

```
Private sub Command1_click ()
    For $i = 0$ To 8
        Print $i$
    Next $i$
End Sub
```

Lets look at the above program.

For- for loop
Now let's apply for-next loop to a program to display “Hello” 3 times on the form when you click the command button.

Private sub Command1_ click ()
    For i= 0 To 2
        Print “Hello”
        Next i
End Sub

Let's look at the above program.
    For- for loop
    i - integer
    0 - starting value
    To –between start and stop (end) value
    2 – stop value
    Next – go to next step (if i>2 then end loop).
Competency Level 10.13 : Develops programs with different methods of repetitions.

Activity 10.13 : Let's write programs for repetitive tasks using the Do-while and Do–Until Loops.

Time : Two Hours

Quality Inputs :
- The Picture in Annexe 10.13.1
- Four copies of exploration instructions in Annexe 10.13.2
- Four copies of the reading material in Annexe 10.13.3
- Demy sheets and pastels

Learning - Teaching Process:

Step 10.13.1 :
- Expose the picture and the question to the class.
- Get three volunteers to answer the question.
- Conduct a discussion to highlight the following.

  - The number of times the child skips depends on the capability.
  - Therefore, the number of skips repeated is unknown.
  - Similarly, in programming, we have an unknown number of repetitions.
  - You have already studied the known repetitions in Visual Basic with For –Next loop.

(10 minutes)

Step 10.13.2 :
- Divide the class into four groups.
- Distribute copies of the group exploration instructions, reading material, demy sheets and pastels among the groups.
- Assign the four areas randomly to the four groups and involve them in the group exploration.
- Prepare them for an innovative whole class presentation.

(30 minutes)
Step 10.13.3 :
- Get each group to present its findings.
- Request the presenters themselves to elaborate on their findings.
- Get the other groups to submit their constructive comments.
- Conclude the session by highlighting the following.

- The Do-while loop is used for unknown repetitions.
- Actions in the Do-while structure are repeated while the condition is true.
- The condition is checked at the beginning of the Do-While loop and at the end of Do-Loop While.

(25 minutes)

Step 10.13.4 :
- Divide the class into four groups.
- Distribute copies of the group exploration instructions, reading material, demy sheets and pastels among the groups.
- Assign the four areas randomly to the four groups and involve them in the group exploration.
- Prepare them for an innovative whole class presentation.

(30 minutes)

Step 10.13.5 :
- Get each group to present its findings.
- Request the presenters themselves to elaborate on their findings.
- Get the other groups to submit constructive comments.
- Conclude the session by highlighting the follow

- The Do-Until loop is also used for unknown repetitions.
- The Do-Until loop fulfill the condition after each execution.
- The actions in Do-Until structure are repeated while the condition is false.

(30 minutes)
Criteria for assessment and evaluation:

- Describes the syntax of the loop structure of Do-While and Do-Until.
- Accepts that the Do-While and Do-Until loops are used when the amount of repetition is unknown.
- Writes a program to solve the given problem.
- Shares experience with others.
- Performs an unknown repetitive task efficiently and effectively.
Annex 10.13.2

Instructions for the Group Exploration

Let’s write programs for repetitive tasks using Do-While loop

- You will be working in four groups with the following four tasks assigned randomly to the four groups.
  - Write and execute a program to display numbers less than 15
  - Write and execute a program to display numbers less than 14
  - Write and execute a program to display numbers less than 12.
  - Write and execute a program to display numbers less than 11.

- Go through the first part of the reading material.
- Identify the syntax of the Do-While loop structure, and the code for the program developed.
- Go through all these components to get a sound understanding about them.
- Now identify the section in the reading material that relates to your task
- Go through it carefully and write your own program.
- Run your program to check its accuracy.
- Be prepared for an innovative presentation at the plenary session.

(30 minutes)

Let’s write programs for repetitive tasks using the Do-Until loop

- You will be working in four groups with the following four tasks assigned randomly to the four groups.
  - Write and execute a program to display numbers greater than 15
  - Write and execute a program to display numbers greater than 14
  - Write and execute a program to display numbers greater than 12.
  - Write and execute a program to display numbers greater than 11

- Go through the second part of the reading material.
- Identify the syntax of the Do-Until loop structure, and the code for the program developed.
- Go through all these components to get a sound understanding about them.
- Now identify the section in the reading material that relates to your task
- Go through it carefully and write your own program.
- Run your program to check its accuracy.
- Be prepared for an innovative presentation at the plenary session.
Question
How many times will a child skip in five minutes using the skipping rope?

Annexe10.13.3

Reading Material

Part 1
Do-While loop is used to execute a block of statements an indefinite number of times. When Visual Basic executes Do-While loop, it first tests condition. If condition is False, it skips all the statements inside the loop. If it's True Visual Basic executes the statements inside the loop and then goes back to the Do While statement and tests the condition again. Consequently, the loop can execute any number of times, as long as condition is True.

Syntax:
Do While <condition>
    Statement(s)
Loop
Condition is evaluated after executing the statements in the loop

Do
    Statement(s)
Loop While <condition>

Example: Do-While loop

Output:
Example 2: Do-While loop

Output:

Part 2
Do-Until loop is also used to execute a block of statements an indefinite number of times. When Visual Basic executes Do-Until loop, it first tests condition. If condition is True, it skips all the statements inside the loop. If it's False Visual Basic executes the statements inside the loop and then goes back to the Do Until statement and tests the condition again. Consequently, the loop can execute any number of times, as long as condition is False.
Syntax:
Do Until <condition>
    Statement(s)
Loop

Condition is evaluated after executing the statements in the loop

Do
    Statement(s)
Loop Until <condition>

Example 1: Do-Until loop

Output:

In the above example, the numbers 1-10 are printed on the form, when you click the start button. If N>10 execution stops.

Example 2 Do Loop Until
Output:
Competency 10: Writes programs to solve problems

Competency Level 10.14: Develops programs using one dimensional array.

Activity 10.14: Let’s use arrays in programming.

Time: 120 minutes.

Quality Inputs:
- The table and student groups in Annexe 10.14.1 written on the board.
- Four copies of group exploration instructions in Annexe 10.14.2
- Four copies of reading material in Annexe 10.14.3

Learning – Teaching Process:

Step 10.14.1:
- Expose the table and student groups on the board to the class.
- Request the class to group the students and propose a method to identify different individuals.
- Lead a discussion to highlight the following.

- Student Perera can be named as A4
- “A” above refers to the group in which Perera is placed while “4” denotes his index in the group.
- Grouping items with similar characteristics thus provides an easy method of access.
- A particular item in a group / structure can be accessed through its index.
- Arrays are used to represent such groups / structures containing variables with similar characteristics.

(10 minutes)

Step 10.14.2:
- Divide the class into four groups.
- Provide each group with exploration instructions and reading materials
- Assign problems at random and involve them in the exploration.
- Prepare them for an innovative whole class presentation.

(60 minutes)

Step 10.14.3:
- Get the groups to present their findings.
- Request the presenters themselves to fill in any gaps they have left.
 Invite constructive comments from the other groups.

 Conclude the session by highlighting the following.

 - By definition, an array is a list of variables, all with an index and the same name.
 - Syntax of declaring one dimensional array is as follows.

   \texttt{Dim ArrayName (Lower Boundary To Upper Boundary) As Data Type}

 - The above “Lower Boundary To” is optional. If this part is not mentioned zero is assigned as the lower boundary.
 - Declaration of an array variable can be simplified as follows.

   \texttt{Dim ArrayName (Upper Boundary) As Data Type.}

 - The number of array elements created by the above declaration is Upper Boundary+1.
 - Data type is optional. If data type is not mentioned, it is taken as a variant type.
 - The syntax for the value assigning is as follows.

   \texttt{ArrayName(Array index) = Value}

 - Outputting values containing in an array is as follows

   \texttt{Print ArrayName(Array index)}

### Criteria for assessment and evaluation

- Presents the syntax of an array and describes its components.
- Selects array structures according to the requirement.
- Uses arrays to develop effective programs in an efficient manner.
- Works systematically to ensure success.
- Minimizes complexity using indexed symbols.
### Annexe 10.14.1

**Table on student names & groups.**

<table>
<thead>
<tr>
<th>Name</th>
<th>Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hema</td>
<td>A</td>
</tr>
<tr>
<td>Kamal</td>
<td>B</td>
</tr>
<tr>
<td>Nihal</td>
<td>A</td>
</tr>
<tr>
<td>Mala</td>
<td>B</td>
</tr>
<tr>
<td>Raja</td>
<td>C</td>
</tr>
<tr>
<td>Mari</td>
<td>A</td>
</tr>
<tr>
<td>Theja</td>
<td>B</td>
</tr>
<tr>
<td>Kamala</td>
<td>B</td>
</tr>
<tr>
<td>Perera</td>
<td>A</td>
</tr>
<tr>
<td>Peter</td>
<td>C</td>
</tr>
<tr>
<td>nayoma</td>
<td>B</td>
</tr>
</tbody>
</table>

**Possible Groups**

**Group A**
1. Hema
2. Nihal
3. Mari
4. Perera

**Group B**
1. Kamal
2. Mala
3. Theja
4. Kamala
5. nayoma

**Group C**
1. Raja
2. Peter
Annexe 10.14.2

Instructions for the Group Exploration

Let's develop a program using arrays

- You will be working in four groups with the following programs assigned to the four groups.
  - Use an array to store 10 random numbers and count all odd numbers in it.
  - Find the maximum number in an array that stores 10 random numbers.
  - Calculate the total of 10 numbers entered into an array from the keyboard.
  - Find the index of a particular number in an array that stores 15 random numbers.

- Design the interface as shown below by changing the caption and name properties as required.

```
Dim NumArray[4] As Integer    'Declaring an array as NumArray
Dim num As Integer
Private Sub Start_Click()
    NumArray(0) = 10                     'Assigning values to the array
    NumArray() = 20
    NumArray(2) = 30
    NumArray() = 40
    NumArray(4) = 50
    For num = 0 To 4     'Display the output
        If NumArray(num) <> 0 Then
            Print NumArray(num)
        End If
    Next num
End Sub
```

- Type the following program and run it.
Private Sub Exit_Click()
    End
End Sub

- Go through the reading material to detect any errors in the program.
- Correct the error identified and run the program
- Open a new project and design a suitable interface for the problem assigned to your group.
- Write a similar program to solve it and test it.
- Be prepared to make a whole-class, innovative, team presentation on your experiences, problems you have encountered and solutions tried out.
Reading Material

Introduction to Arrays
By definition, an array is a list of indexed variables, all with the same name. When we work with a single item, we only need to use one variable. However, if we have a list of items which are of similar type to deal with, we need to declare an array of variables instead of using a variable for each item. For example, if we need to enter hundred names, instead of declaring hundred different variables, we need to declare only one array. We differentiate between each item in the array by using subscript, the index value of each item, for example name(1), name(2), name(3) .......etc.

Declaring Arrays
We could use Dim statement to declare an array just as the way we declare a single variable. The general format to declare an array is as follow.

```
Dim arrayName(lower boundary to Upper boundary) as dataType
```
Where lower boundary indicates the index of first element and upper boundary indicates the index of last element in the array.

**Example**
```
Dim Count(100 to 500) as Integer
```
Declares an array that consists of the first element starting from Count(100) and ends at Count(500). The above “Lower Boundary To” is optional. If this part is not mentioned zero is assigned as the lower boundary.

Declaration of an array variable can be simplified as follows.

```
Dim ArrayName (Upper Boundary) As Data Type.
```
The number of array elements created by the above declaration is Upper Boundary+1.

**Example**
```
Dim CusName(10) as String
```
Will declare an array that consists of 11 elements, starting from CusName(0) through to CusName(10). Data type is optional. If data type is not mentioned, it is taken as a variant type.

Assigning and Accessing data
The syntax for the value assigning is as follows.

```
ArrayName(Array index) = Value
```

Example

NumArray(0) = 20
NumArray(1) = InputBox("Enter Number")

Accessing values containing in an array is as follows

Print ArrayName(Array index)

Example

Print NumArray(0)
Label1.capton = NumArray(1)

The loop control structure can be used to assign new values to an array and accessing the existing values in it.

Example

For N=0 to 10
    num(N)=N * 10
Next N

Example

For i=0 to 10
    Print num(i)
next I

Sample Program 1

Write the program to read the series of numbers through the keyboard and find the place of a particular number in the series

The codes

Dim num(11) As Integer
Dim i As Integer
Dim place, countp As Integer

Private Sub Start_Click()
    countp = 0
    i = 0
    place = 0
    For i = 0 To 10
        num(i) = InputBox("Enter Number") 'Read numbers from keyboard
next i
Next i
MsgBox ("Number entering is over")
place = InputBox("Enter the number that you want to find the index")
Do While num(countp) <> place       'Display the output
    countp = countp + 1
Loop
Form1.Print countp
End Sub

Sample Program 2
Develop a program to calculate the square root of numbers from 1 to 10 and display same?
Interface

The codes
Dim Numarray(10) As String
Dim num As Integer

Private Sub Start_Click()
    For num = 1 To 10       'assign values to an array
        Numarray(num) = num ^ (1/2)
    Next num
    For num = 1 To 10       'display the out put
        If Numarray(num) <> "" Then
            Text1 = Text1 & " , " & Numarray(num)
        End If
    Next num
End Sub
Private Sub Exit_Click()
    End
End Sub
Competency Level 10.15: Develops programs using Functions and procedures.

Activity 10.15: Let’s break down a complex program into small parts to simplify its solution.

Time: 120 minutes.

Quality Inputs:
- Sample program in the folder 10.15 of the CD.
- Four copies of group exploration instructions in Annexe 10.15.1
- Four copies of reading material in Annexe 10.15.2

Learning – Teaching Process:

Step 10.15.1:
- Let the students run the sample program and examine its code.
- Conduct a discussion to highlight the following:
  - Carrying out one big process in one go is difficult.
  - Dividing the whole process into sub processes is convenient.
  - A sub process can be evaluated separately.
  - Sub processes are executed in terms of the main process to achieve the main task.
  - The same sub process is applicable at different times to various stages in the main process.
  - A particular sub process can be applied to different process making with or without small changes.
  - These sub processes are identified as Procedures and Functions in programming.

(15 minutes)

Step 10.15.2:
- Divide the class into four groups.
- Provide each group with instructions for group exploration and reading materials.
- Assign the problems to the groups at random and involve them in the exploration.
● Prepare them for an innovative whole class group presentation.

(30 minutes)

Step 10.15.3 : ● Get the groups to present their findings.

● Request the presenters themselves to fill in any gaps they have left.

● Invite constructive comments from the other groups.

● Conclude the session by highlighting the following.

- Writing programs can be simplified by breaking them down into smaller logical components.
- These components are called procedures
  - Procedures are useful for condensing repeated or shared tasks.
  - A program containing procedures provides an easy way of debugging.
  - Procedures can be made to act as building blocks, with or without modifications, to build other programs.
- There are two types of procedures used in Visual Basic:
  - Sub procedures - do not return a value.
  - Function procedures - return a value.

- The Syntax for Sub procedures

  Private Sub ProcedureName( parameters/arguments )
  statement(s)
  End Sub

Although parameters/arguments can, at times be left out the pair of brackets must always be there.

A Sub procedure is called with a statement as follows:

  Call ProcedureName( parameters/arguments )
The Syntax for Functions

Private Function Function Name (parameter1 As data_type,
    parameter2 As data_type, ...) As return_data_type
    Statement(s)
    Function Name = Return value_that_the_function_returns
    End Function

A Function is called with a statement of the form.

variable1 = FunctionName (parameter1, parameter2,...)

Scope for Public and Private

- Public indicates that the function is applicable to the whole program.
- Private indicates that the function is only applicable to a certain module or procedure.

Criteria for assessment and evaluation

- Describes the syntax of functions and procedures.
- Applies functions and procedures to suit the requirement.
- Uses functions and procedures to develop programs.
- Manages complex jobs effectively by breaking them into smaller jobs.
- Reaches efficiency through systematic planning.
Annexe 10.15.1

Instructions for the Group exploration

Let's develop programs using Functions and procedures

- You will be working in four groups.
- The following four tasks are assigned randomly to the four groups.

  o Write a program to change the fore color and the Back color of the label. It should have following facilities.
    - Select Back Color Or Fore Color using Option buttons
    - Change Red Green Blue Colors Using Three Scroll Bars.
  Write one procedure for the task and call it different event procedures as necessary.

  o Write a Program to add two numbers and output the result in the text box.
    - Write a function to add two numbers with passing arguments and re-call it as required to the click event of the buttons to facilitate the followings.
    - Add Button - add two numbers assigned within the event procedure.
    - Key board - add two numbers given by the key board.
o Write a procedure to pass string values to the caption of the labels 1 and 2 and call these procedures to the three buttons to perform following.
  
  • Each button should display the text similar to its caption in the label 1 and a suitable value relevant to it in the label 2

o Write two functions to find the area and the perimeter of a rectangle in form 3.
  
  • Call these functions to the click event of the two relevant buttons in each form to calculate perimeter and area of a rectangle with given dimensions

- Identify the problems assigned to your group.
- Go through the reading materials and understand the role played by procedures and functions in programming.
- Open VB 6.0, and design the relevant interface
- Test the program giving relevant values
- Be prepared to present your findings at the plenary session.
Reading Material

Introduction to Procedures

You can simplify programming tasks by breaking programs into smaller logical components. These components, called *procedures*, can then become the building blocks that let you enhance and extend Visual Basic.

Procedures are useful for condensing repeated or shared tasks, such as frequently used calculations, text and control manipulation, and database operations.

There are two major benefits of programming with procedures:

- Procedures allow you to break your programs into discrete logical units, each of which you can debug more easily than an entire program without procedures.
- Procedures used in one program can act as building blocks for other programs, usually with little or no modification.
- They allow a team of programmers to work on a single program.

There are two types of procedures used in Visual Basic:

- **Sub procedures**: do not return a value.
- **Functions**: return a value.

The main difference of a function from a procedure is that a function returns a value to the calling procedure while a procedure does not return a value to the calling procedure.

To distinguish them from event procedures (Not considered in this section), Sub and Function procedures are referred to as general procedures.

**Sub Procedures**:

A Sub procedure is a part of a program that performs one or more specific tasks, has its own name, and is written as a separate part of the program.

The Syntax

```
Private Sub ProcedureName( parameters/arguments )
    statement(s)
End Sub
```

Although parameters/arguments are optional open and close brackets should be there.

A Sub procedure is invoked with a statement as:

```
Call ProcedureName( parameters/arguments )
```

The basic goal of naming general procedures is the same as naming variables. The name chosen for a sub procedure should describe the task it performs. Sub procedure can be entered directly into the code window.

**Example 1**

The example below shows how a procedure is written and how it is recalled to the main program.

```vba
Private Sub callproc_Click()
    Call Firstprocedure  'calling statement of procedure
End Sub

Private Sub Firstprocedure()
    Print "Aubowan"
End Sub
```

**Functions**
Functions are similar to normal procedures, but function returns a value to its calling procedure. The return data type can be of any standard data type of Visual Basic.

**The Syntax**

```
Private Function Function Name (parameter1 As data_type, parameter2 As data_type, ...) As return_data_type
    Statement(s)
    Function Name = Return value_that_the_function_returns
End Function
```

The name chosen for a function procedure should describe the task it performs. The `return_data_type` at the end of the function heading specifies the data type of the return value. A Function is invoked with a statement of the form:

```
variable1 = FunctionName (paramenter1, parameter2,...)
```

**Example 2**

The example below shows how a function is written and how it is recalled to the main program.

```vbnet
Private Sub callfunc_Click()
    Dim myfirst As String
    myfirst = firstfunction ' calling statement of Function
    Print myfirst
End Sub

Function firstfunction() As String
    firstfunction = "Good Morning"
End Function
```

**Passing parameters/Arguments to Procedures**

Usually the code in a procedure needs some information about the state of the program to do its job. This information consists of variables passed to the procedure when it is called. When a variable is passed to a procedure, it is called an argument or Parameters.

Consider the following program that calculates the sum of two numbers.

**Example 3**

**Without a sub routine**

```vbnet
Private Sub cmdAdd_Click()
```

Copyright © 2008 National Institute of Education - Sri Lanka. All rights reserved.
Dim Num1 As Integer
Dim Num2 As Integer
Dim Sum As Integer
Num1 = 2
Num2 = 3
Sum = Num1 + Num2
Sum.Text = Str(Sum)
End Sub

Example 4

Below is how the program above is written with sub routines.
Option Explicit
'----------------------main procedure-----------------------------------------------
Private Sub cmdadd_Click()
Dim Num1 As Integer
Dim Num2 As Integer
Dim Sum As Integer
 Call GetTwoNumbers(Num1, Num2)
 Call AddTheTwoNumbers(Num1, Num2, Sum)
 Call DisplayTheSum(Sum)
End Sub
'----------------------procedure 1-----------------------------------------------
Private Sub GetTwoNumbers(a, b)
a = 2
b = 3
End Sub
'----------------------procedure 2-----------------------------------------------
Private Sub AddTheTwoNumbers(c, d, e)
e = c + d
End Sub
'----------------------procedure 3-----------------------------------------------
Private Sub DisplayTheSum(d)
sumtxt.Text = Str(d)
End Sub

Argument Data Types
The arguments for procedures you write have the Variant data type by default. However, you can declare other data types for arguments. For example, the following function accepts a string and an integer:
This example gives the information whether lunch is available and the relevant menu when day(of week) and time are provided.

Example 5

Interface
Private Sub cmdshow_Click()
    Dim msg As String
    Call welcome(msg)
End Sub

Private Sub welcome(message As String)
    message = "You Are Welcome"
    Print message
End Sub

A program may have a number of procedures and functions

Example  6
Private Sub cmdAdd_Click()
    Dim total As Single
    ExplainPurpose()
    total = AddNums(2, 3)
    PrintNums(2, 3, total)
End Sub

Private Sub ExplainPurpose()
    MsgBox ("This program displays a sentence identifying two numbers and their sum")
End Sub

Private Sub PrintNums(num1 As Single, num2 As Single, theTotal As Single)
    MsgBox ("The sum of " & num1 & " and " & num2 & " is " & theTotal)
End Sub

Public Function AddNums(numA As Single, numB As Single) As Single
    Dim theTotalValue As Single
    theTotalValue = numA + numB
    AddNums = theTotalValue
End Function

Remarks: Notice that cmdAdd_Click, the main procedure, became very simple and easy to read. All the details are allocated to individual procedures and functions.
Scope of Public and Private
Public indicates that the function is applicable to the whole program and
Private indicates that the function is only applicable to a certain module or procedure.

Example 7
The code shown along with the following two forms indicates the use of private and public when declaring function or procedure. In form 7 Function convertcelcius has written with word public. So that function can be call into form 8. If the word public replaced with private, it can't be called to form 8 when calling it should mention the form name.
Competency 10: Write programs to solve problems.

Competency level 10.16: Controls programs using the timer object.

Activity 10.16 : Let’s use the timer control

Time : 60 minutes.

Quality inputs : • Four copies of the group exploration instruction sheet in Annex 10.16.1
                  • The soft copy stored in the CD ROM in folder 10.16.
                  • Four copies of reading material in Annex 10.16.2

Learning – Teaching Process:

Step 10.16.1 :

• Get the students to run the two sample programs in the CD
• Now ask them to scroll the scroll bar from left to right and report their observations.
• Request them to explain what they have observed.
• Conduct a discussion to highlight the following.

  • One program is developed to display time every second.
  • The other is developed to display different colors for odd and even numbers.
  • The time between two consecutive color displays is called the interval.
  • The interval between displays is changed by the scroll bar.
  • When the time interval is less the colors change faster while it is the reverse when the time interval more.
  • Timer control has used in the above programs.
  • The interval property of the timer is adjusted by the scroll bar.

(15 minutes)
Step 10.16.2:  
- Divide class into four groups.
- Distribute copies of the reading material and group exploration instructions among each group.
- Let the class run the sample program.
- Involve the groups in the exploration.

(30 minutes)

Step 10.16.3:  
- Get the groups to present their software.
- Get the other students to move around and use the software to take decisions.
- Invite constructive comments from the other groups.
- Conclude the session by highlighting the following.

- The Timer control is used to execute a code in the timer event periodically.
- Before the timer is started the Interval property has to be given a value greater than 0.
- A timer is started by setting the Enabled property to TRUE.
- The timer can be stopped while the application is running by setting the Enabled property to False or setting the interval property to 0.
- The units for the interval are milliseconds. So setting 1000 in the interval will make an event happen every second.

(15 minutes)

Criteria for Assessment and evaluation
- Applies the timer control effectively in programming.
- Set the interval property to match the requirement.
- Uses the timer control for animations.
- Shares experiences with others.
- Works cooperatively with others in decision-making.
Instructions for the Group Exploration.
Let's use the timer control

- You will be working in four groups with the following four programs assigned to control the process.
  - Displaying a message every second on the screen.
  - Moving a circle from left to right on the screen using buttons to start and to stop its movement.
  - Moving a circle from top to bottom on the screen using a scrollbar to control its speed.
  - Increasing the height of a rectangle gradually up to a specified limit.
- Go through the reading material to identify the use of the timer control and the timer event.
- Study the form in figure 1, property window in Figure 2 and the program code in figure 3 to see how the timer control is used to display the time every second.
- Study the form in figure 4 and the program code in figure 5 to learn how a text box has been used to change the interval property to control the speed of a process.
- Study the form in figure 6 and the program code in figure 7 to learn how timer is started and stopped.
- Study the program assigned to you and identify the controls, which are needed to design your interface.
- Identify the properties, which have to be changed with the help of timer control using timer event.
- Set the interval property as required.
- Identify the code that has to be written to execute the required program.
- Run the program and see whether it returns the required output.
- Be prepared for an innovative whole class team presentation.
Reading Material

Timer Control

A timer control allows you to generate events at specified time intervals.

So the interval property is very important.

A timer is started by setting the Enabled property to TRUE and giving the Interval property a value greater than 0. You can do this either from the property window or from the code.

The units for the interval property are milliseconds. So setting 1000 for the interval property can perform something every second.

For example, you can display time every second in the following example.

Timer controls only the display in the label.

Your application might look like the following.

![Figure 1](image1)

**Properties of the Timer Control**

. With these settings, the code in the event TClock_Timer will be executed approximately every second.

![Figure 2](image2)

Timer control can have only timer event.
Figure 3

Example 2

Changing the Interval Property

In the following example the program displays numbers at specified time intervals mentioned in the program.

Figure 4

When you type a number in the interval text box, Lcount label displays numbers one after the other working as a counter.

From this example, display speed can be controlled by changing the value of the interval.

Code

Figure 5

At each interval 1 is added to the previous Number.

This section changes the interval property.
Example 3

Starting and stopping a timer control.

The timer can be stopped while the application is running by setting the **Enabled** property to FALSE or setting the **Interval** property to 0.

![Example 3 Diagram]

**Figure 6**

**Code**

- **This command makes numbers start with 1.** (When the timer is running it adds one.)
- **This command makes the timer start**
- **This command makes the timer stop**
- **This command changes the interval property of timer when the scroll bar is scrolled and displays the interval in**
- **This command makes the shape change its color.**
Figure 7

This program can differentiate odd numbers from even numbers. A shape control changes its colour in accordance with the type of numbers. The Scroll bar has been used to change the interval property of the timer. The current value of the Scroll bar is displayed in the TInterval text box.

When you want to draw a shape, first draw the shape as if you were drawing another control on the form. The shape property of the property window helps you to make it a circle.
Competency : Writes programs to solve problems

Competency Level 10.17 : Develops programs to retrieve data from databases

Activity 10.17   : Let’s develop a program to retrieve and view data from a database
Time            : 180 Minutes
Quality Inputs  : • Print out or enlarged diagram of a table created in Access (Picture 1) and a form created in visual basic (Picture 2) in Annexe 10.17.1
                  • Four copies of group exploration instructions in Annexe 10.17.2
                  • Four sample forms in Annexe 10.17.3
                  • Four copies of graded directions to create the Data Environment and link the table in Annexe 10.17.4
                  • Soft copy of sample database containing four tables

Learning – teaching process:

Step 10.17.1 : • Expose enlarged copy of the table and form to the class
               • Conduct a discussion to highlight the following
                 • A database can be linked to a Visual Basic program
                 • Textboxes in a form can be used display and update data in tables
                 • Forms can be used to view a single record at a time
                 • Some properties of controls on the form can be changed to suit our requirements

(20 minutes)

Step 10.17.2 : • Divide the class into four groups.
               • Provide each group with copies of group exploration instructions and graded directions.
               • Request the groups to involve themselves in the exploration on the basis of the relevant form
               • Prepare the groups for an innovative, whole-class, team presentation.

(120 minutes)

Step 10.17.3 : • Get the groups to present their learning experiences.
               • Provide opportunities for the presenters to make the first elaboration
               • Invite constructive comments from the other groups
               • Conclude the session by highlighting the following.

Copyright © 2008 National Institute of Education - Sri Lanka. All rights reserved.
• Data Environment is used to link an Access database into Visual Basic
• In the Data Environment a connection string has to be created
• A command object has to be created in the connection
• A table name has to be assigned to the command object
• A text box can be used to display data of a field in a table
• A label can be used to give a descriptive name to a field in a table
• To display data from a field in a text box, the following properties of the text box must be set
  o DataSource
  oDataMember
  oDataField
• Text boxes on a form can be used to display a single record at a time
• Usually, code has to be written in the click event of a command button to navigate between records (First, Previous, Next, Last)
• If the Previous button is clicked when the table record position is at the Beginning Of File (BOF) it generates an error
• Some extra line of code has to be written in the click event of Previous button to avoid this error
• If the Next button is clicked when the table record position is at the End Of File (EOF) it generates an error
• Some extra line of code has to be written in the click event of Next button to avoid this error
• Forms provide secure means of viewing data

Criteria for assessment and evaluation
• Describes how to connect a database to visual basic application
• Accepts that visual basic facilitates viewing of data on a database
• Connects a table in a database to Visual basic application
• Uses data in a database in an application confidently.
• Organizes information efficiently.
Note to the Teacher:

Create a folder named ICT in drive C in each of the four computers. Under the folder ICT create folders using the class name as the folder name.

e.g.

C:\ICT\10A
C:\ICT\10B
C:\ICT\10C
C:\ICT\10D
C:\ICT\10E

Create an access database called SAMPLE. It should contain four tables named Classes, Students, Marks and Employees.
The fields of the table are as follows.

<table>
<thead>
<tr>
<th>Classes</th>
<th>Class, Teacher, NoOfBoys, NoOfGirls</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employees</td>
<td>EmpNo, Name, Address, Salary</td>
</tr>
<tr>
<td>Marks</td>
<td>Name, English, Science, Maths</td>
</tr>
<tr>
<td>Students</td>
<td>AddNo, Name, Address, DOB</td>
</tr>
</tbody>
</table>

Add some sample data to the tables

Let the students remain in the same group throughout activities 10.17, 10.18, 10.19 and 10.20. Get them to work with the same table when creating forms, DataGrids and Reports. When saving the project get them to save their project as follows

Assign classes table to group one
Assign employees table to group two
Assign marks table to group three
Assign students table to group four

Saving the project

e.g   Grade 10A group one, students save their project as
      GroupOneProject_10A
      Grade 10B group three, students save their project as
      GroupThreeProject_10B

If Data Environment and Data Report Menu Items are not available in the Project menu, select Components in Project menu in the Visual Basic IDE to get Components dialog box. Then Click on the Designers tab and Check on Data Environment and Data Report options and click on OK.
### Annexe 10.17.1

<table>
<thead>
<tr>
<th>Contact ID</th>
<th>Name</th>
<th>WorkPhone</th>
<th>MobilePhone</th>
<th>EmailName</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>D. Perera</td>
<td>0112365473</td>
<td>0714560362</td>
<td><a href="mailto:perera@abc.com">perera@abc.com</a></td>
</tr>
<tr>
<td>2</td>
<td>G. Silva</td>
<td>0112547896</td>
<td>0781215487</td>
<td><a href="mailto:silva@ads.com">silva@ads.com</a></td>
</tr>
<tr>
<td>3</td>
<td>K. Fernando</td>
<td>0114856321</td>
<td>0714852147</td>
<td><a href="mailto:fernando@navita.com">fernando@navita.com</a></td>
</tr>
<tr>
<td>4</td>
<td>G. Jayasinghe</td>
<td>0012546905</td>
<td>0706532413</td>
<td><a href="mailto:jaya@webcom.lk">jaya@webcom.lk</a></td>
</tr>
<tr>
<td>5</td>
<td>P. Samarasin</td>
<td>0367456963</td>
<td>0773217896</td>
<td><a href="mailto:pnyanta@kemlag.com">pnyanta@kemlag.com</a></td>
</tr>
<tr>
<td>6</td>
<td>M. Nzeem</td>
<td>0374524178</td>
<td>0777869832</td>
<td><a href="mailto:nzeem@noka.com">nzeem@noka.com</a></td>
</tr>
<tr>
<td>7</td>
<td>H. Hameed</td>
<td>0112857412</td>
<td>0773524178</td>
<td><a href="mailto:hameed@share.lk">hameed@share.lk</a></td>
</tr>
<tr>
<td>8</td>
<td>M. Y. Silva</td>
<td>0112368596</td>
<td>0712365211</td>
<td>msilva@sim@com</td>
</tr>
</tbody>
</table>
Annexe 10.17.2

Instructions for the Group Exploration
Lets develop programs to retrieve data from databases

- You will be working in four groups with one of the following tables in the sample database assigned to your group
  - Table containing classes information
  - Table containing staff(Employee) information
  - Table containing test marks information
  - Table containing students information
- Launch Visual Basic, open (create) a new project (standard EXE), add a dataenvironment component to the project, create a command object under the connection in the dataenvironment and connect the table assigned to your group to command object.
- Go through the reading material to learn how to connect a table of a database to visual basic project
- Click on the Save button in the standard tool bar. (You will be prompted to save the dataenvironment, the form and the project)
- Save them as follows in the folder assigned to you by the teacher.
  e.g. suppose you are in grade 10A
  **Group one**
  DataEnvironment1 as DataEnvironment1
  Form as frmClasses
  Project as GroupOneProject_10A

  **Group Two**
  DataEnvironment1 as DataEnvironment1
  Form as frmEmployees
  Project as GroupTwoProject_10A

  **Group Three**
  DataEnvironment1 as DataEnvironment1
  Form as frmMarks
  Project as GroupThreeProject_10A

  **Group Four**
  DataEnvironment1 as DataEnvironment1
  Form as frmStudents
  Project as GroupFourProject_10A
- Use labels, text boxes and command buttons to design the form assigned to your group.
- Give a suitable title to your form using a label.
- Save the form by clicking on the save button and run the program. You will see the text boxes are still empty.
- Link the text boxes on the form to the table of the database. In order to do that the following properties of the text boxes appropriately.

<table>
<thead>
<tr>
<th>Datasource</th>
<th>Datamember</th>
<th>DataField</th>
</tr>
</thead>
</table>
- Run the application, click on the buttons and see what happens
- Stop the running program
- Double click on the icon representing your form in the project explorer window to bring it into focus
- Double click on the button with the caption **First**
- Add code to the click event of this button to move to the first record of the table
- Double click on the icon representing your form in the project explorer window to bring it into focus
- Double click on the button with the caption **Next**
- Add code to the click event of this button to move to the next record of the table
- Double click on the icon representing your form in the project explorer window to bring it into focus
- Double click on the button with the caption **Previous**
- Add code to the click event of this button to move to the previous record of the table
- Double click on the icon representing your form in the project explorer window to bring it into focus
- Double click on the button having the caption **Last**
- Add code to the click event of this button to move to the Last record of the table
- Save the form and the project
- Run the application and click on the buttons to see what happens
- Click on the button having the caption **First**, then click on the button having the caption **Previous**. Now you will have an error message, why has this error occurred? Try to modify the code in the click event of the **Previous** button. Get your teacher’s assistance.
- Click on the button with the caption **Last**, then click on the button having the caption **Next**. Now you will have an error message, why has this error occurred? Try to modify the code in the click event of the **Next** button. Get your teacher’s assistance.
- Run the application and click on the buttons
- Save the project
- Be prepared to make a whole-class, innovative, team presentation on your learning experiences.
### Table for Group 1: Classes

<table>
<thead>
<tr>
<th>Class</th>
<th>Teacher</th>
<th>NoOfBoys</th>
<th>NoOfGirls</th>
</tr>
</thead>
<tbody>
<tr>
<td>6A</td>
<td>Mr. K. Perera</td>
<td>17</td>
<td>23</td>
</tr>
<tr>
<td>6C</td>
<td>Mrs. N. Silva</td>
<td>23</td>
<td>16</td>
</tr>
<tr>
<td>6D</td>
<td>Mr. D. Sersenhe</td>
<td>21</td>
<td>20</td>
</tr>
<tr>
<td>7A</td>
<td>Mrs. B. Geethani</td>
<td>21</td>
<td>23</td>
</tr>
<tr>
<td>7B</td>
<td>Mrs. G. Kumari</td>
<td>18</td>
<td>25</td>
</tr>
<tr>
<td>8A</td>
<td>Mrs. D.M Premawathi</td>
<td>25</td>
<td>32</td>
</tr>
</tbody>
</table>

### Table for Group 2: Employees

<table>
<thead>
<tr>
<th>EmpNo</th>
<th>Name</th>
<th>Address</th>
<th>Salary</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Mr N.D Perera</td>
<td>No 51, Hill Street, Dehiwala</td>
<td>Rs 10,500.00</td>
</tr>
<tr>
<td>101</td>
<td>Mr Sam Silva</td>
<td>No 69, Angela Hill, Peradeniya</td>
<td>Rs 15,700.00</td>
</tr>
<tr>
<td>102</td>
<td>Mr Rohan Gunasekara</td>
<td>2nd Lane, Gammana Para, Maharagama</td>
<td>Rs 25,000.00</td>
</tr>
<tr>
<td>103</td>
<td>Mrs Geethani Jayakudi</td>
<td>No 25, Dalada Veediya, Kandy</td>
<td>Rs 18,500.00</td>
</tr>
<tr>
<td>104</td>
<td>Mr Sarath Kumara</td>
<td>No 1/16, Dutugemunu Veediya, Monaragala</td>
<td>Rs 17,200.00</td>
</tr>
<tr>
<td>105</td>
<td>Miss Inoka Gamage</td>
<td>No 25, Inner Circular Road, Ratnapura</td>
<td>Rs 16,892.10</td>
</tr>
<tr>
<td>106</td>
<td>Miss Iresha Kolambage</td>
<td>11th mile post, Monaragala Road, Buttala</td>
<td>Rs 17,099.90</td>
</tr>
</tbody>
</table>

### Table for Group 3: Marks

<table>
<thead>
<tr>
<th>Name</th>
<th>English</th>
<th>Science</th>
<th>Maths</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anuradha</td>
<td>65</td>
<td>45</td>
<td>70</td>
</tr>
<tr>
<td>K. Ajith Ranaweera</td>
<td>82</td>
<td>65</td>
<td>90</td>
</tr>
<tr>
<td>M.A. Kamal</td>
<td>25</td>
<td>36</td>
<td>45</td>
</tr>
<tr>
<td>P. Ruwan</td>
<td>35</td>
<td>65</td>
<td>98</td>
</tr>
<tr>
<td>R. Nimu Perera</td>
<td>58</td>
<td>75</td>
<td>98</td>
</tr>
<tr>
<td>R. Senadheera</td>
<td>75</td>
<td>35</td>
<td>50</td>
</tr>
<tr>
<td>Ruwan Jayasekera</td>
<td>50</td>
<td>56</td>
<td>85</td>
</tr>
</tbody>
</table>

### Table for Group 4: Students

<table>
<thead>
<tr>
<th>AddNo</th>
<th>Name</th>
<th>Address</th>
<th>DOB</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>M.A. Kamal</td>
<td>No 65, Danture, Kandy</td>
<td>8/9/1989</td>
</tr>
<tr>
<td>1001</td>
<td>R. Nimal Perera</td>
<td>2nd Lane, Badulla Road, Passara</td>
<td>7/8/1988</td>
</tr>
<tr>
<td>1002</td>
<td>P. Ruwan</td>
<td>No 01, Mihudu Mawatha, Bandarawella</td>
<td>8/6/1989</td>
</tr>
<tr>
<td>1003</td>
<td>Ruwan Jayasekera</td>
<td>1st mile post, Kandy Road, Gampola</td>
<td>5/2/1979</td>
</tr>
<tr>
<td>1004</td>
<td>Wasana Sepali</td>
<td>No 60, School Lane, Matara</td>
<td>1/1/1979</td>
</tr>
<tr>
<td>1005</td>
<td>D. Anuradha</td>
<td>NO 67, Kumbawela, Ella</td>
<td>3/2/1990</td>
</tr>
<tr>
<td>1006</td>
<td>R. Niranjan</td>
<td>433/4, Ramasinge Road, Gampulla</td>
<td>5/11/1980</td>
</tr>
<tr>
<td>1007</td>
<td>K. Ajith Ranaweera</td>
<td>No 78, Galle Road, Matara</td>
<td>12/1/1979</td>
</tr>
</tbody>
</table>
Form for Group One

- Set the properties of the form and objects as follows

<table>
<thead>
<tr>
<th>Object</th>
<th>Name</th>
<th>Caption / Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form1</td>
<td>frmClasses</td>
<td>Classes</td>
</tr>
<tr>
<td>Label1</td>
<td>lblClass</td>
<td>Class</td>
</tr>
<tr>
<td>Label2</td>
<td>lblTeacher</td>
<td>Teacher</td>
</tr>
<tr>
<td>Label3</td>
<td>lblBoys</td>
<td>No of Boys</td>
</tr>
<tr>
<td>Label4</td>
<td>lblGirls</td>
<td>No of Girls</td>
</tr>
<tr>
<td>Text1</td>
<td>txtClass</td>
<td></td>
</tr>
<tr>
<td>Text2</td>
<td>txtTeacher</td>
<td></td>
</tr>
<tr>
<td>Text3</td>
<td>txtBoys</td>
<td></td>
</tr>
<tr>
<td>Text4</td>
<td>txtGirls</td>
<td></td>
</tr>
<tr>
<td>Command1</td>
<td>cmdFirst</td>
<td>First</td>
</tr>
<tr>
<td>Command2</td>
<td>cmdPrevious</td>
<td>Previous</td>
</tr>
<tr>
<td>Command3</td>
<td>cmdNext</td>
<td>Next</td>
</tr>
<tr>
<td>Command4</td>
<td>cmdLast</td>
<td>Last</td>
</tr>
</tbody>
</table>

Form for Group Two

- Set the properties of the form and objects as follows
### Form for Group Three

- Set the properties of the form and objects as follows

<table>
<thead>
<tr>
<th>Object</th>
<th>Name</th>
<th>Caption / Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form1</td>
<td>frmMarks</td>
<td>Marks</td>
</tr>
<tr>
<td>Label1</td>
<td>lblName</td>
<td>Student Name</td>
</tr>
<tr>
<td>Label2</td>
<td>lblEnglish</td>
<td>English</td>
</tr>
<tr>
<td>Label3</td>
<td>lblScience</td>
<td>Science</td>
</tr>
<tr>
<td>Label4</td>
<td>lblMaths</td>
<td>Maths</td>
</tr>
<tr>
<td>Text1</td>
<td>txtName</td>
<td></td>
</tr>
<tr>
<td>Text2</td>
<td>txtEnglish</td>
<td></td>
</tr>
<tr>
<td>Text3</td>
<td>txtScience</td>
<td></td>
</tr>
<tr>
<td>Text4</td>
<td>txtMaths</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Object</th>
<th>Name</th>
<th>Caption / Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form1</td>
<td>frmEmployees</td>
<td>Employees</td>
</tr>
<tr>
<td>Label1</td>
<td>lblEmployeeNo</td>
<td>Employee No</td>
</tr>
<tr>
<td>Label2</td>
<td>lbName</td>
<td>Name</td>
</tr>
<tr>
<td>Label3</td>
<td>lblAddress</td>
<td>Address</td>
</tr>
<tr>
<td>Label4</td>
<td>lblSalary</td>
<td>Salary</td>
</tr>
<tr>
<td>Text1</td>
<td>txtEmployee</td>
<td></td>
</tr>
<tr>
<td>Text2</td>
<td>txtName</td>
<td></td>
</tr>
<tr>
<td>Text3</td>
<td>txtAddress</td>
<td></td>
</tr>
<tr>
<td>Text4</td>
<td>txtSalary</td>
<td></td>
</tr>
<tr>
<td>Command1</td>
<td>cmdFirst</td>
<td>First</td>
</tr>
<tr>
<td>Command2</td>
<td>cmdPrevious</td>
<td>Previous</td>
</tr>
<tr>
<td>Command3</td>
<td>cmdNext</td>
<td>Next</td>
</tr>
<tr>
<td>Command4</td>
<td>cmdLast</td>
<td>Last</td>
</tr>
</tbody>
</table>
Form for Group four

- Set the properties of the form and objects as follows

<table>
<thead>
<tr>
<th>Object</th>
<th>Name</th>
<th>Caption / Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form1</td>
<td>frmStudent</td>
<td>Student</td>
</tr>
<tr>
<td>Label1</td>
<td>lblAddNo</td>
<td>AddNo</td>
</tr>
<tr>
<td>Label2</td>
<td>lblName</td>
<td>Student Name</td>
</tr>
<tr>
<td>Label3</td>
<td>lblAddress</td>
<td>Address</td>
</tr>
<tr>
<td>Label4</td>
<td>lblDOB</td>
<td>DOB</td>
</tr>
<tr>
<td>Text1</td>
<td>txtAddNo</td>
<td></td>
</tr>
<tr>
<td>Text2</td>
<td>txtName</td>
<td></td>
</tr>
<tr>
<td>Text3</td>
<td>txtAddress</td>
<td></td>
</tr>
<tr>
<td>Text4</td>
<td>txtDOB</td>
<td></td>
</tr>
<tr>
<td>Command1</td>
<td>cmdFirst</td>
<td>First</td>
</tr>
<tr>
<td>Command2</td>
<td>cmdPrevious</td>
<td>Previous</td>
</tr>
<tr>
<td>Command3</td>
<td>cmdNext</td>
<td>Next</td>
</tr>
<tr>
<td>Command4</td>
<td>cmdLast</td>
<td>Last</td>
</tr>
</tbody>
</table>
Graded Directions

Creating a Data Environment to display records from a table in Visual Basic

We are going to connect the table named contacts in Sample database (C:\ict\Sample.mdb)

1. Launch Visual Basic, Select Standard EXE in the new tab in New Project Window, Click on Open.

2. Click Project → Data Environment

3. In the Dataenvironment window that appears, right click on Connection1 and click on Properties
4 In the Data Link Properties window make sure that Microsoft OLE DB provider for ODBC Drivers is selected and click on Connection tab.

5 In the connection tab, Click on Use Connection String option button and click on Build button
6 In the select Data Source Window, Click on Machine Data Source tab, Click on Ms Access Database and Click Ok.

7 In the Login Window Click on the Database Button

8 In the Select Database window, select the drive and folder where you have saved your database, select the database from the list, Click Ok.

9 Click Ok Button in the login Window,
10 Click on **Test Connection** Button. If You get this window, click OK. Again click Ok in the Data Link properties window.

11 Right Click **Connection1** and click on **Add Command**

12 Right click **Command1** and click on **properties**

13 Select **Table** in the Database object name, Select **contacts** (name of the table) as object name

14 Click OK

15 Close the Dataenvironment1 window

16 Lets save the project. Click on the save button, save the dataenvironment1 as dataenvironment1, from as frmcontacts, project as My_school in ICT folder in drive C)

17 Click No if you get this window
18 Add five labels to the form, change their caption properties to **Contact ID**, **Name**, **Home Phone**, **Mobile Phone**, **Email** respectively

19 Add five text boxes to the form, keep the text property blank by deleting text1, text2 etc.

Change the name properties of the text boxes as follows

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text1</td>
<td>txtContactID</td>
</tr>
<tr>
<td>Text2</td>
<td>txtName</td>
</tr>
<tr>
<td>Text3</td>
<td>txtHomePhone</td>
</tr>
<tr>
<td>Text4</td>
<td>txtMobilePhone</td>
</tr>
<tr>
<td>Text5</td>
<td>txtEmail</td>
</tr>
</tbody>
</table>

20 Add four command buttons, change their properties as follows

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Name</th>
<th>Caption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command1</td>
<td>cmdFirst</td>
<td>First</td>
</tr>
<tr>
<td>Command2</td>
<td>cmdPrevious</td>
<td>Previous</td>
</tr>
<tr>
<td>Command3</td>
<td>cmdNext</td>
<td>Next</td>
</tr>
<tr>
<td>Command4</td>
<td>cmdLast</td>
<td>Last</td>
</tr>
</tbody>
</table>

21 Add Another Label to the form Change its caption property to **Employee Contact Numbers**

The designed form should look like this

![Employee Contact Numbers Form](image)

22 Run the program, nothing is displayed in the text boxes

23 Close the form. If required Double click on the icon representing the form you designed in the project explorer window to bring it into focus (if the form you designed is not displayed in the project explorer window, double click on the forms icon in the project explorer window to display icons representing all the forms in the project (In this case only one)

24 Select the text box against the label **Contact ID** (**txtContactID**) Set the following Properties in order as follows.
25 Set the properties of other text boxes as follows

<table>
<thead>
<tr>
<th>Object Name</th>
<th>DataSource</th>
<th>DataMember</th>
<th>DataField</th>
</tr>
</thead>
<tbody>
<tr>
<td>txtName</td>
<td>DataEnvironment1</td>
<td>Command1</td>
<td>Name</td>
</tr>
<tr>
<td>txtHomePhone</td>
<td>DataEnvironment1</td>
<td>Command1</td>
<td>HomePhone</td>
</tr>
<tr>
<td>txtMobilePhone</td>
<td>DataEnvironment1</td>
<td>Command1</td>
<td>MobilePhone</td>
</tr>
<tr>
<td>txtEmail</td>
<td>DataEnvironment1</td>
<td>Command1</td>
<td>Email</td>
</tr>
</tbody>
</table>

26 Run the program now. You will see the text boxes filled with data from respective fields of the table. But Nothing happens when you click on the buttons.

27 Close the form. Double click on the button having the caption **First**, type the following line of code in the click event of the button. The code window should look like this.

```vba
Private Sub cmdFirst_Click()
    DataEnvironment1.rsCommand1.MoveFirst
End Sub
```

28 Double click on the icon representing the form you designed in the project explorer window to bring the form design window back

29 Double click on the button having the caption **Previous**, type the following line of code in the click event of the button. The code window should look like this.

```vba
Private Sub cmdPrevious_Click()
    DataEnvironment1.rsCommand1.MovePrevious
End Sub
```
30. Add code to other two buttons as well. The code window should look like this.

31. Save the project

32. Run the Project and click on the buttons to navigate between records of the table.

Note: If you click the **Previous** button after clicking the **First** button, an error will generate. To Avoid this error **modify** the **code** of the **Previous** button’s **click event** as follows.

```vbnet
Private Sub cmdPrevious_Click()
    If DataEnvironment1.rsCommand1.AbsolutePosition > 1 Then
        DataEnvironment1.rsCommand1.MovePrevious
    End If
End Sub
```

If you click the **Next** button after clicking the **Last** button, an error will generate. To Avoid this error **modify** the **code** of the **Next** button’s **click event** as follows.

```vbnet
Private Sub cmdNext_Click()
    If DataEnvironment1.rsCommand1.AbsolutePosition < DataEnvironment1.rsCommand1.RecordCount Then
        DataEnvironment1.rsCommand1.MoveNext
    End If
End Sub
```
Competency : Writes programs to solve problems

Competency Level 10.18 : Updates records in databases

Activity 10.18 : Let's develop a program to add, delete and edit records in a table of a database in Visual Basic

Time : 90 Minutes

Quality Input :

- Photo copies or enlarged copy of the form 1 and form 2 in Annexe 10.18.1
- Four copies of group exploration instructions in Annexe10.18.2
- Four sample forms in Annexe 10.18.3
- Four copies of graded directions to add, edit and delete records in Annexe10.18.4
- Soft copy of school database with four tables

Learning – teaching process:

Step 10.18.1 :

- Expose copy of the form to the class.
- Conduct a discussion to highlight the following

  - Visual Basic provides the facility to retrieve data from a table as well as manipulate data in it.
  - Some code has to be written to manipulate data in a table of a database
  - Usually, this code is written inside the click event of a command button.

(15 minutes)

Step 10.18.2 :

- Divide the class into four groups.
- Provide each group with copies of group exploration instructions and graded directions
- Request the groups to involve themselves in the exploration on the basis of the relevant form
- Prepare the groups for an innovative, whole-class, team presentation.

(60 minutes)

Step 10.18.3 :

- Get the groups to present their learning experiences.
- Provide opportunities for the presenters to make the first elaboration
• Invite constructive comments from the other groups
• Conclude the session so as to highlight the following.

<table>
<thead>
<tr>
<th>The methods defined in the data environment object can be used to</th>
</tr>
</thead>
<tbody>
<tr>
<td>o Edit the fields of a record</td>
</tr>
<tr>
<td>o Add a new record to a table</td>
</tr>
<tr>
<td>o Delete an existing record from a table</td>
</tr>
<tr>
<td>ReadWrite check box under the advanced tab in the properties of Connection 1 should be selected</td>
</tr>
<tr>
<td>“3 Optimistic” in the lock type list under the Advanced tab in the properties of the command1 should be selected</td>
</tr>
<tr>
<td>Visual Basic application provides a convenient way to manipulate data in a database.</td>
</tr>
<tr>
<td>Edited data are automatically recorded</td>
</tr>
<tr>
<td>Addition can be effected by clicking on Add button and entering data in blank form</td>
</tr>
<tr>
<td>Table should be refreshed following deletion of a record</td>
</tr>
</tbody>
</table>

(15 minutes)

Criteria for assessment and evaluation

• Describes different methods used in manipulating data
• Accepts that controls on a form provide an easy way to manipulate data
• Handles data in a table effectively
• Follows instructions to accomplish a task
• Works cooperatively in a group
Annexe 10.18.1

Employee Contact Numbers

- **Contact ID**: 1
- **Name**: D. Perera
- **Home Phone**: 0112365473
- **Mobile Phone**: 0714568362
- **E_Mail**: perera@abc.com

**Buttons**:
- First
- Previous
- Next
- Last
- Add
- Save
- Delete

---

Employee Contact Numbers

- **Contact ID**: 1
- **Name**: D. Perera
- **Home Phone**: 0112365473
- **Mobile Phone**: 0714568362
- **E_Mail**: perera@abc.com

**Buttons**:
- First
- Previous
- Next
- Last

---

Copyright © 2008 National Institute of Education - Sri Lanka. All rights reserved.
Annexe 10.18.2

Instructions for the Group Exploration

Let's update records in tables

- You will be working in four groups with one of the following
- Go through the reading material to become familiar with how to manipulate (Add, Edit, Delete) records using Visual Basic.
- Launch Visual Basic and open the project you developed and saved in the previous activity.
  Set the properties of the connection1 and command1 in the Dataenvironment1 window as specified by the reading material.
- Add three buttons to the form you developed, change their caption property to Add, Save and Delete. Your form should look like this.
- Run the application, Click on the buttons and see what happens, Stop the program.
- Double click on the button with the caption Add.
  Write the line of code to add a record to the table you were assigned.
- Double click on the icon in the project explorer window representing the form you developed.
- Double click on the button with the caption Save.
  Write the line of code to save the record you added to the table you were assigned.
- Double click on the icon in the project explorer window representing the form you developed.
- Double click on the button with the caption Delete.
  Write the line of code to delete the current record from the table.
- Run the program again, Click on the buttons and see what happens.
- When you click on the Add button, all the text boxes get cleared. So fill in the text boxes using suitable data.
- Click on Save button to save the newly entered data into the table.
- Modify the code of the Add button’s click event to display the message “One Record Saved” in a message box. If necessary get your teacher’s assistance.
- Save the project and the form.
- Be prepared to make a whole-class, innovative, team presentation on your learning experiences.
Graded Directions

How to manipulate data in a table of a database using Visual Basic

We are going to open the project developed in the previous lesson

1. Launch Visual Basic, Click on the Recent tab, select the project in the list and click on open

2. Double Click on the Dataenvironment1 icon in the project explorer window.

3. Right click on the connection1 in the dataenvironment1 window and click on properties

4. In the Data Link Properties window click on the Advanced tab, click on the check box against the word ReadWrite, Click Ok.
5 Right click on **Command1** in the Dataenvironment1 window and click on **properties**, click on the advanced tab, select **lock type** as **3.Optimistic**, Click Ok

![Frame Editor Properties dialog box](image1)

6 Double click on the frmEmployees icon in the project explorer window to bring the form we developed into design window

7 Resize the form and controls in it, set the font size to 10. Add three command buttons and change their name and caption properties as follows

<table>
<thead>
<tr>
<th>Object (Control)</th>
<th>Name</th>
<th>Caption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command1</td>
<td>cmdAdd</td>
<td>Add</td>
</tr>
<tr>
<td>Command2</td>
<td>cmdSave</td>
<td>Save</td>
</tr>
<tr>
<td>Command3</td>
<td>cmdDelete</td>
<td>Delete</td>
</tr>
</tbody>
</table>

The form should look like this

![Employee Contact Numbers form](image2)
8. Now double click on the button named **Add**. Write the following line of code inside the click event of the **Add** button:

```vbnet
Private Sub cmdAdd_Click()
    DataEnvironment1.rsCommand1.AddNew
End Sub
```

9. The code for the click event of the other three buttons should be as follows:

```vbnet
Private Sub cmdSave_Click()
    DataEnvironment1.rsCommand1.Update
End Sub

Private Sub cmdDelete_Click()
    DataEnvironment1.rsCommand1.Delete
    DataEnvironment1.rsCommand1.Update
    MsgBox ("Program will be terminated to effect the refreshment of the table.")
    Unload Me
End Sub
```

10. Run the Program, click on the buttons and see what happens.

   **Note:** When clicked on the **Delete** button, it will delete the current record displayed in text boxes. If you click on the **Delete** button again, an error will be generated. This is due to the current record being deleted. So modify the code of the click event of the **Delete** button to terminate the program as follows:

```vbnet
Private Sub cmdDelete_Click()
    DataEnvironment1.rsCommand1.Delete
    DataEnvironment1.rsCommand1.Update
    MsgBox ("Program will be terminated to effect the refreshment of the table.")
    Unload Me
End Sub
```
Competency : Writes programs to solve problems

Competency Level : 10.19 Handles data through data grids in Visual programming
Activity 10.19 : Let’s display all records of a table in a database in a Visual Basic project.

Time : 90 Minutes
Quality Input : ● An enlarged copy of the DataGrid created from a table in Annexe 10.19.1
● Four copies of group exploration instructions in Annex 10.19.2
● Four sample datagrids in Annexe 10.19.3
● Four copies of graded directions to add data grid control to a form in Annex 10.19.4
● Soft copy of sample database with four tables

Learning – teaching process:

Step 10.19.1 : ● Expose the enlarged Datagrid (Annexe 10.19.1) to the class
● Conduct a discussion to highlight the following
   • A data grid is used to display records of a table in a database
   • A data grid can be used to display all the records of a table
   • Information of more than one record can be found using a datagrid
   (15 minutes)

Step 10.19.2 : ● Divide the class into four groups.
● Provide each group with copies of group exploration instructions and graded directions.
● Request the groups to involve themselves in the exploration on the basis of the relevant data grid.
● Prepare the groups for an innovative, whole-class, team presentation.
   (60 minutes)

Step 10.19.3 : ● Get the groups to present their learning experiences
● Provide opportunities for the presenters to make the first elaboration
● Invite constructive comments from the other groups
• To manipulate data, DataGrid control has to be added to the Toolbox
• Dataenvironment should have been developed linking table
• DataSource and DataMember are two important properties when linking a table to the datagrid
• Data Grid control is used to view multiple records at once
• In a data grid we can edit and update multiple records
• We can use data grid to add new records to a table
• The appearance of the data grid control can be modified by changing
  the values of properties like;
  o BackColor
  o BorderStyle
  o ForeColor
  o Appearance
• Using a data grid is an easier way to manipulate data in a table
• Data Grid provides a secure and attractive interface to manipulate data

Criteria for assessment and evaluation

• Describes the advantages of different methods used in displaying data
• Accepts that DataGrids facilitates viewing of multiple records of a table
• Uses datagrid appropriately in an application
• Uses effective means of carrying out tasks.
• Engages in group activities
Instructions for the Group Exploration
Let’s display all records of a table of a database in Visual Basic

- You will be working in four groups with one of the following forms with a data grid assigned to your group
  - A data grid containing class information
  - A data grid containing staff information
  - A data grid containing test marks information
  - A data grid containing student information

- Launch Visual Basic and open the project you saved in the previous activities
- Go through the reading material and practice how to add a datagrid control to a form and display data in a table in the datagrid
- Run the project
- Try to do the following using the datagrid
  - Change the values in the fields
  - Add a new record to the table
  - Delete a record
- Close the form, Double click on the icon in the project explorer window representing the form you are working now.
- Right click on the datagrid and click on properties, uncheck AllowAddNew and click ok.
- Run the application and see whether you can add a new record now
- Experiment with other properties as well
- Be prepared to make a whole-class, innovative, team presentation on your learning experiences.
Annexe 10.19.3

Datagrid for group one

Datagrid for group two
Data grid for group three

<table>
<thead>
<tr>
<th>Name</th>
<th>English</th>
<th>Science</th>
<th>Maths</th>
</tr>
</thead>
<tbody>
<tr>
<td>R. Nimal Perera</td>
<td>58</td>
<td>75</td>
<td>69</td>
</tr>
<tr>
<td>M. A. Kamal</td>
<td>26</td>
<td>36</td>
<td>45</td>
</tr>
<tr>
<td>P. Ruwan</td>
<td>36</td>
<td>65</td>
<td>98</td>
</tr>
<tr>
<td>Ruwani Jayasekera</td>
<td>50</td>
<td>56</td>
<td>85</td>
</tr>
<tr>
<td>Wasana Sepali</td>
<td>74</td>
<td>69</td>
<td>68</td>
</tr>
<tr>
<td>D. Anuradha</td>
<td>65</td>
<td>45</td>
<td>70</td>
</tr>
<tr>
<td>R. Senadheera</td>
<td>75</td>
<td>36</td>
<td>50</td>
</tr>
<tr>
<td>K. Ajith Ranaweera</td>
<td>82</td>
<td>65</td>
<td>90</td>
</tr>
</tbody>
</table>

Data Grid for group four

<table>
<thead>
<tr>
<th>AddNo</th>
<th>Name</th>
<th>Address</th>
<th>DOB</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>M. A. Kamal</td>
<td>No 65, Danture, Kandy</td>
<td>8/9/1989</td>
</tr>
<tr>
<td>1001</td>
<td>R. Nimal Perera</td>
<td>2nd Lane, Badulla Road, Passara</td>
<td>7/8/1988</td>
</tr>
<tr>
<td>1002</td>
<td>P. Ruwan</td>
<td>No 01, Mihidu Mawatha, Bandarawela</td>
<td>8/6/1989</td>
</tr>
<tr>
<td>1003</td>
<td>Ruwani Jayasekera</td>
<td>1st mile post, Kandy Road, Gampola</td>
<td>5/2/1979</td>
</tr>
<tr>
<td>1004</td>
<td>Wasana Sepali</td>
<td>No 80, School Lane, Matara</td>
<td>1/1/1979</td>
</tr>
<tr>
<td>1005</td>
<td>D. Anuradha</td>
<td>NO 67, Kumbhalwela, Ella</td>
<td>3/2/1980</td>
</tr>
<tr>
<td>1006</td>
<td>R. Niranjan</td>
<td>433/4, Ranasinge Road, Ganimulla</td>
<td>5/11/1960</td>
</tr>
<tr>
<td>1007</td>
<td>K. Ajith Ranaweera</td>
<td>No 78, Galle Road, Mataraj</td>
<td>12/1/1979</td>
</tr>
</tbody>
</table>
How to add a data grid control to a visual basic form to display all the records of a table in a database

1 Open the project you saved in the previous activities
2 Click Project → Component, In the component window, Click on the check box having the caption Microsoft Data Grid control 6.0 (OLEDB) to add Data Grid control to the toolbox
3 Click Apply → Ok

Now you will have an icon in the Tool box representing the Data Grid control

4 Insert a new form (Project → Add form, in the new tab in the add form window, select form icon and click on open button)

5 Change the name of the form to frmGrid and save it

6 Click on the DataGrid icon in the toolbox, then draw a grid on the
form as shown

7 We are going to display the records of **contacts** (command1 in the DataEnvironment1) table. Click once on the DataGrid to select it. Set the following two properties of the DataGrid:

- **DataSource** = Dataenvironment1
- **DataMember** = Command1

(You can change other properties like font, font size, BackColor, ForeColor etc according to your requirements)

8 Right click on the Datagrid and select **Retrieve Fields** from the pop up menu.
9 Click on the Yes button in the message box that appears.
10 Right click on the DataGrid and click on Properties option. Make sure that check marks appear as shown below and click Ok.
9  Save the form. Set this form as the startup object of the project as follows.

Click on Project in main menu and select properties. In Project properties window select frmGrid as the startup object, Click on Ok button

10  Run the application. The result should be like this
Competency 10: Writes programs to solve problems

Competency Level 10.20: Creates reports to retrieve data in databases

Activity 10.20: Let's create a report in Visual Basic

Time: 90 Minutes

Quality Input:
- An enlarged copy of the report in Annexe 10.20.1 created from a table
- Four copies of group exploration instructions in Annexe 10.20.2
- Four sample school reports in Annexe 10.20.3
- Four copies of graded directions on creating reports in Annexe 10.20.4
- Soft copy of school database with four tables

Learning – teaching process:

Step 10.20.1:
- Expose the enlarged copy of the report to the class.
- Conduct a discussion to highlight the following
  - Data in the report have been obtained from a table previously developed
  - Data reports provide an effective way of presenting data in a printed format
  - Visual Basic can be used to develop attractive hard copies of data reports
  
  (10 minutes)

Step 10.20.2:
- Divide the class into four groups.
- Provide each group with copies of group exploration instructions and graded directions
- Request the groups to involve themselves in the exploration on the basis of the relevant report
- Prepare the groups for an innovative, whole-class, team presentation.

  (60 minutes)

Step 10.20.3:
- Get the groups to present their learning experiences.
- Provide opportunities for the presenters to make the first elaboration
- Invite constructive comments from the other groups.
Conclude the session by highlight the following.

- Reports provide the facility to obtain a hard copy of a table in a computer system
- The appearance of the report can be improved through formatting
- Data environment is used to link the table to the report
- Repeating text boxes enable fields of the table to be displayed in the report
- Report Width, Report Height, Top Margin, Bottom Margin, Left Margin and Right Margin are some important properties to be considered in obtaining a printout
- The show method of the report has to be called to view the data in the report
- The click event of a command button is usually used to call the show method of a report
- Reports provide two buttons for printing and saving

Criteria for assessment and evaluation

- Describes the advantages and disadvantages of different data retrieval methods
- Accepts that reports are very effective for printing data from a database
- Creates attractive reports using data from tables
- Uses effective means of presenting ideas
- Works cooperatively in a group
Annexe 10.20.1
Instructions for the Group Exploration

Let's create reports in Visual Basic

- You will be working in four groups with one of the following school reports assigned to your group
  - Report on Class Information
  - Report on Staff Information
  - Report on Test marks
  - Report on Student Information

- Open the project you saved in activity 10.19
- Go through section 1 of the reading material to add a data report to the project.
- Read section 2 to set the two properties Data Source and Data Member of the report.
- Now take action to design the report assigned to your group.
- Use labels to display report headings and column headings.
- Make the headings attractive by selecting suitable font, font size and forecolor.
- Create a text box in the detail section of the report for each field in the table.
- Link the text boxes to the fields of the table in the database.
- Save the work.
- Select the form design in the project and add a command button to it.
- Change the caption of the button to View Report.
- Double click on the button and write code to the click event as explained in section 15 of the graded directions.
- Save the project and the form.
- Run the program and click on View Report Button.
- Examine the report to ensure that it meets your expectations.
- Be prepared to make a whole –class, innovative, team presentation on your learning experiences.
Annexe 10.20.3

Reports on School Information

- **Classes**

![Classes Table]

- **Employees**

![Employees Table]
Marks

Mahanama Central College
Monaragala
Marks for three subjects - Year 10

<table>
<thead>
<tr>
<th>Name of the Student</th>
<th>English</th>
<th>Science</th>
<th>Maths</th>
</tr>
</thead>
<tbody>
<tr>
<td>R. Nimal Perera</td>
<td>58</td>
<td>75</td>
<td>68</td>
</tr>
<tr>
<td>M.A. Kamal</td>
<td>25</td>
<td>36</td>
<td>45</td>
</tr>
<tr>
<td>P. Ruwan</td>
<td>36</td>
<td>65</td>
<td>98</td>
</tr>
<tr>
<td>Ruvani Jayasekera</td>
<td>50</td>
<td>56</td>
<td>85</td>
</tr>
<tr>
<td>Wasana Sepali</td>
<td>74</td>
<td>69</td>
<td>68</td>
</tr>
<tr>
<td>D. Anuradha</td>
<td>65</td>
<td>45</td>
<td>70</td>
</tr>
<tr>
<td>R. Senadheera</td>
<td>75</td>
<td>35</td>
<td>50</td>
</tr>
<tr>
<td>K. Ajith Ranaweera</td>
<td>82</td>
<td>65</td>
<td>90</td>
</tr>
</tbody>
</table>

Students

Mahanama Central College
Monaragala
Details of Students

<table>
<thead>
<tr>
<th>Admission Number</th>
<th>Name of the Student</th>
<th>Address</th>
<th>Date of Birth</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>M. A. Kamal</td>
<td>No 65, Danture, Kandy</td>
<td>6/9/1989</td>
</tr>
<tr>
<td>1001</td>
<td>R. Nimal Perera</td>
<td>2nd Lane, Badulla Road, Passara</td>
<td>7/8/1988</td>
</tr>
<tr>
<td>1002</td>
<td>P. Ruwan</td>
<td>No 01, Mihidu Mawatha, Bandarawela</td>
<td>8/6/1989</td>
</tr>
<tr>
<td>1003</td>
<td>Ruvani Jayasekera</td>
<td>1st mile post, Kandy Road, Gampola</td>
<td>5/2/1979</td>
</tr>
<tr>
<td>1004</td>
<td>Wasana Sepali</td>
<td>No 80, School Lane, Mataara</td>
<td>1/1/1979</td>
</tr>
<tr>
<td>1005</td>
<td>D. Anuradha</td>
<td>NO 87, Kumbalwela, Ella</td>
<td>3/2/1980</td>
</tr>
<tr>
<td>1006</td>
<td>R. Niranj</td>
<td>433/4, Ranasinge Road, Ganemulla</td>
<td>5/11/1980</td>
</tr>
</tbody>
</table>
Reading Material

How to create a report using Visual Basic

Here we are going to create a report using the contacts table in the sample database. We use Dataenvironment1 created in activity 10.17 (which links contacts table) in preparing this report.

1. Click Project → Add Data Report

Now you will see the report design window.

2. Click on the title bar of the data report1 and set the following two important properties of the data report1 respectively.

   - **Datasource**: Dataenvironment1
   - **Data Member**: Command1

3. Close the gap between page header and report header sections by dragging the gray area (Page Header – section2) upward. (move the mouse pointer to the upper edge of the Page header – section2. Mouse pointer will change to a cross like shape. While holding down the left mouse button.Drag the gray area up to reduce the gap, down to increase the gap)
4 Increase the page header area by dragging the gray area (Detail- section1) down. Click on the label in the data report toolbox (left side of the screen), draw a label in the page header area of the data report window.

5 Click on the box in front of the caption property of the label in the properties window.

6 Type the title of the report as follows:
   Mahanama Central College (Or name of your school)

7 Change the font, font size and font color using the properties window of the label, resize the label as required (Click on the label to select it, drag from the corners).

8 Add another 3 labels to page header area, Change their caption as follows Monaragala, Employee Contact List, ******************, respectively.

9 Click on the top of the report design window (title bar) to select the report, change the following properties of the report in the properties window to meet your requirements:
   Top margin, Bottom Margin, Left Margin, Right Margin.

10 Click on a label to select the label and change the following properties to place it exactly where you want it.
   Left, Top
   Or use the mouse to move the label to the required position (Click and hold the left mouse button on the label, then drag).

The report we designed so far looks like this:

11 Click on the save icon in the standard toolbar, save the report using a suitable name (datareport1).

12 In the project explorer window, double click on the frmContacts icon to bring that form into focus.

13 Add a command button to this form, Change its caption property to Show Report.
14 Double click on the button named \textbf{Show Report} to get the code window.

15 Type the following line of code in the click event of the command button:

\begin{verbatim}
Datareport1.show
\end{verbatim}

16 Set \texttt{frmcontacts} as the startup object as shown in the picture.

17 Run the program and click on the \texttt{show report} button to view the report. Now you should see the report as follows.
(If you get an error message like, “**report width is greater than paper width**” close the data report window, close the form, double click on the datareport1 icon in the project explorer window to bring back report design. Reduce the report width by dragging the white area back(reposition the labels if required), save the report, run the program and click on the **Show report** button again to view the report. )

18 Get the report design window and add more labels to the Page Header section. Change the captions of the labels as follows

Contact ID, Name of the Teacher, Mobile Phone, Home Phone and E-mail

Draw a line using the line tool in the tool box below the field headings (labels). The report should look like as shown below

19 Save the report again by clicking on the save button, run the application, click on the show report button to view the half completed report. It looks like this
20 Close the report window. Get the report design window and select the detail section.

21 Create five repetitive text boxes in the detail section below each field heading.

22 Select the textbox for Contact_id and set its **DataField** property as contact_id. Set the **DataField** property for each text box as follows:
   - 2\textsuperscript{nd} text box: WorkPhone
   - 3\textsuperscript{rd} text box: MobilePhone
   - 4\textsuperscript{th} text box: EmailName

23 Use the line tool to draw a line below the fields in the detail section. Reduce the gap between the detail section and page footer section. Reduce the height of the report footer also. This is what the screen looks like:
24 Save the report, run application and lick on **Show Report** button to view the report. The Completed report looks like this

![Completed Report]

Click on the icon in the upper left corner of the data report window to print the report and to save the report click on the export button close to the print button.
Competency Level 11.1 : Selects suitable systems for automation purposes

Activity 11.1 : Let’s select a system for automation

Time : 120 Minutes

Quality Inputs :
- Pictures in Annexe 11.1.1 depicting systems of the human body
- Five copies of group exploration instructions in Annexe 11.1.2
- Five copies of the reading material in Annexe 11.1.3
- Demy sheets and markers

Learning - Teaching Process:

Step 11.1.1 :
- Expose the picture to the class.
- Get the class to identify the pictures as sub systems of the human body and the inputs, process, and the outputs of each system.
- Help them to observe the links between the sub systems.
- Conduct a discussion to highlight the following.
  - The human body is a natural system
  - There are several sub systems in the human body system.
  - Each sub system carries out a specific task that enables the human body to function.
  - Inter relationships exist between sub systems.
  - We come across a variety of natural and artificial systems in our day-to-day life.

(15 minutes)

Step 11.1.2 :
- Divide the class into five groups.
- Distribute copies of the exploration instructions, reading material, demy sheets and markers among the groups.
- Assign the five areas randomly to the five groups and involve them in the group exploration.
- Prepare them for an innovative whole class presentation at the plenary session.
Step 11.1.3:

- Get each group to present its findings.
- Request the presenters themselves to elaborate on their findings.
- Get the other groups to make constructive comments.
- Conclude the session by highlighting the following.

A system consists of three basic components - inputs, process and the outputs.

Defining boundaries help automate systems e.g. Students of a class.

Information systems generate useful information for decision-making.

Manual information systems can be converted into computer based information systems.

The automation process consists of several steps. System Development Life Cycle.

Artificial systems can be manual or automated.

Identification of the problem and feasibility studies are the first two steps of this process.

Criteria for assessment and evaluation:

- Defines a system and describes the components and functions of a system.
- Accepts the value of defining a problem and checking its feasibility in selecting systems for automation.
- Selects suitable problems for automation.
- Defines problems as a first step in recommending solutions.
- Conducts feasibility studies for efficiency and effectiveness.
Annexe11.1.1

Pictures of the different systems of the human body
Digestive System
Annex 11.1.2

Instructions for the Group Exploration
Let’s Select Systems for Automation

- You will be working in five groups with the following five areas assigned randomly to the five groups.
  - Student Attendance
  - Test marks
  - School Textbooks
  - Student Information
  - Canteen Transactions

- Go through the reading material to familiarize yourself with the following.
  - System and sub systems
  - Components of a system
  - System boundaries
  - Inter relations among systems
  - Need for automation of systems in terms of feasibility

- With focus on the area assigned to your group, identify the boundaries to define a feasible system.
- Identify the problems that necessitate the automation of the system.
- Prepare a list of user requirements to be met.
- Assess the utility value of automating the system in terms of the resources to be consumed.
- State whether you are ready to select the system for automation purposes.
- Name any other system, which you wish to select for automation.
- Give reasons for your decision.
29.1 Introduction

There are natural and man-made (designed) systems. Man-made systems normally have a certain purpose, objectives. They are "designed to work as a coherent entity". Natural systems may not have an apparent objective.

A system is a fundamental concept of systems theory, a way of thinking about the world, a model. We determine a system by choosing the relevant interactions we want to consider, plus choosing the system boundary — or, equivalently, providing a membership criteria to determine which entities are part of the system, and which entities are outside of the system and are therefore part of the environment of the system.

An open system usually interacts with some entities in their environment. A closed system is isolated from its environment.

An open system is a state of a system, in which a system continuously interacts with its environment. Open systems are those that maintain their state and exhibit the characteristics of openness previously mentioned.

Open systems contrast the closed systems. Systems are rarely ever either open or closed but open to some and closed to other influences. Basic characteristics of an open system are environment, input, throughput and output. And some control systems with feedback. The definition of a "system" is often arbitrary; a system may be defined as the region of space under study being characterized by a collection of components or elements related in some way.

The concept of an "open system" is originally developed in thermodynamics, and since the 1950s also in systems theory. Nowadays the concept has its applications in the natural and social sciences.

A subsystem is a set of elements, which is a system itself, and a part of a larger system.

A closed system is a system in the state of being isolated from the environment. It is often used to refer to a theoretical scenario where perfect closure is an assumption, however in practice no system can be completely closed; there are only varying degrees of closure.

A system that can exchange energy with the surroundings is referred to as an open system.

Systems are created to solve problems. One can think of the systems approach as an organized way of dealing with a problem. In this dynamic world, The subject System Analysis and Design, mainly deals with the software development activities.

29.3 Defining A System

A collection of components that work together to realize some objective, forms a system. Basically there are three major components in every system, namely input, processing and output.
In a system the different components are connected with each other and they are interdependent. For example, The human body represents a complete natural system. We are also bound by many national systems such as the political system, economic system, educational system and so forth. The objective of the system demand that some output is produced as a result of processing the suitable inputs.

The following are the different phases of software development cycle:

- Identification of the problem
- Feasibility study
- System analysis
- System design and Development (Coding)
- Testing
- Implementation
- Maintenance

Some systems in the universe, & inside the school and How they are identified

**In the universe**
- Solar System – The sun, nine planets and other sub-planets
- Ecological Systems – Forests, Ponds, Rivers etc.

**Outside the school**
- Computer System *
- Organizations – Bank, University, School, Office etc.

**In the school**
- Library System
- Canteen
- Daily Attendance
- Students Detail
- Staff Detail
- Principals’ Office
- Sports meet

* Computers can be found in the school. But they are not considered part of the school system because they are not included in the functions of the school system.

**Characteristics of a system**

- A system has a boundary
- It is made up of different components
- It has a specific task or related tasks towards a particular function
• It has input and output sub systems

A sub-system is a system which is part of another system. A system typically consists of components (or elements) which are connected together in order to facilitate the flow of information, matter or energy.

A System is a collection of components organized to accomplish a specific function or set of functions.
Competency 11 : Designs and develops an Information System to manage information in an efficient and effective manner

Competency Level 11.2: Analyses systems, selected for automation
Activity 11.2 : Let’s analyze selected systems for automation
Time : 180 minutes
Quality Inputs : • A table of G.C.E.(A/L) results of the past five years In Annexe 11.2.1
• A chart to analyze the above results In Annexe 11.2.2
• Five copies of group exploration Instruction sheet in Annexe 11.2.3
• Five copies of reading material in Annexe 11.2.4
• Demy sheets and markers

Learning -Teaching Process:
Step 11.2.1 :
• Expose the table to the class
• Then show the chart
• Conduct a discussion to highlight the following
  • Different methods are used to gather information. They are
    o Interviews
    o Documents
    o Observation
    o Discussions
  • Gathered information should be organized in a proper manner
    o Summarize
    o Charting and Graphing

(20 minutes)

Step 11.2.2 :
• Divide the class into five groups
• Distribute copies of the group exploration instructions, and reading material to each group with a demy sheet and markers.
• Involve the groups in the exploration
• Prepare them for an innovative presentation at the plenary session

(120 minutes)
Step 11.2.3:

- Get the groups to present their findings.
- Request the presenters themselves to fill in any gaps they have left.
- Invite constructive comments from the other groups.
- Conclude the session by highlighting the following.

  Several methods can be used to gather information
  Requirements and operations of the new system can be identified based on information gathered

(60 minutes)

Criteria for assessment and evaluation

- Names and describes the different techniques of gathering information
- Accepts the importance of analyzing gathered information to develop systems correctly
- Analyses systems for automation
- Identifies the problems in the approved manner before solving them
- Gathers necessary facts to solve problems.
Annexe 11.2.1

A table of G.C.E.(A/L) results of past four years

<table>
<thead>
<tr>
<th>Subject</th>
<th>2003</th>
<th>2004</th>
<th>2005</th>
<th>2006</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physics</td>
<td>22</td>
<td>18</td>
<td>15</td>
<td>20</td>
</tr>
<tr>
<td>Chemistry</td>
<td>23</td>
<td>19</td>
<td>24</td>
<td>26</td>
</tr>
<tr>
<td>Com. Maths</td>
<td>17</td>
<td>13</td>
<td>19</td>
<td>30</td>
</tr>
<tr>
<td>Biology</td>
<td>16</td>
<td>15</td>
<td>20</td>
<td>26</td>
</tr>
<tr>
<td>Agriculture</td>
<td>20</td>
<td>19</td>
<td>21</td>
<td>28</td>
</tr>
</tbody>
</table>

Annexe 11.2.2

A chart to analyze the above results
Annexe 11.2.3

Instructions for the Group Exploration

Let’s analyze selected systems for automation

- You will be working in your group, with the selected system
- Gather information using the most suitable information gathering technique described in the reading material
- Select an easier method and analyze your information
- Identify the system requirements based on the analyzed information
- Prepare your findings as inputs for the next stage of system development

Annexe 11.2.4

Reading Material

PHASES OF SYSTEM DEVELOPMENT LIFE CYCLE

Let us now describe the different phases and the related activities of system development life cycle in detail.

System Study

System study is the first stage of system development life cycle. This gives a clear picture of what actually the physical system is? In practice, the system study is done in two phases. In the first phase, the preliminary survey of the system is done which helps in identifying the scope of the system. The second phase of the system study is more detailed and in-depth study in which the identification of user’s requirement and the limitations and problems of the present system are studied. After completing the system study, a system proposal is prepared by the System Analyst (who studies the system) and placed before the user. The proposed system contains the findings of the present system and recommendations to overcome the limitations and problems of the present system in the light of the user’s requirements.

To describe the system study phase more analytically, we would say that system study phase passes through the following steps:

- problem identification and project initiation
- background analysis
- inference or findings

Feasibility Study

On the basis of result of the initial study, feasibility study takes place. The feasibility study is basically the test of the proposed system in the light of its workability, meeting user’s requirements, effective use of resources and of course, the cost effectiveness. The main goal of feasibility study is not to solve the problem but to achieve the scope. In the process of feasibility study, the cost and benefits are estimated with greater accuracy.

System Analysis

Assuming that a new system is to be developed, the next phase is system analysis. Analysis involved a detailed study of the current system, leading to specifications of a new system. Analysis is a detailed study of various operations performed by a system and their relationships within and outside the system. During analysis, data are collected on the available files, decision points and transactions handled by the present system. Interviews, on-site observation and questionnaire are
the tools used for system analysis. Using the following steps it becomes easy to draw the exact boundary of the new system under consideration:

- Keeping in view the problems and new requirements
- Workout the pros and cons including new areas of the system

The main points to be discussed in system analysis are:

- Specification of what the new system is to accomplish based on the user requirements.
- Functional hierarchy showing the functions to be performed by the new system and their relationship with each other.
- Function network which are similar to function hierarchy but they highlight the those functions which are common to more than one procedure.

Information Gathering Techniques

- Interviews – Face to face meeting of system users and other related people
- Questionnaires – Prepare questionnaires to collect required information
- Documents – Study of forms, bills, vouchers, slips, etc.
- Observation – Visit the site and observe what happens in the existing system
- Discussions – Individual or group Discussions

Data analyzing and organizing

- Summarizing
- Charting an graphing
- Any other suitable methods
Competency Level 11.3: Designs and develops computerized systems for analyzed manual systems

Activity 11.3: Let’s design and develop information systems

Time: 180 min

Quality Inputs:
- A diagram of sample flow chart and coding designed to solve simple problem
- Five copies of group exploration instruction in Annexe 11.3.1
- Five copies of reading material in Annexe 11.3.2
- Computer
- Demy Sheets and Markers

Learning Teaching Process:

Step 11.3.1:
- Expose the diagram to the class
- Conduct a discussion to highlight the following:
  - A Flow chart helps develop a solution to a problem
  - Coding is made easier by following the steps in a flow chart
  - The overall solution can be got by combining the codes

  (20 minutes)

Step 11.3.2:
- Use the same groups
- Provide the necessary instructions
- Involve the groups in the exploration
- Prepare groups for a whole class presentation

  (120 minutes)

Step 11.3.3:
- Get each group to present its findings.
  - Get the presenters themselves to fill in gaps, if any
  - Elicit constructive suggestions from the other groups.
  - Lead a discussion to highlight the following
• System Design involves
  o Interface design
  o Database design
  o Software design
• Interfaces help input and output
• Database design creates databases
• Software design involves coding
• Use of programming language is required to write a source code

(40 minutes)

Criteria for assessment and evaluation
• Names and describes the tasks of the design and development phase
• Accepts the importance of proper designing
• Designs and develops information systems
• Understands problems and designs solutions
• Maintains sequence in developing solutions
Instruction for the group exploration
Let’s design and develop information systems

- Follow the sequence below for the system you selected
- Design an interface to input data
- Design interface to output information
- Design appropriate databases to the system, if any
- Draw flow charts to illustrate the sequence of the solution
- Use programming language to write codes for the above

Reading Material

System Design
Based on the user requirements and the detailed analysis of a new system, the new system must be designed. This is the phase of system designing. It is a most crucial phase in the development of a system. Normally, the design proceeds in two stages:

- preliminary or general design
- Structure or detailed design

Preliminary or general design: In the preliminary or general design, the features of the new system are specified. The costs of implementing these features and the benefits to be derived are estimated. If the project is still considered to be feasible, we move to the detailed design stage.

Structure or Detailed design: In the detailed design stage, computer oriented work begins in earnest. At this stage, the design of the system becomes more structured. Structure design is a blue print of a computer system solution to a given problem having the same components and inter-relationship among the same components as the original problem. Input, output and processing specifications are drawn up in detail. In the design stage, the programming language and the platform in which the new system will run are also decided.

There are several tools and techniques used for designing. These tools and techniques are:

- Flowchart
- Data flow diagram (DFDs)
- Data dictionary
- Structured English
- Decision table
- Decision tree

Each of the above tools for designing will be discussed in detailed in the next lesson.

Coding
After designing the new system, the whole system is required to be converted into computer understanding language. Coding the new system into computer programming language does this. It is an important stage where the defined procedure is transformed into control specifications by the help of a computer language. This is also called the programming phase in which the programmer converts the program specifications into computer instructions, which we refer as programs. The programs coordinate the data movements and control the entire process in a system.
It is generally felt that the programs must be modular in nature. This helps in fast development, maintenance and future change, if required.

System design involves following stages

- Interface design,
  Interface Design the user Interface includes
  - Design Input
  - Design Output

- Database design
  Database design means design files and or databases

- Software design.
  Software design means design computer programs (coding)
Competency Level 11.4: Implements and tests for debugging of developed systems

Activity 11.4.1: Let's test and implement information systems

Time: 180 min

Quality Inputs:
- Computers with necessary software (Programming Language Other Application software)
- A soft copy of a simple program with errors
- Five copies of group exploration in Annexe 11.4.1
- Five copies of reading materials on “Test and implement of systems” in Annexe 11.4.2

Learning Teaching Process:

Step 11.4.1:
- Get Students to run a teacher defined program (with errors)
- Help them to spot and debug the errors in the program
- Conduct a discussion to highlight the following
  - If a program fails to provide the required output, we have to debug it until the required output is produced.
  - Likewise, a system also may have to be modified several times to get the appropriate output.

  (10 minutes)

Step 11.4.2:
- Use the same groups as in the previous activity.
- Distribute group exploration instructions, reading material, demy sheets and markers
- Involve the groups in the exploration
- Prepare groups for a whole class presentation

  (120 minutes)

Step 11.4.3:
- Get each group to present its findings.
- Get the presenters themselves to fill in gaps, if any
- Invite constructive comments from the other groups.
- Conduct a discussion to highlight the following
• Testing and debugging is one of the important phases in the System Development Life Cycle

• Checking and debugging for errors involves
  o Unit testing - testing isolated modules
  o Integrated testing – Combine modules and test
  o User acceptance testing – User must be satisfied with the system’s functionality.

• One of the following methods should be used in launching the new system
  o Direct Implementation
  o Parallel Implementation
  o Phase Implementation

• Proper documentation is important for maintenance

Criteria for assessment and evaluation
• Names and describes the testing and debugging methods
• Accepts the importance of testing before implementation
• Tests and debugs information systems
• Tests before implementation
• Corrects errors to get the exact output
Annexe 11.4.1

Instructions for Group Exploration
Let’s test and implement information systems

- Work in your usual group
- Test your system for errors using the following sequence
  - Unit or Module testing
  - Integrated or system testing
  - User acceptance testing
- Implement the system using an appropriate implementation method out of the following and make sure it solves the initial problem
  - Parallel Implementation
  - Phase Implementation
  - Direct Implementation

Annexe 11.4.2

Reading Materials

Testing

Before actually implementing the new system into operations, a test run of the system is done removing all the bugs, if any. It is an important phase of a successful system. After codifying the whole program of the system, a test plan should be developed and run on a given set of test data. The output of the test run should match the expected results.

The following test runs are carried out using the test data:

- Unit test
- System test
- User acceptance test

**Unit test:**
When the programs have been coded and compiled and brought to working conditions, they must be individually tested with the prepared test data. Any undesirable happening must be noted and debugged (error corrections).

**System Test**
After carrying out the unit test for each of the programs of the system and when errors are removed, then the system test is done. At this stage the test is done on actual data. The complete system is executed on the actual data. At each stage of the execution, the results or output of the system is analyzed. During the result analysis, it may be found that the outputs do not match the expected output of the system. In such cases, the errors in the particular programs are identified and are fixed and further tested for the expected output.

**User acceptance test**
When it is ensured that the system is running error-free, the users are called with their own actual data so that the system could be shown running as per their requirements (user acceptance testing).

**Implementation**

After having the user acceptance of the new system developed, the implementation phase begins. Implementation is the stage of a project during which theory is turned into practice. During this phase, all the programs of the system are loaded onto the user's computer. After loading the system, training of the users starts. Main topics of such type of training are:

- How to execute the package
- How to enter the data
- How to process the data (processing details)
- How to take out the reports

After the users are trained about the computerized system, manual working has to shift from manual to computerized working. The following two strategies are followed for running the system:

- Direct Implementation
- Parallel Running

**Direct Implementation**

With this method of implementation the users stop using the manual system and start using the computer system from a given date.

The advantage of this method is that it is less costly in effort and time than any other method of implementation. The disadvantage of this method is that if problems occur the users do not have any alternative apart from returning to a manual system which may prove difficult if it has been discontinued.

**Parallel Implementation**

With parallel running, the new system is introduced alongside the existing system. With parallel running both systems (manual and computer, or old computer and new computer system) will be in operation at the same time.

This strategy is helpful because of the following:

- Manual results can be compared with the results of the computerised system.
- Failure of the computerised system at the early stage, does not affect the working of the organisation, because the manual system continues to work, as it used to do.

However, it has the major disadvantage that each job is done twice and therefore it means a lot of extra work for the users.

**Phase Implementation**

The system is implemented phase by phase. One component is implemented first and others are implemented if it is successful.

i. **Pilot run:** In this type of run, the new system is installed in parts. Some part of the new system is installed first and executed successfully for considerable time period. When the results are found satisfactory then only other parts are implemented. This strategy builds the confidence and the errors are traced easily.
Competency 11 : Designs and develops an Information System to manage information in an efficient and effective manner

Competency Level 11.5 : Maintenance systems for smooth and continuous service

Activity 11.5 : Let’s maintain information systems

Time : 80 min

Quality Inputs :
- A warranty card for an article purchased (provided by the teacher)
- Computer lab
- Group Exploration instruction sheet in Annexe 11.5.1
- Reading material on system maintenance in Annexe 11.5.2
- Demy sheets and markers

Learning Teaching Process:

Step 11.5.1 :
- Show the warranty card to the class
- Conduct a discussion to highlight the following:
  - There should be a warranty for any goods or service after sale by the vendor
  - Warranty has to cover possible damage or failure
  - Systems also must carry a guaranteed against possible failure or shortcomings.
  - After installation, the system developer must be responsible for the proper maintenance and functioning of the system

  (20 minutes)

Step 11.5.2 :
- Get students to work with their own groups
- Provide necessary instructions
- Involve the groups in the exploration
- Prepare groups for a presentation at the plenary session

  (120 minutes)
Step 11.5.3:

- Get the groups to present their findings.
- Request the presenters themselves to fill in any gaps they have left.
- Invite constructive comments from the other groups.
- Conduct a discussion to highlight the following

<table>
<thead>
<tr>
<th>Error handling of operational level might involve one, two or all three categories below</th>
</tr>
</thead>
<tbody>
<tr>
<td>o Hardware compatibility</td>
</tr>
<tr>
<td>o Software compatibility</td>
</tr>
<tr>
<td>o Incompatible data</td>
</tr>
</tbody>
</table>

- The system needs to be modified as and when required as follows

| Add new user requirements |
| Expand organization |
| Adapt new technology |

- System maintenance involves the activities above

(60 minutes)

Criteria for assessment and evaluation

- Names and describes the different forms of operational level error handling
- Accepts the importance of maintaining systems
- Maintains systems to ensure efficient service
- Adapts to changes in daily life
- Cultivate the habit of follow up action
Annexe 11.5.1

Group Exploration Instructions
Let's maintain information systems

- You are working in your usual group and use the system developed
- Frequently visit the place where the system is installed and check it to see whether it is working properly
- Discuss with the users about any possible errors they have noticed.
- If so, take action to eliminate the error
- Improve the system to meet new user requirements.
- Create a maintenance report on the system
- Make an innovative whole class presentation

Annexe 11.5.2

Reading Material

Maintaining a system

The maintenance phase involves making changes to hardware, software, and documentation to support its operational effectiveness. It includes making changes to improve a system’s performance, correct problems, enhance security, or address user requirements. To ensure modifications do not disrupt operations or degrade a system’s performance or security. Organizations should establish appropriate change management standards and procedures.

Change management (sometimes referred to as configuration management) involves establishing baseline versions of products, services, and procedures and ensuring all changes are approved, documented, and disseminated. Change controls should address all aspects of an organization’s technology environment including software programs, hardware and software configurations, operational standards and procedures, and project management activities. Management should establish change controls that address major, routine, and emergency software modifications and software patches.

Major modifications involve significant changes to a system’s functionality. Management should implement major modifications using a well-structured process, such as an SDLC methodology. Routine changes are not as complex as major modifications and can usually be implemented in the normal course of business. Routine change controls should include procedures for requesting, evaluating, approving, testing, installing, and documenting software modifications.

Maintenance

Maintenance is necessary to eliminate errors in the system during its working life and to tune the system to any variations in its working environment. It has been seen that there are always some errors found in the system that must be noted and corrected. It also means the review of the system from time to time. The review of the system is done for:

- knowing the full capabilities of the system
- knowing the required changes or the additional requirements
- studying the performance

If a major change to a system is needed, a new project may have to be set up to carry out the change. The new project will then proceed through all the above life cycle phases.
Competency 12.0: Uses Internet for Effective Information Search and Communication.

Competency Level: Uses Internet to access information

Activity 12.1: Let's use the Internet to search for information.

Time: 120 minutes.

Quality Inputs:
- Two Copies of the Dialogue in Annexe 12.1.1
- Four copies of the Group Exploration Instruction sheet in Annexe 12.1.2
- Four copies of the Graded Directions in Annexe 12.1.3
- Four Copies of the reading material in Annexe 12.1.4

Learning – Teaching Process:

Step 12.1.1:
- Get two volunteers to present the dialogue to the class.
- Conduct a discussion to highlight the following.
  
  - Internet is a network of networks.
  - To access Internet the following will be needed.
    - A modem
    - Internet Service Provider
    - A web browser
    - A telephone line
  - The Internet gives us the ability to access information anywhere in the world.

  (20 minutes)

Step 12.1.2:
- Divide the class into four groups.
- Distribute copies of the group exploration instructions, Graded Directions and Reading Material
- Provide demy sheets & markers
- Involve the groups in the exploration.
- Prepare the groups for a presentation at the plenary session.

  (60 minutes)
Step 12.1.3

• Get each group to present its findings.
• Request the presenters themselves to fill in gaps, if any.
• Seek for constructive comments from the other groups.
• Conclude the session by highlighting the following.

- The World Wide Web is the collection of different services, and resources available on the Internet accessible through a Web browser.
- Web browser is software that gives a user access to the World Wide Web.
- Web page is a single, World Wide Web document.
- A collection of pages at the same address, or URL, is called a web site.
- Web address is the location of a Web page on the Internet.
- Every machine on the Internet has a unique identifying number, called an IP Address.
- Search engines are used to search information in WWW.
- Once connected we can type the Web Address and get linked to the needed web site straightaway.
- If web addresses are not known, we have to use the search engines using key words to find web sites relevant to the information.
- A search Engine is also a Web Site.
- Many Search Engines are available on the Internet.

(40 minutes)

Criteria for Assessment and Evaluation

- Names three web browsers and four search engines.
- Accepts that the Internet can be used to search for information.
- Seeks information using browsers and search engines.
- Demonstrates awareness of ethics in accessing information.
- Downloads information using the Internet.
Dialogue

Kamal : Hello, Nimal, where are you going?
Sunil : I’m going to the school to look for my results. Aren’t you?
Kamal : Haven’t you got your results yet?. I knew my results the evening before last.
Sunil : How come? The school receives the results by post, this morning. Doesn’t it?
Kamal : Sunil… Didn’t you listen to the evening news the day before yesterday? And it was announced that the results would be carried on the Internet at mid-night, the same day.
Sunil : Then how about yours?
Kamal : I’ve got 10 A’s.
Sunil : Congratulations, Oh! What do you mean by Internet?
Kamal : Well, now we don’t have to go to the school for each and every thing. My computer at home provides access to information.
Sunil : Tell me about this new development. I am totally ignorant.
Kamal : Internet is a global computer network that provides quick access to important information all over the world. By accessing the web site of the Examinations Department we can get results of public examinations. Let’s go to my place. I could go through the web site and watch yours’ too. Not only that, I can download it and get a print out.
Sunil : Thank you very much, Kamal. Then I can show it to the rest at home.
Annexe 12.1.2

Instructions for the Group Exploration

Let’s use the Internet to search for information.

- You will be working in four groups.
- On the basis of the reading material provided, carry out the part assigned to you by discussing it with the others in your group.
- Write down the important points relevant to your topic.
- Assign one of the following topics and a search engine below to each group.
  
  **Topics:**
  - Internet, and Internet services.
  - IP Address, URL and WWW.
  - Web browsers and search engines.
  - Web page and web site.
  
  - Search engines
    - Yahoo
    - MSN
    - Google
    - Altavista
  
  - Go through the search engine assigned to your group and search for the information listed below.
    - Water falls in Sri Lanka
    - Historical places in Sri Lanka
    - Sigiriya
    - Dalada Maligawa
  
  - Be prepared to present your findings at the plenary session
Annexe 12.1.3

**Graded Directions**

Select the following path to load the web browser (Internet Explorer)

Click: Start button → Programs → Internet Explorer or
Double click on Internet Explorer icon on Desktop.

If you do not know the Web address you could get help from the search engine or else you could type the address in the address bar.
How to load the search engine?

Type Web address of any search engine (eg: www.Yahoo.com) in the address bar of Internet Explorer web browser and click Go.
Screen layout of Google search engine web site
What is the Internet?

The Internet is a vast system of computers that are “networked”, or linked together, to exchange information. It is a network of networks. It is a shared global resource that is not owned regulated by anyone.

What do I need to access Internet?

To access Internet the following will be needed.

- Modem
- Internet Service (ISP)
- Web Browser
- A telephone line

Why we access Internet?

- To gain knowledge.
- To get information.
- To communicate with others.
- For entertainment.
- To buy or sell goods & services.
A computer delivers (serves up) Web pages. Every Web server has an IP address and possibly a domain name. For example, if you enter the URL http://www.pcwebopedia.com/index.html in your browser, this sends a request to the server whose domain name is 'pcwebopedia.com.' The server then fetches the page named 'index.html' and sends it to your browser.

A site (location) on the World Wide Web. Each Web site contains a home page, which is the first document users see when they enter the site. The site might also contain additional documents and files. Each site is owned and managed by an individual, company or organization.

An Internet address uniquely identifies a node on the Internet. The Internet address may also refer to the name of a Web site (URL). URL stands for Uniform Resource Locator.

To make it easier for us humans to remember, IP addresses are normally expressed in decimal format as a "dotted decimal number". But computers communicate in binary form.

The World Wide Web (WWW)
The World Wide Web, also known as WWW, comprises a vast collection of documents stored in computers all over the world. These specialized computers are linked to form part of a worldwide communication system called the Internet. When you conduct a search, you direct your computer’s browser to go to web sites where documents are stored and retrieve the requested information to display on your screen.

Web Page
A document written in HTML that can be accessed on the Internet is called a web page. Every Web page has a unique address called a URL. Web pages can contain text, graphics, and hyperlinks to other web pages and files

What is an IP address?
Every machine on the Internet has a unique identifying number, called an IP Address. A typical IP address looks like this:
216.27.61.137
11011000.00011011.00111101.10001001

Internet Address or Web Address?
For example, www.computerlanguage.com

Domain Name:
A name that identifies one or more IP addresses. For example, the domain name microsoft.com represents about a dozen IP addresses. Domain names are used in URLs to identify particular Web pages. For example, in the URL http://www.pcwebopedia.com/index.html, the domain name is pcwebopedia.com.

Every domain name has a suffix that indicates which top level domain (TLD) it belongs to. There are only a limited number of such domains. For example:

- **gov** - Government agencies
- **edu** - Educational institutions
- **org** - Organizations (nonprofit)
- **mil** - Military
• **com** - commercial business
• **net** - Network organizations

In addition, every country has its own top-level domain name.

<table>
<thead>
<tr>
<th>Domain Name</th>
<th>Country (Meaning)</th>
</tr>
</thead>
<tbody>
<tr>
<td>lk</td>
<td>Sri Lanka</td>
</tr>
<tr>
<td>uk</td>
<td>United Kingdom</td>
</tr>
<tr>
<td>au</td>
<td>Australia</td>
</tr>
<tr>
<td>us</td>
<td>United States</td>
</tr>
<tr>
<td>jp</td>
<td>Japan</td>
</tr>
</tbody>
</table>

Because the Internet is based on IP addresses, not domain names, every Web server requires a Domain Name System (DNS) server to translate domain names into IP addresses.

**Web Server**

A Web Server is a computer with special software to host web pages and web applications.

**Web Browser**

Software that gives a user access to the World Wide Web. Web browsers provide a graphical interface that lets users click buttons, icons, and menu options to view and navigate Web pages. Netscape Navigator and Microsoft Internet Explorer are popular Web browsers. Web pages are what you see in a web browser.

**Search Engine**

Some Popular search engines are:

A search engine provides the means for humans to find things in all the millions of web pages out there. You type in a few words, click the search button and you get a list of web pages. Search engines collect information from more than just Web Pages. They search through news groups, file servers and other sources.

When you use a search engine, you're not really searching the Internet, you're searching the database file. The Internet is just too big to search directly.
Competency Level 12.2: Communicates using e-mail

Activity 12.2. : Lets communicate using e-mail

Quality Inputs : ● Two copies of the dialogue in Annexe 12.2.1
● Three copies of group exploration instructions in Annexe 12.2.2
● Three copies of graded directions in Annexe 12.2.3
● Three copies of reading material in Annexe 12.2.4

Learning – teaching process:

Step 12.2.1 : ● Get two volunteers to present the dialogue to the class.
● Conduct a discussion to highlight the following

- E-mail or electronic mail is a new way of communication.
- It is an electronic mailing system.
- To send or receive e-mail, an e-mail address is needed.
- An e-mail address is unique and contains two main parts
  - User name
  - Domain name
- The User name and Domain name are separated by @ sign.
- Domain name indicates the service provider.
- The User name is given by the user and identifies the user uniquely.
- This is a very cheap and fast electronic mailing system used to send or receive mail.
- One can create a free e-mail address through the Internet.

(10 minutes)

Step 12.2.2 : ● Divide the class into three groups.
● Provide each group with copies of Annexes 12.2.2, 12.2.3 and 12.2.4
● Get each group to create its own e-mail account according to the given domain.

(30 minutes)
Step 12.2.3:

- Get each group to present its findings.
- Conduct a discussion to highlight the following.

- To access an e-mail address the user name and the password is needed.

- The capacity to hold mails differs according to domain

- The E-mail facility provided by some search engines is free of charge.
- E-mail accounts created using search engines can be accessed from anywhere in the world.
- Internet is essential to create an email account through search engines.
- Eudora and Outlook express are some communication software used to send or receive e-mail.
- Audio, video, pictures and text files can be attached to the email.
- Extra copies of the original mail could be sent as carbon copies (Cc s).
- The receiver of the original mail can see the addresses of the Cc s but receivers of Cc s cannot view addresses of those receiving the original.

(20 minutes)

Criteria for assessment and evaluation

- Names and describes the advantages of email.
- Is motivated to use email.
- Communicates using email.
- Conforms to the relevant ethics.
- Works cooperatively with peers.
Annexe 12.2.1

Dialogue between two friends

**Peter:** Hai! Nalin, How are you? I tried several times to contact you?

**Nalin:** Fine! I am busy with business matters going here and there. Dear

**Peter:** I too have a business matter with you. So, tell me how I could get in touch with you.

**Nalin:** Well, Here’s my e-mail address. I check my mail daily.

**Peter:** Hey! What’s this? I have no idea about it. Could you explain please?

**Nalin:** This is a very cheap and fast electronic mailing system used to send or receive mail. You can create a free e-mail address through Internet. Sorry dear, I have to visit a friend now. I will give you more information later, Bye

**Peter:** Thank you!. Bye.

Annexe 12.2.2

Instructions for the group exploration

**Let’s communicate using e-mail**

- You will be working in three groups.
- Go through the reading material in annexe 12.2.4 and learn about e-mail
- Use the graded direction in annexe 12.2.3 to create an e-mail account.
- Assign one of the following email address and a search engine below to each group.

- Create a free web base e-mail account using [www.google.com](http://www.google.com)
  And E-mail address **Group1@gmail.com**

- Create a free web base e-mail account using [www.msn.com](http://www.msn.com).
  And E-mail address **Group2@hotmail.com**

- Create a free web base e-mail account using [www.netscape.com](http://www.netscape.com).
And E-mail address  Group3@aol.com

- Take care about how you interpret terms such as check mail, compose, cc and bcc
- Send mails to other groups. and check mails you received.
- Be prepared for an innovative, whole class and team presentation at plenary session

Annexe 12.2.3

Graded Directions

- Follow these instructions to create an email account.

To create a free email account
- Use a web browser to connect the Internet and load www.yahoo.com web site.
  Start → Programs → Internet Explorer → Type http://www.yahoo.com → Press Enter

![Fig. 1](yahoo.png)

This will open Yahoo.com in a new browser window.
- Click on My Mail button or Mail icon in Fig. 1

![Sign in to Yahoo!](sign_in.png)

- Click Sign Up hyperlink.
• Fill in this form correctly.

![Image of Yahoo Registration window]

• Click on **Submit** button.

• The Yahoo mail page will appear.

**Sending & receiving mails**

• Start → Programs → Internet Explorer → Type [http://www.yahoo.com](http://www.yahoo.com) → Press Enter
This will open Yahoo.com in a new browser window.

- Click on **My Mail** button or **Mail** image in Fig. 1
- The following login screen will appear.

  ![Login Screen](image)

  - Enter your **Yahoo ID** in the Yahoo ID text box and **Password** in the Password text box.
  - Then click on the **Sign In** button.
  - A screen similar to the following will appear.

  ![Mail Window](image)

  **Composing a new message**
• Click on the Compose button.

• Then the following screen will appear.

![Email Composition Screen]

• Enter the email address of the person that you are sending the message to in the “To:” field. If there are multiple recipients, then their addresses have to be separated by commas (,) or semi colons (;)

• Enter the email address of any other person in the Cc: field, that you wish to receive copies of the message.

• Enter the subject of your message in to the main window.

• If you want to attach a file, click on the Attach Files button.

• Select the location of a file you want by clicking on the Browse button.

• Select the file you want to attach and then click on the Open button.

• Then click on the Attach Files button

• Click on the Done button.
Sending the message:

- Click on the Send button.
- Then a confirmation message will be displayed.

Check Mail:

- Click on the Check Mail button or Inbox link on the folders section.
- The Inbox will be displayed with a list of read and unread messages.
- The unread messages will be displayed in bold.
- Click on the subject of the message to view the message body.

After checking the mail you can either,

- Reply
- Reply All
- Forward or Delete the message.

Annexe 12.2.4

Reading Material

Introduction to E-mail

Electronic mail, or email is the term used to describe the tool, which allows one computer user to send a message to one or more other computer users over a computer network in a digital form. Email can be sent internally to members of an organization through their internal computer network or they can be sent externally to anyone in the world by using the Internet. It’s very similar to our traditional mail system with post boxes, post offices, envelops and addresses. Just as you can send attachments with your letters in the normal post you can also send computer documents, graphics, software or anything else that can be turned into a digital form attached to an email message.

What do you need to send or receive email?

1. A computer with an Internet connection.
   You need basic hardware such as computer, modem and a telephone line.
2. An email account.
   To become an email user you need to have an email account (ISP).
3. Email software.
4. In order to read or send a email you will need special software.
Email Address
An email address comprises two parts.

- User name
- The domain name
  These two are separated by the symbol “@”
  Example: kamal@yahoo.com

Domain Name:
A name that identifies one or more IP addresses. For example, the domain name microsoft.com represents about a dozen IP addresses. Domain names are used in URLs to identify particular Web pages. For example, in the URL http://www.pcwebopedia.com/index.html, the domain name is pcwebopedia.com.

Every domain name has a suffix that indicates which top level domain (TLD) it belongs to. There are only a limited number of such domains. For example:

- **gov** - Government agencies
- **edu** - Educational institutions
- **org** - Organizations (nonprofit)
- **mil** - Military
- **com** - commercial business
- **net** - Network organizations

In addition, every country has its own top-level domain name.

<table>
<thead>
<tr>
<th>Domain Name</th>
<th>Country(Meaning)</th>
</tr>
</thead>
<tbody>
<tr>
<td>lk</td>
<td>Sri Lanka</td>
</tr>
<tr>
<td>uk</td>
<td>United Kingdom</td>
</tr>
<tr>
<td>au</td>
<td>Australia</td>
</tr>
<tr>
<td>us</td>
<td>United States</td>
</tr>
<tr>
<td>jp</td>
<td>Japan</td>
</tr>
</tbody>
</table>

Because the Internet is based on IP addresses, not domain names, every Web server requires a Domain Name System (DNS) server to translate domain names into IP addresses.

Creating an e-mail account using Internet
Open Internet Explorer.
Type http://www.yahoo.com on the address bar
To create a free email account
- Use a web browser to connect the Internet and load www.yahoo.com web site.

Start → Programs → Internet Explorer → Type http://www.yahoo.com → Press Enter
This will open Yahoo.com in a new browser window.

- Click on **My Mail** button or **Mail icon** in Fig. 1

![Sign in to Yahoo!](image)

- Click Sign Up hyperlink.
- Fill in this form correctly.

![Yahoo! Mail](image)

- Click on **Submit** button.
Reading Material

Timer Control

A timer control allows you to generate events at specified time intervals.

So the interval property is very important.

A timer is started by setting the Enabled property to TRUE and giving the Interval property a value greater than 0. You can do this either from the property window or from the code.

The units for the interval property are milliseconds. So setting 1000 for the interval property can perform something every second.

For example, you can display time every second in the following example.

Timer controls only the display in the label.

Your application might look like the following.

Figure 1

Properties of the Timer Control

. With these settings, the code in the event TClock_Timer will be executed approximately every second.

Figure 2
Figure 3

Example 2

Changing the Interval Property

In the following example the program displays numbers at specified time intervals mentioned in the program.

Figure 4

When you type a number in the interval text box, Lcount label displays numbers one after the other working as a counter.

From this example, display speed can be controlled by changing the value of the interval.

Code

Figure 5

At each interval 1 is added to the previous Number.

This section changes the interval property.
Composing a new message

- Click on the Compose button.
- Then the following screen will appear.
Main parts of an email message

- **To:**
  The “To field represents to whom the message is being sent. If there are multiple recipients, then their addresses have to be separated by commas (,) or semi colon (;)

- **Cc:**
  “Cc” stands for “Carbon copy”. Any one listed in the Cc: field of a message will receive a copy of that message when you send it. All other recipients of that message will be able to see that the person you designated as a Cc: recipient has received a copy of the message.

- **BCc:**
  “BBc” stands for “Blind Carbon Copy”. This is similar to the Cc: feature, except that BCc: recipients are invisible to all of the other recipients of the message.

- **Subject:**
  This field represents what the message is about. The message line summarizes the contents of the message.

- **Attachment:**
  Attachments are separate files that are sent along with your email message. They do not form a part of your email message but they can be opened, saved or edited by the email recipient. You can attach all sorts of files to an email, including Spreadsheets, word processor documents, database files, even sound recordings and graphic images.
  In order to view an attached file the recipient needs to have a copy of the software application that was used to create the attachment initially. For example: if you send an excel document as an email attachment to a friend, then your friend must have Excel installed to read the attachment.

- Enter the email address of the person that you are sending the message to in the “To:" field. If there are multiple recipients, then their addresses have to be separated by commas (,) or semi colon (;)

- Enter the email address of any other person in the Cc: field, that you wish to receive copies of the message.

- Enter the **subject** of your message into the main window.

- If you want to attach a file, click on the **Attach Files** button.

- Select the location of a file you want by clicking on the **Browse** button.

- Select the file you want to attach and then on the **Open button**.

- Then click on the **Attach Files** button

- Click on the **Done** button.
Sending the message:

- Click on the **Send** button.
- Then a confirmation message will be displayed.

Check Mail:

- Click on the **Check Mail** button or **Inbox** link on the folders section.
- The Inbox will be displayed with a list of read and unread messages.
- The unread messages will be displayed in bold.
- Click on the subject of the message to view the message body.
- After checking the mail you can either,
  - Reply
  - Reply All
  - Forward or Delete the message.

**Reply**
Click on the Reply button to send the message back to the sender with a reply attached to it.

**Reply All**
Click on the Reply All button to send a reply to everyone in the **To:** field.

**Forward**
Click on the Forward button to forward the message to another person.

**Delete**

- Tick on check box in front of the message in the Inbox.
- Then click on the **Delete** button.
Competency 12: Uses Internet for Effective Information Search and Communication

Competency Level 12.3: Uses chat to exchange information.

Activity 12.3: Lets chat to exchange information.

Time: 60 Minutes.

Quality Inputs:
- Chat script in Annexe 12.3.1
- Three copies of group exploration instruction sheet in Annexe 12.3.2
- Three copies of graded directions in Annexe 12.3.3

Learning – teaching process:

Step 12.3.1:
- Get two students to present the dialog in the Annexe 12.3.1.
- Conduct a discussion to highlight the following
  - Chatting is a real-time communication method.
  - Text messages are sent and received.
  - You must register before you start chatting – You need a user name and a password.
  - At least two persons are needed to chat.

(10 minutes)

Step 12.3.2:
- Divide the class into three groups.
- Provide each group with a copy of exploration instructions and graded directions.
- Assign each group to chat using the given chat service.

(40 minutes)

Step 12.3.3:
- Request each group to explain its experience to the rest of the class.
- Conduct a discussion to emphasize the following
  - Chat categories differ from one service to the other.
  - Chat provides online communication from different locations through internet.
  - Group chatting is also possible.
  - This facility is provided free of charge.
  - The individuals chatting should be requested to use the same website.

(10 minutes)
Criteria for assessment and evaluation

- Lists and describes the importance of chat
- Appreciates the facilities in chat
- Uses chat to share ideas
- Uses Internet for communication.
- Maintains ethics when associating with people.
Annexe 12.3.1

CHAT DIALOGUE

A: Hello, Rajan, I am Kamal, I saw your name online when I was on the Internet. I like to have a conversation with you. Please contact.

B: Hello, Kamal, thanks for finding me online. How are you? Tell me about yourself.

A: Fine, thanks. I am an A/L student at Prince of Wales' College, Moratuwa. What about you?

B: I am also an A/L student at President's College, Maharagama. I like to have a lot of friends and my hobby is talking to friends. I live in Colombo.

Annexe 12.3.2

Instructions For Group Exploration

Let’s chat through computers

• You are going to chat with the online users.
• You have to register using the instructions given on the website.
• You will be working in three groups.
• A copy of the graded direction will be provided by the teacher.
• Enter the User name and password that you used at the registration
• Follow the instructions to open a chat session and use it to communicate with others.
Annex 12.3.3

Graded Directions

Group 1.

Step 1.

Type www.onlanka.com into your browser and go to the Onlanka home page.

Step 2.

Click chat button then you will go to web page shown below.
Step 3.

Click here to register, as you are a new user

Step 4.

You will get the following window. Type a user name, a password and the code in the relevant boxes.
Then click Register button.

Step 5.

If the registration is successful, type the Username and Password correctly and click Login on the following window.

Now you can chat with online users. The online users are shown in the following window. You can type your message.
Select by clicking a person from the chat room displayed on the right of the screen and type the message and press Send button in the following window.
Group 2.

Step 1.
Type **www.yahoo.com** into your browser and go to the yahoo home page.

Step 2.
Click chat button (chat button is included in the More yahoo services box) then you will go to web page shown below.
Step 3.

Now you type the given username and password correctly then go to below chat screen

Step 4.

First select a chat category from the list and click “Enter Chat Room” button then chat screen will appear.
Group 3.

If Net meeting is already installed in your computer, you can select the following path:

Start -> Programs -> Accessories -> Communication -> NetMeeting

- Click Call tab and select New Call to start the session

- Type the Name or IP Address of the computer you want to get connected to.

A. Starting to Chat

0. Click on the Chat button.
1. Begin typing a message to the caller. When you are done, hit Enter.
2. Pause for a moment to allow the caller to read the message and respond to it.

NOTE: The caller's response will appear in the Chat box under your message.
B. Using the Whiteboard
   0. Click on the **Whiteboard** button.
   1. Using the tools on the left of the screen, create an image to convey thoughts.

C. Share a document
   0. Click on the Share button on the top of the screen.
   1. A list of programs currently open appear.
   2. Click on Netscape.
   3. Click OK to accept message about sharing files on the Web.
Competency 13: Develops Multimedia contents to express ideas effectively.

Competency Level 13.1: Creates effective still graphics using suitable graphic software

Activity 13.1.1: Let’s create a still graphic.

Time: 120 minutes.

Quality Inputs:
- Four copies of the group exploration instruction sheet in Annexe 13.1.1
- Graded directions to create animations in Annexe 13.1.2
- Demy sheets and markers.
- Soft copies of the three-example graphic files.

Learning – Teaching Process:

Step 13.1.1: Display the four graphics to the class.
- Conduct a discussion to highlight the following.
  - Graphics are designed for various purposes
  - These are of fine art work.
  - Ones creative ability makes a fine finish
  - Graphic designing software facilitates in the creation of graphics

(15 minutes)

Step 13.1.2: Divide the class into four groups.
- Distribute copies of the group exploration instructions to each group with demy sheets and markers.
- Involve the groups in the exploration.
- Prepare groups for an innovative presentation.

(60 minutes)

Step 13.1.3: Get each group to present its findings.
- Request the presenters themselves to fill in gaps, if any.
- Invite constructive comments from other groups.
- Conclude the session by highlighting the following.
Photoshop is a graphic software which facilitates for the following
- Creating vector graphics
- Modifying photographs
- Creating logos

The canvas is the working area

Tools layers, styles, filters and other options facilitate in the creation and modification of text and graphics.

Layers can be used to draw and edit objects on one layer without affecting objects on another layer.

Color Mixer can be used to create and edit solid colors and gradient fills

These graphics can be used for various needs such as:
- Invitations
- Greeting cards
- Web pages
- Background pictures for animations.

(40 minutes)

Criteria for Assessment and Evaluation

- Names and describes the use of tools, layers and styles in Photoshop.
- Accepts that the old photographs can be modified to give a new look.
- Creates a logo for students IT club.
- Analyzes features of existing tools to derive maximum benefits.
- Shares knowledge and ideas with peers.
Instructions for the Group Exploration
Let’s create a still graphic.

• You will be working in three groups with the following three graphic types assigned to all groups.
  o Creating an invitation
  o Designing a logo
  o Modifying an old photograph

• On the basis of the activity, engage in the following task.
  o Load Photoshop
  o Go through the reading material

• Study the following tools, components and menu sequences in the reading material
  o Tools in the toolbox
  o Layers
  o Work space (Canvas)

• Identify the tools, components and menu sequences required to create the task assigned to your group.

• Create your graphic more than one layer
• Write down the important points.
• Be prepared to present your findings at the plenary session.
## Annexe 13.1.2

### Graded Direction

<table>
<thead>
<tr>
<th>The marquee tools</th>
<th>The move tool</th>
<th>The lasso tools</th>
<th>The magic wand tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>make rectangular, elliptical, single row, and single column selections.</td>
<td>moves selections, layers, and guides.</td>
<td>make freehand, polygonal (straight-edged), and magnetic * (snap-to) selections.</td>
<td>selects similarly colored areas.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>The crop tool</th>
<th>The slice tool</th>
<th>The slice selection tool</th>
<th>The healing brush tool *</th>
</tr>
</thead>
<tbody>
<tr>
<td>trims images.</td>
<td>creates slices.</td>
<td>selects slices.</td>
<td>paints with a sample or pattern to repairs imperfections in a image.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>The patch tool *</th>
<th>The brush tool</th>
<th>The pencil tool</th>
<th>The clone stamp tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>repairs imperfections in a selected area of an image using a sample or pattern.</td>
<td>paints brush strokes.</td>
<td>paints hard-edged strokes.</td>
<td>paints with a sample of an image.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>The type mask tools *</th>
<th>The pen tools *</th>
<th>The custom shape tool *</th>
<th>The annotation tools *</th>
</tr>
</thead>
<tbody>
<tr>
<td>create a selection in the shape of type.</td>
<td>let you draw smooth-edged paths.</td>
<td>makes customized shapes selected from a custom shape list.</td>
<td>makes notes and audio annotations that can be attached to an image.</td>
</tr>
<tr>
<td>Tool</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pattern Stamp Tool</td>
<td>Paints with part of an image as a pattern.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>History Brush Tool</td>
<td>Paints a copy of the selected state or snapshot into the current image window.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Art History Brush Tool</td>
<td>Paints with stylized strokes that simulate the look of different paint styles, using a selected state or snapshot.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Magic Eraser Tool</td>
<td>Erases solid-colored areas to transparency with a single click.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eraser Tool</td>
<td>Erases pixels and restores parts of an image to a previously saved state.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Background Eraser Tool</td>
<td>Erases areas to transparency by dragging.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blur Tool</td>
<td>Blurs hard edges in an image.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sharpen Tool</td>
<td>Sharpens soft edges in an image.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Smudge Tool</td>
<td>Smudges data in an image.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dodge Tool</td>
<td>Lightens areas in an image.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Burn Tool</td>
<td>Darkens areas in an image.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sponge Tool</td>
<td>Changes the color saturation of an area.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Path Selection Tools</td>
<td>Make shape or segment selections showing anchor points, direction lines, and direction points.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type Tools</td>
<td>Create type on an image.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Copyright © 2008 National Institute of Education - Sri Lanka. All rights reserved.
Load Photoshop

To create a graphic

File ➔ New
Select the size as you want in the dialog box
Click OK
Draw any shape using Lesso tool
Select Layer ➔ New Fill Layer ➔ Solid color
Open Layer panel (Windows ➔ Layer)

Refer help on Photoshop and prepare a material to suit you
Competency 13: Develops Multimedia contents to express ideas effectively.

Competency Level 13.2: Creates effective 2D animations using suitable 2D Animation software

Activity 13.2.1: Let’s learn how to create a 2D animation.

Time: 120 minutes.

Quality Inputs:
- Four copies of the group exploration instruction sheet in Annexe 13.2.1
- Graded directions to create animations in Annexe 13.2.2
- Demy sheets and markers.
- Soft copy of the three-example animation files and target animation file

Learning – Teaching Process:

Step 13.2.1:
- Load Flash MX software and demonstrate how to create a simple animation.
- Draw the attention of students to the Test Movie menu item
- Ask students to describe their experience in the use of animation
- Conduct a discussion to highlight the following.

- Animations are used in many fields like Web sites, TV advertisement, cartoons and telegrams.
- Flash is a software package used to develop 2D animation.
- There are many tools and windows in the software.
- In Flash the stage is used to create the user interface components.
- Test Movie in the control menu is used to run the animation.

(20 minutes)

Step 14.2.2:
- Divide the class into four groups.
- Distribute copies of the group exploration instructions to each group with demy sheets and pastels.
- Involve the groups in the exploration.
- Prepare groups for an innovative presentation.

(60 minutes)
Step 14.2.3 :  

- Get each group to present its findings.
- Request the presenters themselves to fill in gaps, if any.
- Invite constructive comments from other groups.
- Conclude the session by highlighting the following.

| Toolbox contains the tools to create, place and modify text and graphics. |
| The Timeline organizes and controls a movie’s content over time in layers and frames. |
| A key frame is a frame that used to create or change an animation. |
| The speed of the animation can be change using frame rate. |
| The Property inspector makes it easy to access and change the most commonly used attributes of an animation. |
| Color Mixer can be used to create and edit solid colors and gradient fills. |
| Layers can be used to draw and edit objects on one layer without affecting objects on another layer. |

(40 minutes)

Criteria for Assessment and Evaluation

- Names the tools within Flash and describes their functions.
- Accepts the value of animation software in creating and editing animations.
- Creates animations using Flash.
- Analyzes features of existing tools to derive maximum benefits.
- Shares knowledge and facilities with peers.
Annexe 13.2.1

Instructions for the Group Exploration

Let’s learn how to create a 2D animation.

- You will be working in four groups with the following three animation types assigned to all groups.
  - FRAME-BY-FRAME ANIMATION
  - SHAPE TWEENING (OBJECTS)
  - MOTION TWEENING (SYMBOLS)

- Study the given animation files.
- On the basis of the target animation file given, engage in the following task.
- Load Flash MX
- Go through the reading material
- Study the following tools, components and menu sequences in the reading material.
  - Stage
  - Time line
  - Key Frame
  - Black Frame
  - Arrow Tool
  - Oval Tool
  - Rectangle Tool
  - Free Transform Tool
  - Eraser Tool
  - Text Tool
  - Property inspector
  - Layers
  - Export Movie

- Identify the tools, components and menu sequences required to create the task assigned to your group.
- Create your animation using more than one layer
- Write down the important points.
- Be prepared to present your findings at the plenary session.
Flash MX Interface
The Interface refers to what you encounter when launching Flash MX

Toolbox  Layers  Timeline  The Stage  Panels

Property Inspector
If you encounter missing pieces of the interface puzzle, Window > Panel Sets > Default Layout will remedy the situation.

The Stage is where you compose the content for individual frames in the movie, drawing artwork on it directly or arranging imported artwork on it.

The Toolbox
The tools in the toolbox let you draw, paint, select, and modify artwork, as well as change the view of the Stage. The toolbox is divided into four sections:

The Timeline
The Timeline organizes and controls a movie's content over time in layers and frames.

Layers
Layers are like transparent sheets of acetate stacked on top of each other. Layers help you organize the artwork in your document. You can draw and edit objects on one layer without affecting objects on another layer.

Creating a layer
When you create a new layer or folder, it appears above the selected layer. A newly added layer becomes the active layer.

Choose Insert > Layer.

To delete a layer
Right click on the layer and select Delete layer

To rename a layer
Double click the layer and type the new name

Property Inspector
The Property Inspector displays the most frequently used setting for a tool or object.

Panels
Panels in Flash help you view, organize, and change elements in a document.

To get the panel set
Windows > panel sets

Using frames and keyframes
A keyframe is a frame in which you define a change in an animation or include frame actions to modify a movie.

Working with frames in the Timeline
In the Timeline, you work with frames and keyframes, placing them in the order you want the objects in the frames to appear. You can change the length of a tweened animation by dragging a keyframe in the Timeline.

You can perform the following modifications on frames or keyframes:
- Insert, select, delete, and move frames or keyframes
- Drag frames and keyframes to a new location on the same layer or on a different layer
Copy and paste frames and keyframes
Convert keyframes to frames
Drag an item from the Library panel onto the Stage to add the item to the current keyframe

To insert frames in the Timeline, do one of the following:
To insert a new frame, choose Insert > Frame
To create a new keyframe, choose Insert > Keyframe,
To create a new blank keyframe, choose Insert > Blank Keyframe,

To delete or modify a frame or keyframe, do one of the following:
To delete a frame, keyframe, or frame sequence, select the frame, keyframe, or sequence and choose Insert > Remove Frame.

Drawing straight lines, ovals, and rectangles
You can use the Line, Oval, and Rectangle tools to easily create these basic geometric shapes. The Oval and Rectangle tools create stroked and filled shapes. The Rectangle tool lets you create rectangles with square or rounded corners.

To draw a straight line, oval, or rectangle:
Select the Line, Oval, or Rectangle tool.
Select Window > Properties and select stroke and fill attributes in the Property inspector.

For the Rectangle tool, specify rounded corners by clicking the Round Rectangle modifier and entering a corner radius value. A value of zero creates square corners.

For the Oval and Rectangle tools, Shift-drag to constrain the shapes to circles and squares.

For the Line tool, Shift-drag to constrain lines to multiples of $45^\circ$.

Free Transform Tool
You can use the Free Transform tool to freely transform objects, groups, instances, or text blocks.
You can perform individual transformations or combine several transformations, such as moving, rotating, scaling, skewing, and distortion.

To transform freely:
Select a graphic object, instance, group, or text block on the Stage.
Click the Free Transform tool.
Moving the pointer over and around the selection changes the pointer to indicate which transformation function is available.
Drag the handles to transform the selection

Eraser Tool
Erasing with the Eraser tool removes strokes and fills. You can quickly erase everything on the Stage, erase individual stroke segments or filled areas, or erase by dragging.
You can customize the Eraser tool to erase only strokes, only filled areas, or only a single filled area. The Eraser tool can be either round or square, and it can have one of five sizes.

**Publishing an animation file (Export Movie)**

Using following steps you can publish a move file

- Create your animation and save
- File> Export Movie

Flash file has fla extension and movie file has swf extension

**FRAME-BY-FRAME ANIMATION**

Try to animate the text **FLASH**

**STEP 1:** Open a new Flash document

**STEP 2:** Select the **Text Tool**, click on the stage, and type an **F**.

**STEP 3:** Click on the second frame in the **timeline**

**STEP 4:** Insert a keyframe. If your prefer the menu, select Insert > Keyframe.

**STEP 5:** Click on the second keyframe to select it.

**STEP 6:** Select the **Text Tool**, click on the stage, and type an **L**.

**STEP 7:** Continuing the above typing other characters **A,S,H**

**STEP 8:** After that insert several keyframes and then blank keyframe

**STEP 9:** Click on the stage and set the frame rate to 5 in the Properties Panel.

**STEP 10:** After saving your Flash project, Control > Test Movie to see your work.

**SHAPE TWEENING (OBJECTS)**

**STEP 1:** Open a new document and draw a circle (no stroke) on the stage

**STEP 2:** Click on frame 20 and **Insert > Blank Keyframe** (F7)

**STEP 3:** Now your stage should be empty as you inserted a Blank Keyframe

**STEP 4:** Draw a square on the stage (without a stroke)

**STEP 5:** Move your playhead to frame 19 and notice that your circle resides in frames 1-19.

**STEP 6:** Click on the first keyframe.

**STEP 7:** Change the Tween setting in the Properties Panel from None to Shape.

**STEP 8:** Your timeline should reflect the change. The green color indicates a Shape
Tween. (A Motion Tween would be blue.)

**STEP 9:** Save your work and **Control > Test Movie**

**STEP 10:** To make the movie loop we have to use a different strategy. **Right-Click** on the first keyframe and select **Copy Frames** from the contextual menu.

**STEP 11:** **Right-Click** on frame 40 and select **Paste Frames**.

**STEP 12:** Click on frame 20 and set the **Tween to Shape** in the **Properties Panel**.

**STEP 13:** Save and Test Movie.

**MOTION TWEENING (SYMBOLS)**

**STEP 1:** Open a new document and draw a circle on the stage. Use the Arrow Tool to move it near the top of the stage.

**STEP 2:** Use the Arrow Tool to select the circle. The ENTIRE object must be selected!

**STEP 3:** **Insert > Convert to Symbol** (F8).

**STEP 4:** Make sure the Graphic Behavior is selected.

![Convert to Symbol](image)

**STEP 5:** Name your symbols!

![Convert to Symbol](image)

**STEP 7:** **Insert > Keyframe** (F6) on frame 30.

**STEP 8:** Click on the first keyframe and set the Tween to Motion in the Properties Panel.

**NOTE:** If you get a dotted line between frames 1 and 30 you probably didn't convert your object to a symbol correctly. Best to start again.

**STEP 9:** **Insert > Keyframe** (F6) on frame 15.

**STEP 10:** Use the Arrow Tool to move your symbol straight down toward the bottom of the stage. (Hold the Shift key down to constrain the angle.)

**STEP 11:** Save and **Control > Test Movie**
Competency 13: Develops multimedia contents to express ideas effectively

Competency Level 13.3: Creates audio contents using suitable sound editing software.

Activity 13.1: Let’s create audio files.

Duration: 80 minutes.

Quality Inputs:
- Tape recorder and computers with multimedia facilities.
- Four copies of Extract in Annexe 13.3.1
- Four copies of the group exploration instructions in Annexe 13.3.2
- Four copies of Graded direction in Annex 13.3.3
- Demy sheets and markers.

Learning – Teaching Process:

Step 13.3.1:
- Get a volunteer to sing few lines of the school song.
- Record and play the song
- Conduct a discussion to highlight the following.
  - Sounds can be recorded
  - Recorded sounds can be deleted.
  - This can be done in Computers easily.

(15 minutes)

Step 13.1.2:
- Divide the class into four groups.
- Provide each group with copies of group exploration instructions, graded directions, demy sheets and markers.
- Assign the four topics to each group and involve them in exploration.
- Prepare groups for a presentation at the plenary session.

(25 minutes)

Step 13.1.3:
- Get each group to present its findings.
- Request the presenters themselves to fill in any gaps they have left.
- Invite constructive comments from the other groups.
- Conduct a discussion to highlight the following.
• Sounds can be recorded using computer.
• Recorded sounds can be saved as audio files.
• These audio files can be edited using special effects in sound recorder tool.
  o Changing volume
  o Changing speed
  o Addition of echo
• There are other software available for sound recording and editing.

(15 minutes)

Criteria for Assessment and Evaluation

• Describes special effects used in audio editing.
• Accepts that audio can be edited in more effective manner.
• Makes sound clips to suit the needs.
• Uses tools for modifications.
• Makes optimal use of available resources.
Annexe 13.3.1

Extract

The schools attempting to implement the new technical subject ICT at the GCE (OL) are likely to face a number of challenges. First and foremost, the non-availability of a computer laboratory or an adequate number of computers for the task will not allow all schools with GCE (OL) classes to initiate the course in year 2007 itself. The technical nature of ICT will further limit the number of teachers opting to teach the subject thereby preventing the school authorities from selecting the most suitable teacher to be trained for the purpose. Moreover, lack of senior teachers both within and in the vicinity of the school will not allow adequate assistance and guidance to be offered to those teachers who undertake teaching of the new subject.

Curricula proposed under the first curriculum reform of the new millennium require all subject teachers to introduce the philosophy of learning by doing. The teachers attempting to meet this requirement have to link theory with practice in every activity they plan for their students. The learning thus acquired through activities has to be supplemented with a number of additional practice sessions. All this requires every school offering the subject to be equipped with a computer laboratory with multimedia facilities. Although the ideal situation in this respect is to provide a computer to each student, the many limitations resulting through resource constraints would necessitate two students to share one computer.

Annexe 13.3.2

Instructions for the Group Exploration

Let’s create audio files.

- Go through the graded directions provided to get a good understanding of the topic.
- You will be working in four groups on the following four topics.
- Record the two paragraphs separately and save as file A and file B
- Double the volume of sound file A
- Increase the speed of sound file A by 200%
- Add echo effect to sound file B
- Remove the first sentence from the first sound file A and save it as file C
- Remove the last sentence from the first sound file A and save it as file D
- Extract an inner section from any place desirable from the second sound file .B and save it as file E
- Merge any two of these files.
- Be prepared to make an innovative whole class presentation.
Annexe 13.3.3

Graded Directions

Using Sound Recorder
You can use Sound Recorder to record, mix, play, and edit sounds.

Open Sound Recorder
- To open Sound Recorder, click **Start**, point to **All Programs**, point to **Accessories**, point to **Entertainment**, and then click **Sound Recorder**.
- To use Sound Recorder, you must have a sound card and speakers installed on your computer. If you want to record sound, you also need a microphone.
- For information about using Sound Recorder, click the **Help** menu in Sound Recorder.

To record a sound
1. Make sure you have an audio input device connected to your computer.
2. On the **File** menu, click **New**.
3. To begin recording, click.
4. To stop recording, click.
5. On the **File** menu, click **Save As**.

To play a sound
1. On the **File** menu, click **Open**, locate the sound file you want to play, and then double-click it.
2. Click to start playing the sound.
3. Click to stop playing the sound.

Editing sounds

To delete part of a sound file
1. On the **File** menu, click **Open**, locate the sound file you want to modify, and then double-click it.
2. Move the slider to the place in the file that you want to cut.
3. On the **Edit** menu, click **Delete Before Current Position** or **Delete After Current Position**.

To overlay (mix) sound files
1. On the **File** menu, click **Open**, locate the sound file you want to modify, and then double-click it.
2. Move the slider to the place in the file where you want to overlay the sound file.
3. On the **Edit** menu, click **Mix with File**.
4. Enter the name of the file you want to mix.

**Addition of special effects**

**To add an echo to a sound file**

1. On the **File** menu, click **Open**, locate the sound file you want to modify, and then double-click it.
2. On the **Effects** menu, click **Add Echo**.

**To change the speed of a sound file**

1. On the **File** menu, click **Open**, locate the sound file you want to modify, and then double-click it.
2. On the **Effects** menu, click **Increase Speed (by 100%)** or **Decrease Speed**.

**To change the volume of a sound file**

1. On the **File** menu, click **Open**, locate the sound file you want to modify, and then double-click it.
2. On the **Effects** menu, click **Increase Volume (by 25%)** or **Decrease Volume**.

**To play a sound file in reverse**

1. On the **File** menu, click **Open**, locate the sound file you want to modify, and then double-click it.
2. On the **Effects** menu, click **Reverse**, and then click 🎵.
Competency Level 13.4  :  Effectively integrates Multimedia contents.
Activity 13.4       :  Let’s integrates Multimedia contents.
Duration            :  120 minutes.

Quality Inputs      :
• Flash movie in Annexe 13.4.1  
• Three copies of the group exploration instructions in Annexe 13.4.2  
• Three copies of Graded direction in Annex 13.4.3  
• Demy sheets and markers.

Learning – Teaching Process:

Step 13.4.1  :
• Demonstrate a flash movie to the class.  
• Conduct a discussion to highlight the following.  

Step 13.4.2  :
• Divide the class into three groups.  
• Provide each group with copies of group exploration instructions, graded directions, demy sheets and markers.  
• Assign randomly the three tasks to three groups and involve them in exploration.  
• Prepare groups for a presentation at the plenary session.  

Step 13.4.3  :
• Get each group to present its findings.  
• Request the presenters themselves to fill in any gaps they have left.  
• Invite constructive comments from the other groups.  
• Conduct a discussion to highlight the following.  

(15 minutes)
Criteria for Assessment and Evaluation

- Describes how to integrate multimedia contents.
- Accepts that use of multimedia gives more attraction.
- Creates animations using tweenning options.
- Uses combination of things for quality products.
- Works cooperatively with others.
Annexe 13.4.2

Instructions for the Group Exploration
Let's integrate Multimedia contents

- Go through the reading material provided to understand the topic well.
  - Creating motion tween animations with sounds
  - Creating shape tween animation with sounds
  - Creating text animation with sounds
- Use your prior knowledge to create suitable sounds and still graphics needed for your topic
- Integrate the components assigned to you.
- Reflect on your prior experiences on the topic to make a brief presentation to the small groups.
- Listen to the presentations made by your peers to collect ideas on the following
  - Inserting audio tracks
  - Inserting still graphics
  - Creating motion tween
- Be prepared to make an innovative whole class presentation.

Annexe 13.4.3

INSERTING SOUND FILES
1. Insert a new layer
2. File ➔ import
3. Locate the sound / audio file and click open (This file will be imported to flash library)
4. Now click Windows ➔ Library
5. From the library drag the sound / audio file you imported to the new layer
6. Test the movie

INSERTING GRAPHIC FILES
1. Insert a new layer
2. File ➔ import
3. Locate the graphic file and click open (This file will be imported to flash library)
4. Now click Windows ➔ Library
5. From the library drag the graphic file you imported to the new layer
6. Test the movie

To create Frame-by-Frame Animation, Shape Tweening and Motion Tweening refer annexe 13.2.2
Competency 14: Develops simple websites incorporating multimedia technology.

Competency Level 14.1: Structures information for development of websites.

Activity 14.1: Let's design web pages.

Time: 120 minutes.

Quality Inputs:
- A soft copy of a simple website and a common website incorporated in the common folder to facilitate the engagement and the exploration respectively.
- Four copies of the group exploration instruction sheet in Annexe 13.1.1
- Demy sheets and pastels

Learning – Teaching Process:

Step 14.1.1:
- Expose the simple website to the class.
- Get students to identify its main features.
- Conduct a discussion to highlight the following.
  - Main points in the information are highlighted to draw the attention of the reader.
  - The reader is systematically directed to different information placed within the same page and other pages of the website.
  - The website as a whole, therefore, has to be planned.

(15 minutes)

Step 14.1.2:
- Divide the class into four groups.
- Provide each group with a copy of the group exploration instructions, a soft copy of the relevant website, demy sheets and pastels.
- Involve the groups in the exploration.
- Prepare groups for an innovative presentation at plenary.

(60 minutes)

Step 14.1.3:
- Get each group to present its findings.
- Request the presenters themselves to engage in the first elaboration.
- Invite for constructive comments from the other groups.
- Conclude the session by highlighting the following.
Criteria for Assessment and Evaluation

- Names and describes various features of a web site.
- Accepts the need to make the Home Page of a web site both attractive and systematic.
- Prepares layouts to facilitate web design.
- Makes selections to suit the situation.
- Engages in planning for efficiency and effectiveness.

Instructions for the Group Exploration

Let’s design web sites.

We know that, from ancient times, numerous methods were used for the purpose of exchanging information. In the present day world information is at a premium. The Internet plays quite a powerful role in exploring information. We already know the role of web sites and web pages in the Internet for accessing information.

- Out of the four topics given below for the development of web sites, focus attention on the topic assigned to your group.
  - Myself
  - My School
  - School Magazine
  - Bookshop
- First, study the web site assigned in common to all groups.
- Identify the following aspects used to present the content.
Now focus on the topic assigned to your group.
Identify the information to be included in the web site to be developed.
Prepare a layout to facilitate web design.
Incorporate relevant information.
Be prepared to present your designs at plenary.
Competency 14: Develops simple websites incorporating multimedia technology.

Competency Level 14.2: Develops websites using web development tools.

Activity 14.2: Let’s develop websites using FrontPage.

Time: 120 minutes.

Quality Inputs:
- Four copies of the group exploration instruction sheet in Annexe 14.2.1
- Website plans prepared in activity 14.1
- Graded directions to create a web page in Annexe 14.2.2
- A soft copy of a partially built website in Annexe 14.2.3
- Demy sheets and markers.

Learning – Teaching Process:

Step 14.2.1:
- Load FrontPage software and demonstrate how to initialize a simple website.
- Let students recall text-formatting tools they have used in MS Word.
- Request them to point out similar tools in FrontPage.
- Draw the attention of students to the Normal view window of FrontPage.
- Get students to type some text in normal window.
- Ask students to switch over to Preview window and observe the web site.
- Conduct a discussion to highlight the following.

FrontPage is a software package used to develop websites.
Software packages used for web site development contain tools to structure information.
Some of these tools are similar to those found in MS Word.
In FrontPage Normal window is used to create the website.

Step 14.2.2:
- Divide the class into four groups.
- Distribute copies of the group exploration instructions to each group with demy sheet and marker.
- Involve the groups in the exploration.
- Prepare groups for an innovative presentation.

(15 minutes)

(60 minutes)
Step 14.2.3

- Get each group to present its findings.
- Request the presenters themselves to fill in gaps, if any.
- Seek for constructive comments from other groups.
- Conclude the session by highlighting the following.

Frames, windows and tables are used to structure information.
Facilities provided in the FrontPage can be used to incorporate the multi media features into the web page.
Hyperlinks and buttons are used to connect web pages.
Tools are available in the FrontPage for following tasks.
  - Text formatting
  - Page Layout
  - Incorporation of multimedia

(45 minutes)

Criteria for Assessment and Evaluation

- Names the tools within FrontPage and describes their functions.
- Accepts the value of web development software in creating and editing web pages.
- Creates web pages using FrontPage.
- Analyzes features of existing tools to derive maximum benefits.
- Shares knowledge and facilities with peers.
Annexe 14.2.1

Instructions for the Group Exploration
Let's develop websites using FrontPage.

You already know that multimedia can improve the quality of information presented in a web site. Lists, columns, frames, banners, tables and logos are some techniques that can be used here.

Focus attention on the web page designed earlier under activity 13.1.

- Load Front Page.
- Go through the reading material.
- Study the menu sequences in the reading material.
- Identify the tools described by menu sequences required to convert the design into web site.
- Now use the tools in FrontPage to develop the web page.
- Be prepared to make an innovative presentation at plenary.

Annexe 14.2.2

Graded Directions

What is a Web Page?

A web page is a document that is displayed by your web browser (e.g. Netscape or Internet Explorer). Most web pages include some text, images and links to other web pages. A collection of web pages about a topic is usually referred to as a web site.

You will usually create and edit web pages on your own computer, and then publish them (copy them) to the web host server to make them available to people browsing the web.

Web Authoring Tools:

- FrontPage from Microsoft.
- Dreamweaver from Macromedia.

Let’s Create Web Page Using Web Design Software

What is FrontPage?

FrontPage is a powerful tool used to design, create and publish web sites. You choose the type of web site you want, while FrontPage generates and organizes all the web site documents you need. Then you can fill your web site with the text, pictures, sounds and other features you want your visitors to experience.

Getting Started with FrontPage.

1. Point to the start button on the task bar. The start button on the left side of the task bar and is used to start program on your computer.
2. Click Microsoft **FrontPage** is located in the program group, which is the top of the start menu.

3. Point to **Program**. Program on you computer, including **FrontPage**, listed in this of the start menu.

4. Click the Microsoft **FrontPage** icon on the program menu. This will start the **FrontPage** Web Design Application.

---

**FrontPage Screen Layout**

Below is a diagram of the default page layout in FrontPage. You can change the view by selecting a different **View Option**.
Views

- **Page view** gives an environment for creating and editing web pages.
- **Folders view** lists all of the files and folders in your web for easy management.
- **Reports view** identifies problems with pages and links in the web including slow-loading pages, broken links, and other errors.
- **Navigation view** lists the navigation order of the site and allows you to change the order that a user would view the pages.
- **Hyperlinks view** allows you to organize the links in the web pages.
- **Tasks view** provides a grid for inputting tasks you need to complete in your web.

Starting a New Web

You can quickly get started with a new web. To being working on a new web follow these steps:

1. Go to File on the menu bar and go down to New and click on Web.
2. Click on the one page web icon. Type in the location where you want your web to reside locally on your machine.
3. Click on next.
4. Your new web will open with a blank page if you were in page view when you created the web.
5. You can begin designing your new web.
To create a home page

The home page is the front door to your Web site. Greeting your visitors as you might do in person and providing some information about the content or subject matter of your site will spark interest in the people looking at your site. The home page also contains links to the other pages in a web.

1. On the blank page in Page view, type, “Welcome to my Web site!” and then press ENTER. Just like in a word processor, pressing ENTER puts the cursor on a new line.

2. Next, type the sentence, “Take a look around to learn more about the Year 2000, see where people all over the world will be celebrating the new millennium, and look at pictures from past New Year's fireworks.”

3. Press ENTER.

Your page should now look like this:
Font Properties

Many properties of fonts can be changed from the Font dialog box. Highlight the text that will be formatted and select Format | Font from the menu bar.

Page Properties

Change various page properties by selecting File | Properties from the menu bar. The Page Properties window will allow you to change many general properties, the page background, margins, and more.

Adding Text on a Graphic

In FrontPage it is very easy to add text on top of an image. To do this follows these steps:

1. Click on the image that you want to add text to.
2. Click on the text icon from the Pictures’ toolbar on the bottom of your screen.
3. A text box will appear on your image. Type the text you want to add. You can move the text and format it like you would any text box.
Inserting Images From File

Adding Images that you have stored to your FrontPage web is a simple task. Follow the steps below.

1. Go to Insert on the menu bar and go down to Picture and click on From File.
2. The Picture dialog box will open.
3. Click on the file folder with the magnifying glass in the bottom right hand corner. The Select File dialog box will open.
4. Click on the file for the image you want to use. You can use various file types but once inserted into FrontPage they will be converted to either JPEG or GIF.
5. Click on OK.
6. Your image will be added to your page.

HINT- It is a good idea not to have spaces in your image file names.
**Inserting Clip Art**

Adding Clip art to your FrontPage web is a simple task. Follow the steps below.

1. Go to Insert on the menu bar and go down to Picture and click on Clip Art.
2. The Insert Clip Art Gallery will open. Click on the category that you want to use. You can also type a keyword in the search for clips box. Hit enter.
3. Right click on the image you want to use and click on insert or click on the image you want to use and click on the insert clip icon.

Your image will appear on your page. (Images in Front Page work a lot like text. You can align them, put them in a table or click and drag them to a location.) You can resize them by clicking on the corner handle and moving out to enlarge and in to decrease the size. (You do not need to hold the shift key down it will keep the picture in proportion automatically.)

![Inserting Clip Art](image)

**Adding a Marquee**

You can add a marquee on your page. It is important to note that this will only work in Internet Explorer. You will see the text in Netscape but it will not be scrolling. To add a marquee to you page follow these steps:

1. Click on the section of the page where you want to insert your marquee.
2. Go to Insert on the menu bar and go down to Component and click on Marquee.
3. The Marquee Properties' dialog box will open.
4. Type the text that you want displayed.
5. Click on the down arrow for background color and click on your color choice.
6. Click on the Style button then Format then Font. Make the choices for the type of font you want as well as size and color.
7. Click on OK and then OK again.
8. Make a choice for the type of marquee that you want to use. (Scroll, Slide or Alternate). See samples on this page.
9. Click OK.
10. If you ever want to make changes to your Marquee, right click on it and choose marquee properties.
Adding Hover Buttons

A hover button is a button that displays a change when you move your mouse over it. You can create simple hover buttons or you can customize them with your own images. To add a customized hover button to your web page follow these steps:

1. You will need to create or find two files that will be used to create your button and the button that will be displayed when you move your mouse over it. If you are using a theme there are built in images that you can use for this purpose. If you are creating your own you will need to create two separate images.
2. Go to Insert on the menu bar and down to component and click on Hover Button.
3. Type in the text you want displayed on the button.
4. Click on the custom button.
5. Click on the browse next to custom button. Find the file you want for the button.
6. Click on browse next to on hover and choose the file that you want for the hover effect.
7. Click on OK.

To create a hover button without using your own customized graphics follow the steps below:

1. Go to Insert on the menu bar and down to component and click on Hover Button.
2. Type in the text you want displayed on the button.
3. You can then adjust any of the hover button properties that you want like button color, button background, effect, width and height, etc.
4. Click OK after making changes.
Adding a Hyperlink to Text or Images

You can add a hyperlink to both text and images. It is a simple task to do. Follow the steps below to create a hyperlink.

1. Select the text or image that you want to add a hyperlink to.
2. Click on the Hyperlink icon on the standard toolbar.
3. The create hyperlink dialog box will open. Type in the URL that you want to link to in the URL box.
4. Click on OK.
5. Your text or image will now be hyper linked. When in the preview mode or after you publish you will see that when you click on the text or image it will jump to the URL you typed in.
Saving your page

1. Click the Save button on the Standard toolbar.

Previewing your page

When visitors visit your web site, they will look at it through an Internet browser like Internet Explorer or Netscape Navigator. When viewed through these browsers, your page will look somewhat different than it does in FrontPage Editor.

There are two ways to preview what your visitors will see:

Option 1. Click the Preview tab at the bottom of the screen.

Option 2. Click the Preview button on the Standard toolbar.

Creating a table:

Option 1:

- Click the table button on the standard tool bar.
- Drag the mouse over the grid.
- Highlighting the cells that should appear on the table.
- When the table size has been selected, click the mouse button again.

Option 2: Click: Table menu → Insert → Table → Select: number of rows & columns → Click: Ok
Competency 14: Develops simple websites incorporating multimedia technology.

Competency Level 14.3: Develops simple websites using HTML.

Activity 14.3  : Let’s use HTML to develop websites.

Time  : 160 minutes.

Quality Inputs  :  • Four copies of the group exploration instruction sheet in Annexe 14.3.1.
                  • Four sets of web pages (soft copies)
                  • Four copies of reading material in Annexe 14.3.2

Learning – Teaching Process:

Step 14.3.1  :  • Ask student to open the websites developed earlier and observe Normal and HTML views in FrontPage.
                 • Change source code and view it in a browser.
                 • Conduct a discussion to highlight the following.

                 • Every web page has source code.
                 • Web file normally has .Htm or .html extension.
                 • To create a web page, HTML can be used.
                 • A text editor is used to write HTML (Hyper Text Mark up Language) codes.

                 (10 minutes)

Step 14.3.2  :  • Divide the class into four groups.
                 • Distribute copies of the group exploration instructions, soft copy of the web pages and reading material to each group with a demy sheet and markers.
                 • Involve the groups in the exploration.
                 • Prepare groups for a website at plenary.

                 (40 minutes)

Step 14.3.3  :  • Get each group to present its findings.
                 • Request the presenters themselves to fill gaps, if any.
                 • Seek for constructive comments of other groups.
• Conclude the session by highlighting the following.

| HTML tags should be recorded on the text editor (note pad/word pad) |
| A web browser like Internet Explorer is necessary to view the web page created. |
| Tags have to use for structure information inserted in the web page. |
| Every tag that is opened should necessarily be closed. |

(40 minutes)

Criteria for Assessment and Evaluation

• Names and describe the main tags required when creating a web page using HTML.
• Accepts that it is easier to use an authoring package than writing in HTML to create complex web pages.
• Creates a web page using HTML.
• Ensures that every task started has a finish.
• Enjoys participation in activities.
Annexe 14.3.1

Instructions for the Group Exploration
Let’s use HTML to develop websites.

- You will be working in four groups.
- Study the reading material (Annexe 13.3.2) given to identify the HTML tags used to display information.
- The objective of the task is to convert file A into the status of file B.
- Open the HTML file A and file B separately at the same time in MS Internet Explorer.
- Compare browser view of file A and that of file B.
- Note down the differences between those two views.
- Find out from the Annexe 13.3.2 the HTML tags used to effect noted changes.
- View the source code view of file A.
- Write HTML tags necessarily to effect each changes, so that browser view of file A is equal to that of file B.
- After each change save file A and view it in browser to check whether changes has been done properly.
- Be prepared to present your findings at the plenary session.

Annexe 14.3.2

Reading Material

What is an HTML File?

- HTML stands for Hyper Text Markup Language.
- An HTML file is a text file containing small markup tags.
- The markup tags tell the Web browser how to display the page.
- An HTML file must have an .htm or .html file extension.
- An HTML file can be created using a simple text editor.
- Not a programming language.
- Not complicated.

HTML Elements

HTML documents are text files made up of HTML elements.

HTML elements are defined using HTML tags.

HTML Tags

- HTML tags are used to mark-up HTML elements.
- HTML tags are surrounded by the two characters < and >
• The surrounding characters are called **angle brackets**.
• HTML tags normally **come in pairs** like <b> and </b>
• The first tag in a pair is the **start tag**; the second tag is the **end tag**.
• The text between the start and end tags is the **element content**.
• HTML tags are **not case sensitive**, <b> means the same as <B>
• If a browser does not understand a tag it will usually ignore it.

**Basic HTML Tags**

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Html&gt;</td>
<td>Defines an HTML document</td>
</tr>
<tr>
<td>&lt;Body&gt;</td>
<td>Defines the documents body.</td>
</tr>
<tr>
<td>&lt;h1&gt; to &lt;h2&gt;</td>
<td>Defines header 1 to header 6.</td>
</tr>
<tr>
<td>&lt;p&gt;</td>
<td>Defines a paragraph.</td>
</tr>
<tr>
<td>&lt;br&gt;</td>
<td>Insert a single line break. &lt;br&gt; tag is an empty tag. It has no empty tag.</td>
</tr>
<tr>
<td>&lt;hr&gt;</td>
<td>Defines a horizontal rule.</td>
</tr>
<tr>
<td>&lt;!--</td>
<td>Defines a comment.</td>
</tr>
<tr>
<td>&lt;li&gt;</td>
<td>Creates a list</td>
</tr>
<tr>
<td>&lt;ol&gt;</td>
<td>Creates ordered list.</td>
</tr>
<tr>
<td>&lt;ul&gt;</td>
<td>Creates unordered list.</td>
</tr>
<tr>
<td>&lt;a&gt;</td>
<td>Defines an anchor</td>
</tr>
</tbody>
</table>

Structure of an HTML document:
```html
<html>
  <head>
    <title>This is a test</title>
  </head>
  <body>
    <!--...Comments.....>
    <h1>Heading</h1>
    <p>A sample paragraph showing format</p>
  </body>
</html>
```

E.g. 1

Type in the following text:
```html
<html>
  <head>
    <title>Title of page</title>
  </head>
  <body>
    This is my first homepage. <b>This text is bold</b>
  </body>
</html>
```

Save the file as "mypage.htm".
Start your Internet browser. Select "Open" (or "Open Page") in the File menu of your browser. A
dialog box will appear. Select "Browse" (or "Choose File") and locate the HTML file you just created
- "mypage.htm" - select it and click "Open". Now you should see an address in the dialog box, for
example "C:\MyDocuments\mypage.htm". Click OK, and the browser will display the page.

E.g. 2

<html>
  <body>
  <b>This text is bold</b>
  <br>
  <strong>This text is strong</strong>
  <br>
  <big>This text is big</big>
  <br>
  <em>This text is emphasized</em>
  <br>
  <i>This text is italic</i>
  <br>
  <small>This text is small</small>
  <br>
  This text contains
  <sub>subscript</sub>
  </sub>
  <br>
  This text contains
  <sup>superscript</sup>
  </sup>
  </body>
</html>

Browser view:

This text is bold
This text is strong
This text is big
This text is emphasized
This text is italic
This text is small
This text contains
This text contains subscript
This text contains superscript

HTML Layout

Everywhere on the Web you will find pages that are formatted like newspaper pages using HTML
columns.
HTML Layout - Using Tables

One very common practice with HTML, is to use HTML tables to format the layout of an HTML page.

A part of this page is formatted with two columns, like a newspaper page.

As you can see on this page, there is a left column and a right column.

This text is displayed in the left column.

Tables

Tables are defined with the `<table>` tag. A table is divided into rows (with the `<tr>` tag), and each row is divided into data cells (with the `<td>` tag). The letters `td` stands for "table data," which is the content of a data cell. A data cell can contain text, images, lists, paragraphs, forms, horizontal rules, tables, etc.

```
<table border="1">
<tr>
<td>row 1, cell 1</td>
<td>row 1, cell 2</td>
</tr>
<tr>
<td>row 2, cell 1</td>
<td>row 2, cell 2</td>
</tr>
</table>
```

How it looks in a browser:

<table>
<thead>
<tr>
<th>row 1, cell 1</th>
<th>row 1, cell 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>row 2, cell 1</td>
<td>row 2, cell 2</td>
</tr>
</tbody>
</table>

Empty Cells in a Table

Table cells with no content are not displayed very well in most browsers.

```
<table border="1">
<tr>
<td>row 1, cell 1</td>
<td>row 1, cell 2</td>
</tr>
<tr>
<td>row 2, cell 1</td>
</tr>
</table>
```

How it looks in a browser:
Table Tags

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;table&gt;</td>
<td>Defines a table</td>
</tr>
<tr>
<td>&lt;th&gt;</td>
<td>Defines a table header</td>
</tr>
<tr>
<td>&lt;tr&gt;</td>
<td>Defines a table row</td>
</tr>
<tr>
<td>&lt;td&gt;</td>
<td>Defines a table cell</td>
</tr>
<tr>
<td>&lt;caption&gt;</td>
<td>Defines a table caption</td>
</tr>
<tr>
<td>&lt;colgroup&gt;</td>
<td>Defines groups of table columns</td>
</tr>
<tr>
<td>&lt;col&gt;</td>
<td>Defines the attribute values for one or more columns in a table</td>
</tr>
<tr>
<td>&lt;thead&gt;</td>
<td>Defines a table head</td>
</tr>
<tr>
<td>&lt;tbody&gt;</td>
<td>Defines a table body</td>
</tr>
<tr>
<td>&lt;tfoot&gt;</td>
<td>Defines a table footer</td>
</tr>
</tbody>
</table>

Lists:
- Ordered Lists.
- Unordered Lists.
- Definition Lists

List Tags

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;ol&gt;</td>
<td>Defines an ordered list</td>
</tr>
<tr>
<td>&lt;ul&gt;</td>
<td>Defines an unordered list</td>
</tr>
<tr>
<td>&lt;li&gt;</td>
<td>Defines a list item</td>
</tr>
<tr>
<td>&lt;dl&gt;</td>
<td>Defines a definition list</td>
</tr>
<tr>
<td>&lt;dt&gt;</td>
<td>Defines a definition term</td>
</tr>
<tr>
<td>&lt;dd&gt;</td>
<td>Defines a definition description</td>
</tr>
</tbody>
</table>

Ordered Lists

An ordered list is a list of items. The list items are marked with numbers.

An ordered list starts with the <ol> tag. Each list item starts with the <li> tag.

```html
<ol>
  <li>Coffee</li>
  <li>Milk</li>
</ol>
```

Here is how it looks in a browser:

1. Coffee
2. Milk

Inside a list item you can put paragraphs, line breaks, images, links, other lists, etc.
Unordered Lists
An unordered list is also a list of items. The list items are marked with bullets (typically small black circles).
An unordered list starts with the <ul> tag. Each list item starts with the <li> tag.

```html
<ul>
  <li>Coffee</li>
  <li>Milk</li>
</ul>
```

Here is how it looks in a browser:

- Coffee
- Milk

Inside a list item you can put paragraphs, line breaks, images, links, other lists, etc.

Definition Lists
A definition list is not a list of items. This is a list of terms and explanation of the terms.
A definition list starts with the <dl> tag. Each definition-list term starts with the <dt> tag. Each definition-list definition starts with the <dd> tag.

```html
<dl>
  <dt>Coffee</dt>
  <dd>Black hot drink</dd>
  <dt>Milk</dt>
  <dd>White cold drink</dd>
</dl>
```

Here is how it looks in a browser:

Coffee
  Black hot drink
Milk
  White cold drink

Inside a definition-list definition (the <dd> tag) you can put paragraphs, line breaks, images, links, other lists, etc.

HTML Links
HTML uses a hyperlink to link to another document on the Web.

Create hyperlinks

The Anchor Tag and the href Attribute
HTML uses the <a> (anchor) tag to create a link to another document.
An anchor can point to any resource on the Web: an HTML page, an image, a sound file, a movie, etc.

The syntax of creating an anchor:

```
<a href="url">Text to be displayed</a>
```

The `<a>` tag is used to create an anchor to link from, the `href` attribute is used to address the document to link to, and the words between the open and close of the anchor tag will be displayed as a hyperlink.

This anchor defines a link to W3Schools:

```
<a href="http://www.w3schools.com/"">Visit W3Schools!</a>
```

The line above will look like this in a browser:

**Visit W3Schools!**

This example demonstrates how to create links in an HTML document.

```
<html>
<body>
<p>
<a href="lastpage.htm">This text1</a> is a link to a page on this Web site.
</p>
<p>
<a href="http://www.microsoft.com/">This text2</a> is a link to a page on the World Wide Web.
</p>
</body>
</html>
```

This text1 is a link to a page on this Web site
This text2 is a link to a page on the World Wide Web

• An image as a link

This example demonstrates how to use an image as a link.

```
<html>
<body>
<p>
You can also use an image as a link:
```

Copyright © 2008 National Institute of Education - Sri Lanka. All rights reserved.

XML (Extensible Markup Language) is a flexible way to create common information formats and share both the format and the data on the World Wide Web.

**Difference between XML and HTML.**

- **XML** is not a replacement for **HTML**.
- **XML and HTML** were designed with different goals.
- **XML** was designed to carry data, **XML** was designed to describe data and to focus on what data is.
- **XML** allows new elements to be defined by the programmer.
- For example, the following is a well-formed XML document, but because it only uses tags that are defined in HTML, it's also an HTML document:

```html
<HTML>
  <HEAD><title>Message of the Day</title></HEAD>
  <body>
    <p>There is no message of the day.</p>
    <p>Try back tomorrow.</p>
  </body>
</HTML>
```
Competency Level 14: Develops simple websites incorporating multimedia technology.

Competency Level 14.4: Demonstrates preparedness to publish web sites.

Activity 14.4 : Let’s publish a web site.

Time : 120 minutes.

Quality Inputs : • Three copies of the group exploration instruction sheet in annexe 14.4.1.
• Three copies of the reading material in annexe 14.4.2

Learning – Teaching Process:

Step 14.4.1 : • Ask a volunteer to explain how an advertisement is published.
• Conduct a discussion to highlight the following.

- An advertisement can be published in newspapers.
- To publish an advertisement, a special procedure is needed.
- Some advertisements are free of charge and others are not.
- A similar procedure has to be followed when advertising on a web site.

(10 minutes)

Step 14.4.2 : • Divide the class into three groups.
• Distribute copies of the group exploration instructions to each group with a demy sheet and markers.
• Involve the groups in the exploration.
• Prepare groups to present their experiences to the class.

(60 minutes)

Step 14.4.3 : • Get each group to present its findings.
• Request the presenters themselves to fill gaps, if any.
• Invite constructive comments from the other groups.
• Conduct a discussion to highlighting the following.
Criteria for Assessment and Evaluation

- Lists Internet Service Providers.
- Accepts the need to use IP addresses for web publishing.
- Publishes a web site through the Internet.
- Works methodically.
- Selects relevant information for publication.
Annexe 14.4.1

Instructions for the Group Exploration
Let's publish a web site.

- You will be working in three groups.
- Go through the reading material.
- List and define requirements to publish a web site.
- List steps to publish a web site.
- List free web hosts.
- Be prepared to make an innovative presentation at the plenary session.

Annexe 14.4.2

Reading Material

Definition of web page:
A document written in HTML that can be accessed on the Internet is called a web page. Web pages can contain text, graphics, animations, and hyperlinks. Every web page has a unique address called a URL (Universal Resource Locator)

Definition of web site:
A collection of one or more web pages grouped under the same domain name.
You must have three things to put a web site on the Internet:
- A domain name,
- A web site and
- A web host.
A domain name is the address of a web site.
For example,
“www.ActNowDomains.com” is this web site's domain name.
A web host is where your web site is stored so that when someone types in your domain name, your web site appears on his / her computer.
What is an IP address?

Every machine on the Internet has a unique identifying number, called an IP address.

Example:
216.27.61.137

IP addresses are normally expressed in decimal format as a “dotted decimal number” but computers communicate in binary form.

Look at the same IP address in binary form: 110001100.00011011.00111101.10001001

URL (Uniform Resource Locator):

A URL is the unique address for a file that is accessible on the Internet.

Example: Http://www.nie.lk/page/cource.html

Domain name: The unique name that identifies an Internet site. Domain names have two or more parts separated by dots. For example www.kansasmedicare.com

Web Server:

A web server is a computer that delivers web pages to browsers. Every web server has an IP address and a domain name.

For example, if you enter the URL http://www.pcwebopedia.com/index.html in your browser, this sends a request to server whose domain name is pcwebopedia.com. The server fetches index.html and sends it to your browser.

Internet Service Provider (ISP):

An ISP is a company that provides access to the Internet to individuals or companies. ISPs provide local dial-up access from your personal computer to their computer network and their network connects you to the Internet.

Web Host:

A business that provides server space, web services and file maintenance for individuals or companies that do not have their own servers.

How to publish a web:

You will need a web host to publish your pages. For the complete beginner, a web host is a company which has computers that are permanently connected to the Internet. After you design your web page(s), you will need to transfer your pages to your web host's computer (called a web server), so that the rest of the world can see it.
Steps to Publishing on the World Wide Web

In order to publish information on the WWW, you will need to:

1. **Create the pages for your web site using HTML (Hypertext Markup Language).**

   A web page is simply a file, which contains the text of your page along with HTML tags that define the layout and link to other media elements like graphics and sounds. No special software is required to create the HTML file: a plain text editor (Notepad or WordPad) will allow you to create and edit your files. Microsoft Internet Explorer, Netscape or some other browser can be used to preview them. Two popular web authoring programs are Dreamweaver and Microsoft Front Page.

2. **Get permission to store your completed documents on a WWW server computer.**

   The files that contain your web site must be stored on a WWW server, which is continuously available to receive requests from WWW browsers. The central University of Victoria computer (unix.uvic.ca) acts as a WWW server and can be used to store both personal and departmental web documents.

   If your department has its own WWW server, you may be able to store your web site there. You should contact the web server administrator (i.e. the person who takes care of the hardware and software).

3. **Transfer the completed documents to the web server.**

   Once you are satisfied with the documents, you must move them to a Web server. This will often be done by transferring the entire folder of documents to the server using a file transfer program (Fetch on the Macintosh or FTP in Windows).

---

How to Design and Publish Your Website with Mozilla Composer

**What You Will Need**

1. You need to have Mozilla Composer (obviously). This is a free WYSIWYG (What You See Is What You Get) web editor that comes with the Mozilla Suite. Simply download the Mozilla Suite from [http://www.mozilla.org/products/mozilla1.x/](http://www.mozilla.org/products/mozilla1.x/), install it and you will have Composer on your system. There are versions of the Mozilla Suite for a multitude of platforms, including Windows, Macintosh, Linux, etc. Get the appropriate one for your system. Note that the Mozilla Suite is not the same as Mozilla Firefox. The latter is standalone web browser; the Mozilla Suite, on the other hand, includes a browser, an email and newsgroup client, an IRC chat client, and an HTML editor (Composer). You will need to download the Mozilla Suite for Mozilla Composer even if you are already using Firefox.

   Update: there is now a standalone version of Mozilla Composer with more advanced features available. This standalone version is called Nvu. If you prefer to use a standalone web editor, you should read my [Nvu Tutorial](http://www.mozilla.org/products/mozilla1.x/) instead. There are specific instructions in that...
tutorial for Nvu. The Nvu tutorial is located at http://www.thesitewizard.com/gettingstarted/nvu1.shtml

2. You will need a web host to publish your pages to. For the complete beginner, a web host is (loosely speaking) a company which has computers that are permanently connected to the Internet. After you design your web page(s), you will need to transfer your pages to your web host's computer (called a web server), so that the rest of the world can see it. There are numerous web hosts around - you can find a list of cheap web hosts on http://www.thefreecountry.com/webhosting/budget1.shtml

There are other things involved in getting your first web site up and running, such as getting your own domain name and promoting your web site. This tutorial however does not deal with those matters - it is strictly about designing (creating) and publishing (uploading) your website using Mozilla Composer. You can find more information about the other issues by perusing the articles on thesitewizard.com.

Starting Up Mozilla Composer

Start up Mozilla Composer. You do this by first starting up the Mozilla web browser, then clicking the "File" menu, the "New" item on the menu that appears, and the "Composer Page" item that appears on the submenu. A new window should appear. This is the Composer window - the portion of Mozilla that lets you design your own web pages.

For convenience, in future, I shall write the sequence of clicking "File" then "New" then "Composer Page" simply as:

```
File | New | Composer Page
```

This means you are to click the "File" menu, followed by the "New" item, followed by the item "Composer Page". There are actually shortcuts to starting Composer from Mozilla (as there are for many of the commands given in this tutorial), but I will leave the discovery of minor things like that to you and concentrate on the main task of creating a web page.

Creating A Simple First Web Page

To give you an idea how simple it is to create a web page, type the following into the Composer window. You don't have to do anything special - just start typing.

When you type, you are typing into Mozilla Composer's "Normal" mode. You can see which mode you are using by glancing at the series of tabs at the bottom of the Mozilla Composer window.
To see how your page appears in an actual web browser, click the "Preview" tab to enter Mozilla Composer's "Preview" mode. Return to the "Normal" mode before continuing.

When you type text in this mode, Mozilla converts it into a HTML web document behind the scenes so that web browsers can recognize it as a web page. If you want to look at the HTML code that is generated from what you just typed, click the "HTML Source" tab at the bottom of Mozilla Composer. Remember to return to the "Normal" mode when you've finished admiring the code.

Now save the page onto your hard disk. Do this with "File | Save". Remember - this means click the "File" menu followed by the "Save" item on that menu.

A dialog box will pop up, asking you to give a title to your page. Since this is the main page of your website, you should enter the name of your website here. For example, if you are publishing a personal web page, you might want to name your website "Shakespeare's Website" (without the quotes) if your name happens to be Shakespeare. If you are publishing a company web page, the site name should be your company's name, such as “XYZ Company” or the like.

Once you've finished with the title, click the OK button or simply hit the Enter key.

A new dialog box, prompting you for a filename, will appear. Navigate to a directory (ie, folder) on your computer where you want to save your page. Type "index.html" (without the quotes) into the file name part of the dialog box. Do not accept the default name given in the dialog box. Do not use another name. Do not use capital letters in the name (ie, uppercase). Most web hosts expect the main page of your website to be called "index.html". If you change it, you may find that your website does not work as you expect.

After you've saved the file, you will be returned to the Composer main window. Look at the top of the window to the window's title bar. Notice that instead of the words "untitled", the title that you typed in earlier now appears in the window title bar.

**Uploading or Publishing Your First Web Page**

Before we proceed to polish the page so that it looks at least half-way decent, we need to publish the page to your web host. One reason we're going to do this now, even before we've finished the page, is that Mozilla Composer needs the information about your actual website's address (or URL) before it can correctly handle things like links and images on your web page.

Don't worry about the page being so plain. If you've not advertised your website's address (URL) to anyone, no one will even know your site exists, so this preliminary version of your page will be seen by no one but you. People will not visit your site out of the blue just because you happened to sign up for a web hosting account today. It's not that easy to get visitors!

Another reason that you're publishing your page at this time is so that you can get familiar with both the major stages in the design of a web page. Once you get this hurdle out of the way, and
you know how to get your web page from your computer into your web host's computer, you have mastered what is arguably the biggest technical challenge a newcomer is likely to face.

To publish the page, go to "File | Publish" (ie, the "Publish" item on the "File" menu). A "Publish Page" dialog box will appear asking you for more details.

- "Site Name" is the name that you want to give your website. Use the name that you gave to your website when asked for the title earlier (ie, "Shakespeare's Website" or "XYZ Company" or whatever). This name is only used by Composer internally, to refer to your site, but it's probably best to use the real name you ultimately wish to give to your site to minimize any confusion later.

- "Publishing address" is a bit more complicated to explain. When you signed up for your web hosting account from a commercial web host, you would have been given a whole bunch of details by your web host. Among these is something known as your "FTP address". FTP, or File Transfer Protocol, is the usual means by which you transfer your web pages from your own computer to your web host's computer. Transferring your pages from your computer to your web host's computer is known as "publishing" or "uploading" your pages.

  For the purpose of this tutorial, I will assume that your web host told you that your FTP address is "ftp.example.com". You should substitute your real FTP address everytime you see "ftp.example.com" in the examples below.

  Before you enter that address though, you will need to know which directory (or folder) you need to put your web pages. Some web hosts require you to put your web pages in a directory named "www". Others require you to put it in a "public_html" directory. Still others say that you are to put your web pages into the default directory that you see when you connect by FTP. And so on. Find out the directory where you're supposed to upload your web pages to.

  Once you've got all the details, you're ready to form the address you have to enter into the "Publishing address" field.

  If your FTP address is "ftp.example.com", and the directory that you're supposed to upload to is "www", enter "ftp://ftp.example.com/www" here. Notice that you have prefixed "ftp://" to your FTP address ("ftp.example.com"), added a slash ("/") and followed it with your web directory name ("www"). If your web host tells you to simply upload it to the directory you are logged into when you connect by FTP, then just enter "ftp://ftp.example.com" here.

- The "HTTP address of your homepage" field specifies the actual web address (or URL) of your website. If you registered a domain name like "example.com" for your site, enter "http://www.example.com/" into this box. This field is required because Mozilla Composer will use this information to form links on your site. Be sure to enter the "http://" prefix as well.
The "Login information" contains the user name (or login name) and password that your web host assigned to you. It is needed so that Mozilla Composer can connect to your FTP account and upload (publish) your pages.

When you've finished completing the information, click the "Publish" button. Mozilla Composer will proceed to connect to your FTP account on your web host and upload your pages. There will be a dialog box that pops up to tell you it is uploading your page. The box will automatically disappear when Composer has completed its task.

Testing the Web Page
Before you proceed further, you need to test the version of the web page you have uploaded. This way, you will know whether you've made any mistake when entering your details earlier.
Switch back to Mozilla, or if you prefer, start up Internet Explorer or Opera or Netscape or Safari or Konqueror or whichever browser you normally use. Type the URL (web address) of your website. This is the address that you typed into the "HTTP address" field earlier. For example, type "http://www.example.com" if that is your URL.
If you've entered the "publishing address" earlier correctly, you should see the page you created earlier in your web browser.

If you get an error like "No DNS for www.example.com" or "Domain not found", it probably means that your domain name has not yet propagated to your ISP. Put simply, this means that you probably only just bought your domain name. It takes time for a new domain name to be recognized across the world (usually 2 or more days), so it's possible that your ISP has not yet updated its name servers to recognize your new domain. Some web hosts give you a temporary address which you can use to access your website in meantime. If you have that, use the temporary address to check that your site has been uploaded properly. Otherwise, you'll just have to wait.

If you get an error like "404 File Not Found" or you get your web host's preinstalled default page, you may need to go back and check your "publishing address" field. You may have published your page to a location that is not recognized by the web server as the default page to show when only your domain name is entered.

You can change the settings that you have just entered by accessing the "Edit | Publishing Site Settings" menu. One possibility for the page not showing is that you did not specify the correct directory on your web site to publish your index.html page to. A more remote possibility is that your web host requires that your page be named something other than "index.html". This is very rare nowadays, so explore this last possibility only when you've ruled out all others. At worse, ask your web host's support department or check their documentation for help.

If you get no errors at all, but see the page that you've designed earlier, congratulations! You've created and uploaded your first web page. It may be a rudimentary page but you have successfully walked through all the essential stages of designing and uploading a web page.
Competency 15: Compares and contrasts benefits and issues related to ICT in society

Competency Level 15.1: Investigates the contribution of ICT to the health services.

Activity 15.1: Let's investigate the role of ICT in health Services.

Duration: 40 minutes.

Quality Inputs:

- A dialogue about a banner on a computerized dental clinic in Annexe 15.1.1
- Two copies of the group exploration instructions in Annexe 15.1.2
- Two copies of reading materials in Annex 15.1.3
- Demy sheets and markers.

Learning – Teaching Process:

Step 15.1.1:
- Get two volunteers to present the dialogue.
- Conduct a discussion to highlight the following.

  - The computer can be used to monitor dental conditions.
  - Instructions on keeping teeth healthy can be presented through computers.
  - The condition of teeth is clearly seen on the monitor when examined through computer.
  - Computers are used not only in dental but also in other health care activities.

  (10 minutes)

Step 15.1.2:
- Divide the class into two groups.
- Provide each group with copies of group exploration instructions, reading material, demy sheets and markers.
- Assign randomly the two topics to two groups and involve them in exploration.
- Prepare groups for a whole class presentation at the plenary session.

  (15 minutes)
Step 15.1.3  
• Get each group to present its findings.
• Request the presenters themselves to fill in any gaps they have left.
• Invite constructive comments from the other groups.
• Conduct a discussion to highlight the following.

<table>
<thead>
<tr>
<th>Criteria for Assessment and Evaluation</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Names and describes equipment where computer Technology is used in hospitals.</td>
</tr>
<tr>
<td>• Accepts that Computers play a vital role in safeguarding life.</td>
</tr>
<tr>
<td>• Analyses the contribution of special features of ICT to the health sector.</td>
</tr>
<tr>
<td>• Uses reflection as a tool for learning.</td>
</tr>
<tr>
<td>• Makes optimal use of resources through awareness of their potentials.</td>
</tr>
</tbody>
</table>
Annexe 15.1.1

Dialogue

Amali : Did you see the banner put up in front of the school, Upul?
Upul : Oh! You mean that one about teeth?
Amali : That’s right. Didn’t it say something about the computerized examination of teeth?
Upul : Oh yes, I know about it. In fact, I too attended that clinic.
Amali : Is that so? Why don’t you explain it to us, Upul?
Upul : Well, there was a bus fitted out for the clinic. I went in there, Someone there took me to some kind of special seat. He got me to open my mouth and focused a beam of light into it. And then, every detail of my mouth appeared on a computer screen. There were visuals to indicate the presence of tartar on my teeth, whether there were caries, whether my gums were diseased, and so on.
Amali : Oh! That gives us wonderful instructions to keep our teeth healthy.
Annexe 15.1.2

Instructions for the Group Exploration
Let’s investigate the role of ICT in health Services

- You will be working in two groups with the following topics assigned randomly across the groups
  - Telemedicine
  - Computerized medical equipment
- Go through the reading material provided to get a good understanding of the topic.
- Reflect on your prior experiences on the topic to make a brief presentation to the small groups.
- Listen to the presentations made by your peers to collect ideas on the following
  - Contribution of the topic to the health service
  - Benefits and issues of telemedicine.
  - The aspects to be enhanced by ICT and how this can be accomplished.
- Be prepared to make an innovative whole class presentation.

Annexe 15.1.3

Reading Material

Role of ICT in Health sector

Magnetic Resonance Imaging (MRI) Scanner

MRI is a way of getting pictures of various parts of your body without the use of x-rays, unlike regular x-rays pictures and CAT scans. A MRI scanner consists of a large and very strong magnet in which the patient lies. A radio wave antenna is used to send signals* to the body and then receive signals back. These returning signals are converted into pictures by a computer attached to the scanner. Pictures of almost any part of your body can be obtained at almost any particular angle. These "radio wave signals" are actually a varying or changing magnetic field that is much weaker than the steady, strong magnetic field of the main magnet.

Computer Axial Tomography (CAT) Scan

CAT scan is a method of combining images from multiple x-rays under the control of a computer to produce cross-sectional or three-dimensional pictures of the internal organs which can be used to identify abnormalities; the CAT scan can identify prostate enlargement but is not always effective for
assessing the stage of prostate cancer; for evaluating metastases of the lymph nodes or more distant soft tissue sites, the CAT scan is significantly more accurate.

A type of x-ray that can be used to diagnose the presence of the tumor. CT imaging is particularly useful because it can show several types of tissue - lung, bone, soft tissue, and blood vessels - with great clarity. Using specialized equipment and expertise to create and interpret CT scans of the body; radiologists can more easily diagnose problems such as cancers, cardiovascular disease, infectious disease, trauma, and musculoskeletal disorders. This is a patient-friendly exam that involves little radiation exposure.

What is EEG?

The EEG, or electroencephalograph, deserves mention as one of the first -- and still very useful -- ways of non-invasively observing human brain activity. An EEG is a recording of electrical signals from the brain made by hooking up electrodes to the subject's scalp. These electrodes pick up electric signals naturally produced by the brain and send them to galvanometers (instruments that detect and measure small electric currents) that are in turn hooked up to pens, under which graph paper moves continuously. The pens trace the signals onto the graph paper.

EEGs allow researchers to follow electrical impulses across the surface of the brain and observe changes over split seconds of time. An EEG can show what state a person is in -- asleep, awake, anaesthetized -- because the characteristic patterns of current differ for each of these states. One important use of EEGs has been to show how long it takes the brain to process various stimuli. A major drawback of EEGs, however, is that they cannot show us the structures.

Telemedicine

**Telemedicine** can be defined as the investigation, monitoring and management of patients, using systems, which allow ready access to expert advice and to patient information, no matter where the patient or relevant information is located. This involves the transfer of medical information from one location to another. Increasingly, computer technology will allow much of the work currently being carried out in hospital, to be carried out in people's homes, in an effort not only to improve the efficiency and standards of patient care, but to reduce its cost drastically.

Applications of Telemedicine

The primary applications of telemedicine are clinical, educational, administrative, and research. Clinical applications include initial patient evaluations, diagnosis (telediagnosis), and Consultation (teleconsultation). Physician supervision of non-physicians and monitoring of patient status are possible. Continuing education for professionals is available, as is patient and community education (tele-education). Administrative uses, such as conferences, scheduling, and utilization and quality review may be provided. Research is enhanced by aggregation of data from multiple sources and coordination. Telemedicine allows access to the wealth of information available on the Internet. This allows information to be at the touch of a finger. The availability of e-mail allows an efficient mechanism of communication between consulting and primary physicians. Communication between facilities is enhanced.
Tele-monitoring

A Midwife monitors a pregnant mother in her home, using a portable monitoring briefcase.

Tele-video conferencing

A Doctor discusses a patient's condition with a Consultant.

Transmission and Equipment:

Text, images, and sound are transmitted. Text includes EKG results (heart tracings), lab results and patient records. Images range from still photographs to full motion imagery. Radiological images, slides and graphics may be transmitted, as well as voice and chest sounds.

The Benefits and challenges of Telemedicine:

Benefits

Telemedicine improves the mobility of patient care, and assists access to all kinds of medical information. The patient gets improved treatment, and scarce resources are used more efficiently, securing the reputation of Healthcare Telemedicine as the future of medicine. However, there are telemedicine networks where the excess capacity of rural facilities can be tapped into to benefit urban patients. It is possible that during peak times rural physicians may be accessed via telemedicine to provide more timely care to patients waiting in congested urban emergency rooms.

Challenges

Several obstacles remain with regard to the effectiveness of telemedicine.

- Legal issues regarding physician licensing, liability, and patient confidentiality exist. As physicians are licensed by states or countries, this presents a legal problem when physician consults cross state or country.
- Liability is an obstacle in providing telemedicine. There is debate related to which physician would be liable for a poor patient outcome, the primary care or the consulting physician. In the case of a poor outcome, it is not clear if the patient should file suit in the residing country or in the country the practitioner is located.
- Cost is a significant barrier to access. It has been estimated that the startup cost for a rural facility can be very high. In addition to start up costs, consideration must be given to the charge by the consultation team.
- Transmission charges to access resources can be costly.
- Reimbursement has been another obstacle in providing telemedicine services.
Competency 15: Compares and contrasts benefits and issues related to ICT in society

Competency Level: Investigates the contribution of ICT to education.

Activity 15.2: Let's investigate the role of ICT in education.

Time: 80 minutes.

Quality Inputs:
- Any available educational software CDs.
- Three copies of group exploration instructions in Annexe 15.2.1
- Three copies of reading material in Annexe 15.2.2
- Demy sheets and markers.

Learning – Teaching Process:

Step 15.2.1:
- Expose the educational software CDs to the class.
- Pose the question on the CDs shown.
- Conduct a discussion to highlight the following.
  - These CDs are prepared to support the learning of particular subjects area.
  - To see the contents of these CDs a computer is needed.
  - Viewing a CD makes us to get a clear understanding along with attractive pictures, audio and animation rather than reading material only
  - ICT helps access this type of materials

(15 minutes)

Step 15.2.2:
- Divide the class into three groups.
- Provide each group with copies of group exploration instructions, educational software CDs, reading material, demy sheets and markers.
- Assign three topics to the three groups and involve them in the exploration.
- Prepare the groups for an innovative presentations at the plenary session.

(25 minutes)

Step 15.2.3:
- Get each group to present its findings.
- Request the presenters themselves to fill in any gaps they have left.
- Invite constructive comments from the other groups.
- Conduct a discussion to highlight the following.
Criteria for Assessment and Evaluation

- Describes the use of ICT in education.
- Accepts that the ICT provides an interactive mode of learning.
- Categorizes the provision of ICT in terms of learning, teaching and management.
- Uses Internet services for information sharing.
- Develops self-learning practices.
Annexe 15.2.1

Instructions for the Group Exploration

Let's investigate the role of ICT in Education Services

- You will be working in two groups with the following topics assigned randomly across the groups
  - e-learning
  - Learning Management System
  - School Information Management System
- Go through the reading material provided to get a good understanding of the topic.
- Reflect on your prior experiences on the topic to make a brief presentation to the small groups.
- Listen to the presentations made by your peers to collect ideas on the following
  - Contribution of the topic to the education service
  - Benefits and issues of e-learning.
  - The aspects to be enhanced by ICT and how this can be accomplished.
- Be prepared to make an innovative whole class presentation.

Annexe 15.2.2

Reading Material

What is e-Learning?

e-Learning is a catch-all term that covers a wide range of instructional material that can be delivered on a CD-ROM or DVD, over a local area network (LAN), or on the Internet. It includes Computer-Based Training (CBT), Web-Based Training (WBT), Electronic Performance Support Systems (EPSS), distance or online learning and online tutorials. The major advantage to students is its easy to access. There are some typical elements and a standard approach to developing or authoring e-Learning material.

e-Learning provides easy access

The student or learner with information that can be accessed in a setting free of time and place constraints. The student can go through the lessons at his or her own pace.

In many cases—especially in a CBT delivered on a CD-ROM—the material is media-rich information, including such multimedia forms as audio and video.

The progress and achievement of the student can be assessed in e-Learning, with custom feedback and evaluation available in an interactive environment.

Learning Management Systems

Learning Management Systems enable an organization to effectively train a large group of individuals - enterprise wide. With a Learning Management System, or LMS, training and e-learning are managed by the LMS software allowing users and administrators alike to easily access courses and reports.

Using a LMS, users can log on and easily access the training courses. As the student completes the course, scores are tabulated and reports generated. Likewise, managers and administrators can
access reports on the LMS and track the students’ progress.

**Pre-Assessments** – If a student already has the expertise in a particular subject, the assessments show that and the course is adjusted to reflect that. This reduces the amount of training time while maintaining the high quality of instruction.

**Real Time Progress Tracking** – Learners and managers alike can view feedback in real time. This immediate feedback keeps users focused and reduces learner abandonment rates.

**Customizable group reports** – In depth, customizable and relevant reports allow for measurement and tracking of usage, knowledge transfer, completion and progress.

**Simple Global Deployment** – LMS can be deployed in a fraction of the time as other learning management systems. This reduces costs and frees up your IT staff for other projects.

**Secure and Reliable** – With our Learning Management System, users access the courses in a secure environment. Administrators can monitor the progress of all users.

**Robust Management** – With our LMS, you can organize and manage individuals and groups providing a fantastic return on investment across business units or at the individual learner level.

**School Information Management System**

Management characterizes the process of leading and directing all or part of an organization through the deployment and manipulation of resources (human, financial, material, intellectual or intangible). There are five management functions: Planning, Organizing, Leading, Coordinating and Controlling.

In School Information Management System the software used for the automation of the school administrative activities, is especially to handle the Information needed by the administration of the school. This software provides interfaces to the database data entry, extracting information and printing etc. Using such a system helps handling the following:

- Student registration
- Allocation of class and teacher timetable
- Staff information (leave, salary etc)
- Inventory control
- Students’ attendance reports
- Issuing of character certificate
- Facility fees / quality input cash book etc.

Regularly needed Information by the school administration can be obtained through clear reports generated by the software. This improves the efficiency and productivity of the school management.
Competency 15: Compares and contrasts benefits and issues related to ICT in society

Competency Level 15.3: Investigates the contribution of ICT to agriculture

Activity 15.3: Let’s find out how ICT serves agriculture

Time: 40 minutes.

Quality Inputs:
- Three copies of group exploration instructions in Annexe 15.3.1
- Three copies of reading material in Annexe 15.3.2
- Demy sheets and markers

Learning – Teaching Process:

Step 15.3.1:
- Pose the question to the class as to how techniques used in the agriculture have improved compared to those used in the past.
- Conduct a discussion to highlight the following.
  - Farming was found difficult and laborious in the absence of proper equipment 40 to 50 years ago.
  - Buffaloes and ploughs were used for tilling purposes.
  - Farming was not a profitable enterprise in the absence of selected seeds and fertilizer.
  - The equipment available today were not there in the past.
  - Farmers transported their produce to the market in bullock carts and resulting in damage to the produce and loss to the farmers.
  - Nowadays tractors and many modern computer controlled agricultural equipment are available and are in use.
  - Farmers are provided information relevant to their occupation through ICT.

(10 minutes)

Step 15.3.2:
- Divide the class into three groups.
- Provide each group with copies of group exploration instructions, reading material, demy sheets and markers.
- Assign randomly the three topics to three groups and involve them in the exploration.
- Prepare groups for a presentation at the plenary session.

(15 minutes)
Step 15.3.3:

- Get each group to present its findings.
- Request the presenters themselves to fill in any gaps they have left.
- Invite constructive comments from the other groups.
- Conduct a discussion to highlight the following.

<table>
<thead>
<tr>
<th>Criteria for Assessment and Evaluation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Names and describes equipment where computer Technology is used in agriculture.</td>
</tr>
<tr>
<td>Accepts that ICT plays a vital role in promoting agricultural productivity.</td>
</tr>
<tr>
<td>Makes best use of facilities available in ICT for farming.</td>
</tr>
<tr>
<td>Uses modern equipment in farming.</td>
</tr>
<tr>
<td>Makes optimal use of resources through awareness of their potentials.</td>
</tr>
</tbody>
</table>
Annexe 15.3.1

Instructions for the Group Exploration

Let's investigate the role of ICT in agriculture

• You will be working in three groups with the following topics assigned randomly across the groups.
  o Computer controlled agricultural equipment
  o Feeders for dairy cows and cow milking
  o Green house
  o Farming
  o Information searching on agriculture
  o Virtual competitive market for agricultural products
  o Optimization of agricultural productivity
  o Detection and control of pests
  o Optimization of fertilizer use and Weather prediction

• Study the reading material provided to understand the topic well.
• Reflect your prior experiences on the topic to make a brief presentation to the small groups.
• Listen to the presentations made by your peers to collect ideas on the following
  o Contribution of the topic to the agricultural sector.
  o How ICT has facilitated the topics mentioned above.
    o The aspects to be enhanced by ICT and how this can be accomplished.
• Write down the key points relevant to the topic in terms of Agriculture.
• Be prepared to make an innovative whole class presentation.
ICT In Agriculture

ICT in the agriculture sector facilitates knowledge sharing within and among a variety of agriculture networks including researchers, importers/exporters, extension services, and farmers. ICT enables vital information flows by linking rural agricultural communities to the Internet, both in terms of accessing information and providing local content.

ICT activities in agriculture:

- Use of Internet and e-mail for extension purposes
- Communicating agro-meteorological information
- Communicating market price information
- Facilitating networks of agriculture researchers
- Developing land registries

In addition to Internet as the backbone, the province run television station, call center, telephone, mobile phone, and village-run broadcast will be used to meet farmers' needs using so-called "all-round ICT service". It will be a participatory approach to the development strategy of information service. All stakeholders should be mobilized to contribute their money, labor, or knowledge including government agencies, private sectors, companies, farmers, marketers, technicians and professionals with agricultural information and knowledge.

Computer controlled agricultural equipment

Computerized Concentrate Feeders for Dairy Cows

Dairy cows have traditionally been fed concentrates as they are milked to supplement nutritional requirements not supplied by the forages. In smaller-sized herds, feeding concentrates usually requires a considerable amount of labour. Automatic concentrate-dispensing equipment is available for use in stanchion or comfort-stall barns, but few producers have installed such equipment. On farms where concentrates are fed in milking parlors, the opportunity for individual feeding varies considerably, depending on type of equipment and milking management practices.

In some installations, the amount of concentrate each cow receives at each milking varies according to her needs, while in other setups; all cows have free-choice access to the concentrate while in the parlor. Dairy farmers have used various approaches to remove or reduce the feeding of concentrates in the parlor while trying to attain better control of feeding cows as individuals and still handle them as a group, especially in herds ranging in size from 50 to 150 cows.

With computer-controlled concentrate feeders, each cow wears a device around her neck that identifies her. As she enters the feeder head box, her specific number is read electronically and the amount of concentrate programmed in the computer's memory for her to receive is delivered at a rate she can consume before leaving the head box -- usually about one-half pound per minute. The total concentrate allotment is not available upon one entry to the head box but will be divided usually into four or more intervals for the 24-hour period.

Depending on the brand and model, multiple feed-dispensing units capable of delivering from two to four different feeds to each head box are available. Some systems include a cow calendar program that will generate reports listing days in milk, cows to dry off, cows to breed, etc., that can be used in
managing the herd. Certain systems also include another program that will automatically adjust the daily amount of concentrate each cow is allowed to receive. Adjustments are based upon days since calving, projected lactation curves, or programmed equations. Some units either are or can be connected to a computer to allow other record-keeping functions to be performed.

Each cow with access to a computer-controlled concentrate feeder wears a device that identifies her when she enters the feeder head box.

**Advantages**

Computerized concentrate feeder systems overcome the feeding management problems of regulating the total amount of concentrate consumed in a day by regulating how much concentrate can be consumed at each meal, knowing how much concentrate each cow eats daily, and feeding varying amounts of different concentrate ingredients to each cow according to her individual requirements. Computerized feeders can also eliminate the need for feed in the milking parlor, thereby increasing efficiency and potentially increasing profits.

By having better control of the concentrate feeding program, dairy farmers responding to surveys conducted in 1982 and 1983 indicated an average increase in daily production per cow of more than 7%, an increase in milk fat of 0.1 percentage unit and a 10% reduction in total amount of concentrate fed to the herd after computer-controlled feeders were installed. These results will vary with several factors, including the type, quality, and quantity of forage fed, the production level of the cows, the method used currently to feed concentrates, and the amount of concentrates fed. Results will also be greatly dependent on the level of management practiced in the herd - better results will accrue to those who spend more time managing the system. Forage mixer units and grinders that have weighing devices on them are very worthwhile.
Computer-controlled feeder head-box units should be well-protected and located in an area with good ventilation and lighting.

**Summary**
Because feed costs constitute 50 to 60% of the total cost of milk production, regulating feed costs and/or improving feed utilization becomes the largest single area where profits can be increased. Due in part to high labor costs and attempts to reduce drudgery, feeding systems have become increasingly mechanized, automated, and computerized. Individual cow concentrate-feeding systems are rapidly gaining acceptance by dairy farmers across the United States. Capabilities of these systems grow as the feeding function becomes integrated with other herd management applications by interfacing the feeding system with more powerful computers. Most of the systems incorporate "management action reporting" into the feeder system directly. Ration formulation and feed distribution should be analyzed carefully so animal productivity, health, and profitability are maximized.

*Milk cows farm project and milk processing technology.*
The milk-cow farm technology consists of the following components:
- A detailed design and engineering of the farm and all its components, including the infrastructure and utilities.
- Research of the available Feed in order to secure the needed optimal nutrition for the live-stock.
- Support in the selection of the live-stock and breeding.
- Supply of the milking center and milk cooling and storage systems.
- Supply of the most modern tracking, data collection and management computerized system, based on individual electronic tags and data readers and the comprehensive farm management software.
- Erection of a feed center based on optimization of the feed formulation based on the most cost-effective selection of local available feed/nutrition sources and materials, and the use of the computerized "self" mixing and distribution wagon.
- In farm quality control laboratory to ensure the quality of the milk.
- A veterinary support to tackle any veterinarian problem in its initial phase and use of artificial insemination for herd expansion.
- An advanced, computerized daily management of the farm.
- The above described technology is widely practiced and has been proven to yield the highest milk records per cow in the world.

Milk processing factory:
It is believed that an integrated project which will use its own milk for milk products processing will pay much higher return to the farm owners.

An advanced milk processing technology for a medium size milk processing plant is available in huge milk factories by processing quality and high market value milk products, by entering with relatively low cost investment into special market segments like: "milk delicious", different types of cheese, and flavored milk drinks and ice-cream.
Self propelled and loading feed mixing wagon
Controlled Environments for Animal and Plant Production and Commodity Storages (CEAPS) include:

ICT applications

Drying with desiccants for food processing operations; optimal sizes and/or environments for grain bins or other commodity storage facilities;

Greenhouse irrigation systems; nutrient management in greenhouses; greenhouse wetland systems; greenhouse heating; animal housing systems; behavior, safety and comfort of animals and workers; heat stress relief for animals; air quality/animal performance interactions; air quality/human respiratory responses; modeling air quality in buildings; environmental control for plant systems; mushroom production systems; and use of enthalpy wheels in ventilation systems.

Mechanical and Structural Systems (MSS) research includes:

Pesticide application systems (variable rate, draft control, air-blast); design of agricultural machinery systems; evaluation and improvement of animal feeding systems; forage harvesting and storage; feeding systems to optimize animal performance; optimizing the use of forages and other ruminant feed resources; automation in existing food processing plants; computer vision systems for non-destructive evaluation of food products; robotics applications in fruit and vegetable mechanization; radiotelemetry for predicting damage during mechanical handling; vehicle tracking systems; sensor development for precision agriculture; remote sensing for crop assessment; GPS and GIS development and applications in agriculture; fuel cells and microturbines for on-site electricity generation; wood engineering; analysis/design of post frame structures; hardwood glue-laminated design; wood bridge design; bulk solids storage dynamic loads; load deformation behavior of feeds, grains, fertilizers, and pesticides; finite element and boundary element modeling of structural systems; interactions between structural materials and granular media; and alternative structural systems for housing.
Natural Resources Conservation and Management (NRCM) projects include:
Agricultural mapping systems; sedimentation basin design; tillage system effects on runoff, erosion, and pollutant transport; erosion processes; hydrology of quality turfgrass areas; drinking water quality and treatment for domestic and livestock use; numerical modeling of water and pollutant transport processes; methods for identifying critical nutrient contributing areas in watersheds; GIS-based evaluation of non-point pollution from agricultural lands; modeling the physical and economic aspects of conservation and nutrient management practices; water quality under greenhouse systems; utilization of sludge on forest and non-agricultural land; utilization of recyclable materials in agricultural systems; decontamination of polluted soils; transformation, uptake, and movement of wastes and chemicals applied to soils; on-site wastewater treatment and management; milking center wastewater disposal systems; composting and refeeding residues from agricultural production, food processing, and dining facilities; biogas production from animal manures and other biological materials; biogas utilization for generation and vehicle power; and odor control for mushroom and animal production facilities.

Processing for Adding Value to Biological Materials (PAV)

Flow behavior of powder and granular food products; aseptic processing of food products; food biosensors; on-line computer control of food processing operations; modeling heat transfer mechanisms during thermal processing of foods; food automation and control; smart food systems; storage reaction kinetics of biotechnology-derived products; mechanical properties of food and other biological materials; dielectric properties of food and other biological materials; new technologies in food processing; constitutive models for bulk foods; microscopic approach for load response of granular materials; thermophysical properties of freezing and frozen foods; failure mechanisms of food and other biological materials; computer models of food products during microwave heating; numerical modeling of food processing operations; microwave processing of foods; food safety during minimal and added-value processing; industrial microbiology/fermentation.
Competency 15: Compares and contrasts benefits and issues related to ICT in society

Competency Level 15.4: Investigates the contribution of ICT to industries

Activity 15.4: Let’s investigate the role of ICT in health Services.

Time: 40 minutes.

Quality Inputs:
- A picture of a backhoe in Annexe 15.4.1
- Three copies of the group exploration instructions in Annexe 15.4.2
- Three copies of reading materials in Annex 15.4.3
- Demy sheets and markers.

Learning – Teaching Process:

Step 15.4.1:
- Expose the picture to the class.
- Pose questions on the picture to the class.
- Conduct a discussion to highlight the following.
  - Backhoes are used in earth cutting and road construction work etc.
  - Using machinery helps save time and increases productivity.
  - Instruments in the machines are Mechanically operated.
  - Some machines used in industry function on computer instructions.

(10 minutes)

Step 15.4.2:
- Divide the class into three groups.
- Provide each group with copies of group exploration instructions, reading material, demy sheets and markers.
- Assign randomly the three topics to three groups and involve them in exploration.
- Prepare groups for a presentation at the plenary session.

(15 minutes)

Step 15.4.3:
- Get each group to present its findings.
- Request the presenters themselves to fill in any gaps they have left.
- Invite constructive comments from the other groups.
• Conduct a discussion to highlight the following.

<table>
<thead>
<tr>
<th>Computerized machines are used in industries to perform various tasks.</th>
</tr>
</thead>
<tbody>
<tr>
<td>o Banking – Transactions, Calculating interests</td>
</tr>
<tr>
<td>o Factories – Designing, Production, Quality controlling, Packaging</td>
</tr>
<tr>
<td>o Printing – Designing and Printing</td>
</tr>
</tbody>
</table>

• Specified tasks are carried out according to given Instructions

• Computer Assisted Designs (CAD) are more accurate than hand design.

• Computer Assisted Manufacturing (CAM) enables very high accuracy levels in large-scale production

• Performing the same movement at different possibilities is the special characteristic of robotics

• Robotics are used in industries for
  o Moving things to places where man cannot reach
  o Avoiding coalition–acting according to possibilities

• Initial cost is high when using CAD CAM systems but profitable.

• Modeling and Simulation software saves time and money.

Criteria for Assessment and Evaluation

• Names and describes the CAD and CAM software used in industry
• Accepts that computers facilitate fine production.
• Analyses the contribution of special features of ICT to the industry.
• Uses modern techniques and tools at work.
• Compares and contrasts when investing.
Instructions for the Group Exploration

Let's investigate the role of ICT in industry

- You will be working in two groups with the following topics assigned randomly across the groups
  - Computer Assisted Design (CAD) and Computer Assisted Manufacture (CAM)
  - Computerized services in production
  - Robotics
- Go through the reading material provided to understand the topic well.
- Reflect on your prior experiences on the topic to make a brief presentation to the small groups.
- Listen to the presentations made by your peers to collect ideas relevant to your topic.
- Write down the advantages and disadvantages relevant to the topic.
- Be prepared to make an innovative whole class presentation.

Reading Material

Information and communication technology (ICT) is an essential tool in the industrial sector for different tasks. The following explains the usage of ICT in industry.

- Computer Assisted Design and Manufacture (CAD) and (CAM)
- Computerized services and production
- Robots
Computer-aided design (CAD)

CAD software is used to design the structure of vehicles, machinery, aircrafts, mother board of PCs etc. CAD software can also be used for writing the program used in ICs. It is written in programme-editing software before being downloaded onto the chip.

These designs and manufacture can be more accurate than hand-drawn designs and reduces human error. You can save and edit ideas, which make it easier and cheaper to modify your design as you go along; you can modify existing ideas, which saves time.

Computer-aided manufacture (CAM)

The above designs can be produced or manufactured using CAM. Good for batch or mass production and they are of two types:

2D CAM machines
Plotter/cutters can be used either for cutting of card and vinyl, to produce drawings and lettering prior to cutting. Cutter/printers are more complex CAM machines which allow full-colour printing before cutting is done.

3D CAM machines
Mainly used for cutting plastics, hard wax, soft metals and wood-based materials such as MDF. Some of these machines can have a scanner head fitted in place of the cutting tool, allowing 3D scanning to be done.

Robots

What is a Robot?
A robot is a construction of mechanical, electrical, and electronic components, which is capable of autonomous or semi-autonomous operation towards a function or goal specified by the builder or programmer. Human intervened machines with no internal programming or algorithms do not qualify as robots. Most true robots have sensors that allow them to detect details of their environment, and change their behavior accordingly, but do so with essentially no intelligence.

Today robots are mainly used in industrial manufacturing systems for welding, assembling etc. The users are big manufacturers with high volumes and high competence. A robot the size of a person can easily carry a load over one hundred pounds and move it very quickly with a repeatability of +/-0.006 inches. Furthermore these robots can do that 24 hours a day for years on end with no failures whatsoever.

Computerized Machineries in Industry

In the process of manufacturing, packaging and supplying computerized machineries play a vital role. These machineries are controlled or operated by human intervention through software.

- Polythene Industries in U.K using the most advanced computerized productions processes.
- Quality controlling in a fully automated bearings production company.
1. Fully automatic computerized dry and wet-mixed concrete batching plants spread over 7 strategic locations
2. A fleet of 260 concrete mixer trucks equipped with GPS tracking system
3. Centralized Call Center for order taking and delivery schedule
4. A qualified in-house approved

Some of the most common activities in banking industry are
- Cash transaction
- Statements of accounts
- Calculation of interest
- Automated Teller Machine service carried out using ICT.

The printing industry nowadays cannot survive if ICT is not used.
- Graphic – designing, Scanning and modifying
- Text – leaflets, newspapers, magazines
- Printers – high-quality printers, plotters
- 2D and 3D CAM machines (explained in CAD/CAM)
Competency 15 : Compares and contrasts benefits and issues related to ICT in society

Competency Level : Explores the contribution of ICT to business
Activity 15.5. : Let’s investigate the role of ICT in business.
Time : 40 minutes.

Quality Inputs :
• Three copies of the group exploration instructions in Annexe 15.5.1
• Three copies of reading materials in Annex 15.5.2
• Computer connected to the internet
• Demy sheets and markers.

Learning – Teaching Process:

Step 15.5.1 :
• Expose an Internet site such as sltnet.lk to the class.
• Conduct a discussion to highlight the following.
  • Business has changed in the light of ICT, in the modern world.
  • The computer can be used in shopping (to buy goods).
  • One can invest in the stock market through the Internet.
  • Computers are widely used in advertising in the modern world.

(10 minutes)

Step 15.5.2 :
• Divide the class into three groups.
• Provide each group with copies of group exploration instructions, reading material, demy sheets and markers.
• Assign randomly the three topics to three groups and involve them in the exploration.
• Prepare groups for a presentation at the plenary session.
• Use internet to connect to some business web sites; eg.
  o SLT web site (www.sltnet.lk)
  o Colombo stock exchange (www.cse.lk)
  o http://www.ashaphillip.net/home.htm
  o http://www.slt.lk
• Identify how features of these websites cater to the development or effectiveness of business

(15 minutes)

Step 15.5.3: • Get each group to present its findings.
• Request the presenters themselves to fill in any gaps they have left.
• Invite constructive comments from the other groups.
• Conduct a discussion to conclude the lesson.
• Conduct a discussion to highlight the following.

- ICT has contributed to the development of business.
- One can order goods and pay the bill through the internet.
- One can transact with the stock market through the internet.
- Advertising can be made more attractive and effectively using the internet.
- Life has become easier through technology.

(15 minutes)

Criteria for Assessment and Evaluation

- Names and describes the places where one can order goods and pay bills through the internet
- Accepts that Computers play a vital role in the business field
- Analyses the specific features of ICT that enhances the business sector.
- Uses technology to make life easier.
- Works as a group in day to day life
Instructions for the Group Exploration

Let’s investigate the role of ICT in business

- You will be working in one of three groups on one of the following topics assigned
  - Online shopping
  - Online stock market transactions
  - Advertising
- Study the topic assigned to your group in the reading material provided and get a thorough understanding of how helpful your topic is to the business
- Write down the key points relevant to the topic in terms of efficiency, accuracy, security, privacy, etc..
- Be prepared to present your findings at the plenary session.

Reading Material

Online Shopping

Shopping on the Internet can be economical and convenient. Shopping on the Internet is no less safe than shopping in a store or by mail. To help ensure that your online shopping experience is a safe one:

- **Know who you’re dealing with.** Confirm the online seller’s physical address and phone number in case you have questions or problems.
- **Know exactly what you’re buying.** Read the seller’s description of the product closely, especially the fine print.
- **Know what it will cost.** Factor shipping and handling — along with your needs and budget — into the total cost of the order.
- **Pay by credit or charge card**, for maximum consumer protections.
- **Check out the terms of the deal**, like refund policies and delivery dates.
- **Print and save records of your online transactions.**

Shopping online offers lots of benefits that you won’t find shopping in a store or by mail. The Internet is always open — seven days a week, 24 hours a day — and bargains can be numerous online. With a click of a mouse, you can buy an airline ticket, book a hotel, send flowers to a friend, or purchase your favorite fashions. But sizing up your finds on the Internet is a little different from checking out items at the mall.

If you’re buying items from an online retailer or auction website, OnGuard Online offers this advice to help you make the most of your shopping experience:

- **Know who you’re dealing with.** Anyone can set up shop online under almost any name. Confirm the online seller’s physical address and phone number in case you have questions or problems. If you get an email or pop-up message while you’re browsing that asks for financial information, don’t reply or click on the link in the message. Legitimate companies don’t ask for this information via email.
• **Know exactly what you're buying.** Read the seller’s description of the product closely, especially the fine print. Words like “refurbished,” “vintage,” or “close-out” may indicate that the product is in less-than-mint condition, while name-brand items with “too good to be true” prices could be counterfeits.

• **Know what it will cost.** Check out websites that offer price comparisons and then, compare “apples to apples.” Factor shipping and handling — along with your needs and budget — into the total cost of the order. Do not send cash under any circumstances.

• **Pay by credit or charge card.** If you pay by credit or charge card online, your transaction will be protected by the Fair Credit Billing Act. Under this law, you have the right to dispute charges under certain circumstances and temporarily withhold payment while the creditor is investigating them. In the event of unauthorized use of your credit or charge card, you generally would be held liable only for the first $50 in charges. Some companies offer an online shopping guarantee that ensures you will not be held responsible for any unauthorized charges made online, and some cards may provide additional warranty, return, and/or purchase protection benefits.

• **Check out the terms of the deal, like refund policies and delivery dates.** Can you return the item for a full refund if you’re not satisfied? If you return it, find out who pays the shipping costs or restocking fees, and when you will receive your order. A Federal Trade Commission (FTC) rule requires sellers to ship items as promised or within 30 days after the order date if no specific date is promised.

• **Keep a paper trail.** Print and save records of your online transactions, including the product description and price, the online receipt, and copies of every email you send or receive from the seller. Read your credit card statements as you receive them and be on the lookout for unauthorized charges.

• **Don't email your financial information.** Email is not a secure method of transmitting financial information like your credit card, checking account, or Social Security number. If you initiate a transaction and want to provide your financial information through an organization’s website, look for indicators that the site is secure, like a lock icon on the browser’s status bar or a URL for a website that begins “https:” (the “s” stands for “secure”). Unfortunately, no indicator is foolproof; some fraudulent sites have forged security icons.

**Stock Exchange**

**Stock Market**

You are reading about the Sri Lanka Stock Market

**Colombo Stock Exchange**

The Colombo Stock Exchange (CSE) is the only Stock Exchange in Sri Lanka. There are 243 companies listed on the Exchange. Quotations have been granted to 247 equities and 36 Debt Securities as at 30th June 2002. Companies can seek a listing either on the Main Board or the Second Board of the Exchange to list debt or equity. The Listing Rules have been structured to offer maximum flexibility to companies to raise debt and equity. Listed companies are subject to a set of continuing listing requirements, which have been designed to secure the confidence of investors by ensuring that companies will provide sufficient information to enable investors to form a reliable basis for making informed investment decisions. Companies that do not adhere to continuing listings requirements are transferred to the Default Board.

The CSE is a member of the WFE (International Federation of Exchanges). The market capitalisation of the CSE as at 30th June 2002 was Rs.144 Billion (US $1.4 Billion). This amounts to 10.2% GDP. Listed companies are classified into 20 sectors.

The CSE is characterized as one of a mutual exchange which operated on a not for profit basis. The CSE is licensed by the Securities and Exchange Commission of Sri Lanka (SEC). Presently, it has 15 institutional members, all of whom are licensed by the SEC to act as stockbrokers.
The Exchange operates an order driven market using an automated screen based trading system and an automated post trade clearing and settlement system. It has a Central Depository and trading is script less. The Central Depository System (CDS) provides facilities for the clearing and settlement of securities. The CDS is a fully owned subsidiary of the CSE. Trading takes place on all week-days (Monday to Friday) between 9.30 a.m. to 12.30 p.m.

The Colombo Stock Exchange is structured as a Self Regulatory Organisation (SRO). It is responsible for regulating Member Firms (stockbrokers) and Listed Companies. As a modern exchange, The CSE now offers state-of-the-art technological infrastructure to facilitate an "order driven trading platform" for securities trading, for shares and corporate debt securities.

Foreign investment in the stock market is freely permitted except in the case of a few companies where there are certain restrictions imposed.

There are no taxes imposed on share transactions except for a 10% withholding tax on dividends.

On-line and historical market information is available internationally and locally through data vendors and the exchange.

Member firms publish regular research reports and the CSE publishes market information on a daily, weekly, monthly, quarterly and annual basis.

Use the Following Websites to understand how advertisements are helpful in electronic business

- www.sltnet.lk
- www.cse.lk
- http://www.ashaphillip.net/home.htm
- http://www.slt.lk
Competency 15: Compares and contrasts benefits and issues related to ICT in society

Competency Level 15.6: Explores the contribution of ICT to Entertainment

Activity 15.6. : Let’s use the computer for entertainment.

Time : 40 minutes.

Quality Inputs : ● A pack of cards or any game introduced by the teacher that seems interesting to students.
                ● Three copies of the group exploration instructions in Annexe 15.6.1
                ● Three copies of reading material in Annexe 15.6.2
                ● A soft copy of a card game, a song and a short movie installed in the computer.

Learning – Teaching Process:

Step 15.6.1 : ● Get the students to play a game using a pack of cards or the game introduced by the teacher.
       ● Conduct a discussion to highlight the following.

Step 15.6.2 : ● Divide the class into three groups.
       ● Provide each group with copies of group exploration instructions.
       ● Assign randomly the three topics to three groups and involve them in exploration.
       ● Prepare groups for a presentation at the plenary session.

(10 minutes) (15 minutes)
Step 15.6.3:

- Get each group present its findings.
- Request the presenters themselves to fill in any gaps they have left.
- Invite constructive comments from the other groups.
- Conduct a discussion to highlight the following.

(15 minutes)

Criteria for Assessment and Evaluation

- Describes how ICT is used for entertainment.
- Accepts that the computer can be used to spend one's leisure effectively.
- Analyses the contribution of special features of ICT to entertainment.
- Uses the computer as a tool for entertainment.
- Enlightens others on the use of ICT for entertainment.
Annexe 15.6.1

Instructions for the Group Exploration

Let’s spend our leisure with games, songs and movies

• You will be working in three groups with the following activities assigned randomly across the groups.
  o Playing card game
  o Listening to a song
  o Insert MP3 CDs or DVDs in the relevant drives
  o Watching a movie
  o Insert CDs or DVDs containing movies in the relevant drives
• Go through the reading material and do the activity provided to understand the entertainment well.
• Reflect on your prior experiences on the activity to make a brief presentation to your group.
• Listen to the presentations made by your peers to collect ideas on the following
  o The contribution of the games, songs and movies to entertainment
  o Benefits and issues of entertainment in ICT.
• Be prepared to make an innovative whole class presentation.

Annexe 15.6.2

Reading Material

Interactive entertainment and gaming

Interactive entertainment and games are often seen as synonymous, but in reality include rather different sets of activities, interactive television and gaming.

Interactive TV is often described as "lean back" interaction, as users are typically relaxing in the living room environment with a remote control in one hand. This is in contrast to the personal computer -oriented "lean forward" experience where a keyboard, a mouse and a monitor is used. Thus ‘gaming’ in this sense is technically, a computer game composed of a PC or video game console (a computer specially made for game play) – a controlled virtual universe that players may interact with in order to achieve a goal.

Internet games require a connection to the Internet. Internet gaming was originally an offshoot from personal computer games, but may be considered a platform in itself due to its growing scope and the inclusion of Internet capabilities in modern consoles, such as the PlayStation 2, the Gamecube, and the Xbox. Internet gaming in the form of multiplayer online games currently has a massive presence and includes a number of genres such as: Action, Board (involving play on a virtual game
board), Cards, Classics, Flight Sim, MUD (Multi User Dimension / Multi User Dungeon), RPG (Role playing games), Sports, strategy, Trivia/ Puzzle.

**How to play VCDs using Media Player**
These guides describe how to watch and play VCD, SVCD or DVD on your computer or TV.

**How to play VCD, MPEG1 In Windows**
You can play VCDs with Windows Media Player, insert the VCD in your CD-ROM or DVD-ROM and browse to the MPEGAV folder and double click on the .dat file and associate it with Media Player and open them with that.

To play a VCD with menus and still pictures use WinDVD or PowerDVD, insert the VCD and just hit Play.

Use a low resolution, like 640x480, on the monitor when watching a VCD to get best quality.

**How to play DVD, MPEG2 In Windows**
To play a DVD you need a software DVD Player, then it is just to insert the DVD in your DVD-ROM and hit Play using any player like PowerDVD or WinDVD.
To play MPEG2 with Windows Media Player you need a software DVD Player installed or a MPEG2 Codec.

To play a copied/ripped DVD from your HD you can use WinDVD, just right click on the play window and choose **Source->DVD from folder** and choose the VIDEO_TS folder.
To play a copied/ripped DVD from the HD with PowerDVD just click on the open button and choose **Open DVD File from the Hard Disk Drive** and open the video_ts.ifo in the VIDEO_TS folder.

**Audio - Listening**
If you would like to listen to MP3 files on your computer, then you need:

- **A computer**
- **A sound card and speakers for the computer** (If your computer has speakers, it has a sound card.)
- **An MP3 player** (a software application you can download from the Web in 10 minutes) Media player, CD/DVD ROM

**MP3 files - Audio**
You can go to one of the sites, find a song and download it to your hard disk (most MP3 sites let you either listen to the song as a streaming file or download it -- you want to download). Most songs range between 2 and 4 MB, so it will take 10 to 15 minutes unless you have a high-speed Internet connection. Once the song has finished downloading, try to double-click on the file and see what happens. If your computer plays it, then you are set.
How the MP3 Cycle Works

Files can be transferred via the Internet to another user.

Audio is digitally compressed and encoded to create MP3 audio files.

Your computer can rip MP3 files from an audio CD or collect them from MP3 players.

MP3 files can be collected or downloaded from the Internet to your computer.

MP3 files can be transferred to a portable MP3 player or made into an audio CD.
Competency 15: Compares and contrasts benefits and issues related to ICT in society

Competency Level 15.7: Assesses issues related to ICT with respect to ethical and legal aspects

Activity 15.7: Let’s maintain the ethics of ICT use for the benefit of society.

Time: 40 minutes.

Quality Inputs:
- Two copies of the Role Play in Annexe 15.7.1
- Four copies of Group Exploration Instructions in Annexe 15.7.2
- Four copies of reading material in Annexe 15.7.3
- Demy sheets and markers

Learning – Teaching Process:

Step 15.7.1:
- Get two volunteers to perform present the role play.
- Conduct a discussion to highlight the following.
  - There are few people who are interested in peeping into others personal affairs.
  - Accessing personal documents of others is not ethical.
  - ICT users have to follow agreed rules and regulations to protect their documents.
  - Similar action needs to be taken to protect hardware and software.

(10 minutes)

Step 15.7.2:
- Divide the class into three groups.
- Provide each group with copies of group exploration instructions, reading material, demy sheets and markers.
- Assign randomly the three topics to three groups and involve them in the exploration.
- Request groups to become familiar with the concept of ethics by reading the definitions and questions given in part 1 of the handout.
- Prepare groups for a whole class presentation at the plenary session.

(15 minutes)

Step 15.7.3:
- Get each group to present its findings.
- Invite constructive comments from the other groups.
- Conduct a discussion to highlight the following.
Criteria for Assessment and Evaluation

- Names and describes ethical issues in an ICT environment.
- Accepts the need to protect one’s software, hardware and data from unauthorized users.
- Suggests measures to address ethical issues associated with ICT.
- Prepares for preventive action.
- Demonstrates disciplined behavior for social well-being.
Annexe 15.7.1

Script for the Role Play

Vinoth : Oh! I feel terrible.
Bhakya: Why? What’s the matter?
Vinoth : Someone has removed a letter from my diary.
Bhakya: A similar thing happened to me last night. Someone has deleted one of my important files.
Vinoth : You may have deleted it accidentally
Bhakya: No. This type of thing seems to be common now. The mischievous manual acts of those days seem to continue electronically as well. So it’s very important for us to be disciplined and ethical.

Annexe 15.7.2

Instructions for the Group Exploration

Let’s maintain the ethics of ICT

- You will be working in four groups with the following four topics assigned randomly across the groups.
  - Concept of ethics and personal privacy
  - Software theft, Hacking and Access right
  - Harmful actions
  - Encryption technology to minimize harmful actions on internet
- Study the reading material provided to understand the topic well.
- Reflect on your prior experiences on the topic to make a brief presentation to the small groups.
- Listen to the presentations made by your peers to collect ideas on the above.
- Write down the key points relevant to the topic.
- Be prepared to make an innovative whole class presentation at plenary.
Ethical, Legal and social issues

Concept of Ethics

Some definitions of ethics.

• A philosophy that considers what is right and what is wrong.
• Codes of morals of a particular profession.
• The standards of conduct of a given profession.
• Agreement among people to do the right and to avoid wrong.
• The discipline dealing with what is good and what is bad and with moral duty and obligation.
• It is the study of what is right to do in a given situation, and what we ought to do.

Some questions that are needed to be considered regarding issues.

• What information about an individual can be revealed to others?
• What information about individuals that should be kept in databases, and how secure is the information in the computer systems?
• How should one handle data piracy on computer networks.
• Who is allowed to access data and information?
• How can safeguards be introduced to ensure that the information can be accessed only by the right person or organizations?

Computers involve a special technology and they raise some special ethical issues. Computer ethics is the analysis of the nature and social impact of computer technology and the corresponding formulation and justification of policies for the ethical use of such technology. It concerns software as well as hardware and concerns networks connecting computers as well as computers themselves.

The Internet provides access to a variety of information on every topic and this information comes from many different countries throughout the world. One problem with the Internet is that all the information is freely available once a user is connected. There are areas of the Internet, which contain large amounts of illegal material. Material that is illegal in some countries may be perfectly legal in others.

Governments have the problem of finding a way of allowing users to gain access to the Internet but not to any illegal areas. If access to such material is restricted on one part of the Internet a user can simply move to another area to find a way to access the material.

There is a problem in restricting access. The Internet is a global system and it is difficult for single countries to make laws to control it. Another problem with restriction is that it could lead governments to begin attempts to censor, legislate and regulate the Internet for political, cultural and religious reasons. Civil liberty groups are naturally concerned about this aspect of control.
Information Technology has problematic implications and some negative impacts on our society. It poses and creates some problems related to ethics, and contains in general three main types of ethical issues:

**Personal Privacy**

The rapid explosion in the use of computers in the last 15 years has benefited us in many ways. Many things that we now take for granted, such as the use of credit cards and cash dispensers would have been impossible without them. However, there are problems. As more computers are used, more and more information about each of us is stored on computers. By linking the information gained from several computers together it is possible to build up a complete picture of a person’s life.

**Software theft**

As more and more information is held there is the chance of some of it being incorrect. Your private life is becoming less and less private.

It could be said that the use of personal computers has turned many users into thieves. How many people could honestly say that all the software on their hard disks has been purchased by them? As you can see from the Copyright, Designs and Patents Act 1989, it is a criminal offence to copy or steal software.

**Access right**

Due to the current popularity of international commerce on the Internet, the topic of computer security and access right has moved quickly from being a low priority for corporations and government agencies to a high priority. Many attempts of such illegal access by computer hackers have been widely reported. Without implementation of proper computer security policies and strategies, network connections on the Internet can’t be made secure from illegal accesses.

**Harmful action**

In computer ethics, harmful action means injury or negative consequences, such as undesirable loss of information

- Personal privacy
- Access right
- Harmful actions.

Let us look more closely at these issues, exploring in each case the ways in which they affect public reactions to this technological change.

**Personal Privacy**

The rapid explosion in the use of computers in the last 15 years has benefited us in many ways. Many things that we now take for granted, such as the use of credit cards and cash dispensers would have been impossible without them. However, there are problems. As more computers are used, more and more information about each of us is stored on computers. By linking the information gained from several computers together it is possible to build up a complete picture of a person’s life.

**Software theft**

As more and more information is held there is the chance of some of it being incorrect. Your private life is becoming less and less private.

It could be said that the use of personal computers has turned many users into thieves. How many people could honestly say that all the software on their hard disks has been purchased by them? As you can see from the Copyright, Designs and Patents Act 1989, it is a criminal offence to copy or steal software.
Hacking

Hacking means gaining illegal access to someone else’s computer system. Many people see this type of thing as a challenge and not as an illegal activity.

- Loss of property
- Property damage
- Unwanted environmental impacts

This principle prohibits use of computing technology in ways that result in harm to any of users, the general public, employees and employers. Harmful actions include intentional destruction or modification of files and programs leading to serious loss of resources or unnecessary expenditure of human resources such as the time and effort required to purge systems from “Computer Viruses”.

So far there has been relatively little investigation into the privacy and security issues relevant to these ethical problems in IT and Cyberspace. Beside the false contents of information on Internet, many people try to access information that they don’t have rights to. For this reason, computer developers have proposed and used intrusion-detection systems as the basis of security systems designed to protect privacy. Typically, the intrusion detection systems determine if a user is an intruder or a legitimate user, generally by way of various internal system profiles.

Encryption technology to minimize harmful actions on internet

On the Internet, scrambled messages are quite popular as we protect our credit card numbers and private information from enemy hackers. A mathematical technique, called encryption, is used to scramble/encode a message into an unreadable format. The message’s recipient decrypts, or decodes, the data using a key that converts it back into a readable form.

The data can be encrypted in a number of forms: web information transmissions, e-mail, files, transactions, etc.

Such encryption is widely used in

- Online banking transactions
- Internet shopping
- In point-of-sale machines
- Stock trading
- In ATMs
- In electronic business to business transactions

Digital ID

Another form of data protection that is specific for e-mail messages is called “Digital ID”. As more people send confidential information by e-mail, it is increasingly important to be sure that documents sent on e-mail are not forged, and to be certain that messages sent cannot be intercepted and read by anyone other than the intended recipient.
Firewalls

Another protection method against computer crimes is called Firewalls. Internet firewall is essentially one or more systems that control access between computer networks. The firewall serves two basic purposes:

- It controls access to the network from outside users
- It also controls the transfer of information from the inside network to the outside world (Internet).

The most important thing to remember about firewall is that it creates an access control policy for the organization.

In this regard, ethical problems are very important to be understood, realized, and solved legally or technically, not only in one or two countries, but also worldwide.
Competency 15: Compares and contrasts benefits and issues related to ICT in society

Competency Level 15.8: Explores issues and precautions related to ICT with respect to security aspects.

Activity 15.8: Let's investigate issues that occur in ICT.

Time: 40 minutes.

Quality Inputs:

- Some damaged sheets of papers.
- Four copies of the group exploration instructions in Annexe 15.8.1
- Four copies of reading materials in Annex 15.8.2
- Demy sheets and markers.

Learning – Teaching Process:

Step 15.8.1:

- Expose the damaged sheets of papers to the class.
- Conduct a discussion to highlight the following.

- A document can be damaged due to various reasons.
  Examples:
  - Dust
  - Bad usage
  - Insects
  - Temperature
  - Humidity
- If a document is laminated it can be preserved.

Step 15.8.2:

- Divide the class into four groups.
- Provide each group with copies of group exploration instructions, reading material, demy sheets and markers.
- Assign randomly the four topics to four groups and involve them in exploration.
- Prepare groups for a presentation at the plenary session.

(10 minutes)

Step 15.8.3:

- Get each group to present its findings.
- Request the presenters themselves to fill in any gaps they have left.
- Invite constructive comments from the other groups.

(15 minutes)
• Conduct a discussion to highlight the following.

- A computer should be protected from dust, moisture and smoke.
- Your computer should be equipped with a UPS, Surge protection, Stabilizer
- The software and the data in the computer can be protected through the use of passwords and backups
- Viruses, worms and Trojan horses can harm the computer and the software.
- Antivirus Software and Firewall are used to protect the computer from Viruses, worms and Trojan horses

(15 minutes)

Criteria for Assessment and Evaluation

- Names and describes the issues related to ICT with respect to security aspects.
- Accepts that Computers should be used carefully in order to protect them and the data.
- Analyses issues and precautions related to ICT
- Uses reflection as a tool for learning.
- Makes other people aware of the threats that effect ICT.
Annexe 15.8.1

Instructions for the Group Exploration

Let's investigate the issues related to ICT with respect to security aspects

• You will be working in four groups with the following topics assigned randomly across the groups
  o Physical Issues.
  o Malicious codes
  o Combating Viruses, Worms and Trojan Horses
  o Key terms to Understanding Computer Viruses.

• Go through the reading material provided to understand the topic well.
• Reflect on your prior experiences of the topic to make a brief presentation to your group.
• Listen to the presentations made by your peers to collect ideas on the following
  o Physical security of a computer
  o Viruses, worms and Trojan Horses
  o How viruses, worms and Trojan Horses can be prevented
• Be prepared to make an innovative whole class presentation.

Annexe 15.8.2

Reading Material

Issues and precautions related to ICT

Physical Issues

Environmental factors
Your computer should be kept in a
  • Dust free
  • Dry (moisture free)
  • Smoke free environment

Hardware protection
Your computer should be equipped with
  • A UPS (Uninterrupted Power Supplier) to avoid risk of sudden power failure and fluctuations.
  • Surge protection to protect against lightning and thunder.
  • Stabilizer to control voltage.
Logical security

The software and the data in your computer can be protected through the use of
- Password
- Backups

Malicious codes

A common misconception is that other kinds of electronic nasties such as worms and Trojan horse applications are viruses.
Viruses, worms and Trojan horse belong to a broader category called “malicious codes”.

Virus

A program or piece of code that is loaded onto your computer without your knowledge and runs against your wishes. Like any other program, it contains instructions that tell your computer what to do.

- Viruses can also replicate themselves.
- All computer viruses are man made.
- A simple virus that can make a copy of itself over again is relatively easy to produce.
- A virus can be destructive; it could format your hard drive, overwrite your hard drive boot sector or delete files and render your machine inoperative.
- Even such a simple virus is dangerous because it will quickly use all available memory and bring the system to a halt.
- An even more dangerous type of virus is one capable of transmitting itself across networks and bypassing security systems.

How do viruses invade a machine?

- E-mail or an e-mail attachment
- Downloads
- Shared infected floppy disks
- Hacking (Occasionally)

Combating Viruses, Worms and Trojan Horses

The first step to protecting your computer is to ensure your operating system (OS) is up-to-date. This is essential if you are running Microsoft Windows OS.

Secondly, you should have anti-virus software installed on your system and ensure you download updates frequently to ensure your software has the latest fixes for new viruses, worms and Trojan horses. Additionally, you want to make sure your anti-virus program has the capability to scan e-mail and files as they are downloaded from the Internet. This will help prevent malicious programs from even reaching your computer. You should also install a firewall as well.

Antivirus Software

Antivirus software can detect nearly all types of known viruses, but it must be updated regularly to maintain effectiveness.

Firewall

A firewall is a system that prevents unauthorized use and access to your computer. A firewall can be either hardware or software. Hardware firewalls provide a strong degree of protection from most forms of attack from the outside world can be purchased as a stand alone product or in broadband routers.
For individual home users, the most popular firewall choice is a software firewall

**Key terms to Understanding Computer Viruses.**

**Virus**
A program or piece of code that is loaded onto your computer without your knowledge and runs against your wishes.

**Trojan Horse**
A destructive program that masquerades as a benign application. Unlike viruses, Trojan horses do not replicate themselves.

**Worm**
A program or algorithm that replicates itself over a computer network and usually performs malicious actions.

**Blended program**
Blended threats combine the characteristics of viruses, worms, Trojan Horses and malicious code with server and Internet vulnerabilities.

**Antivirus program**
A utility that searches a hard disk for viruses and removes any that are found
Competency 15: Compares and contrasts benefits and issues related to ICT in society

Competency Level 15.9: Investigates health and safety issues inherent in ICT use.

Activity 15.9.: Let's investigate health and safety issues

Time: 40 minutes.

Quality Inputs:
- Three copies of group exploration instructions in Annexe 15.9.1
- Three copies of reading materials in Annexe 15.9.2
- Demy sheets and markers.

Learning – Teaching Process:

Step 15.9.1: Pose the question to the class whether they have experienced injuries while using any kind of equipment at home.
- Conduct a discussion to highlight the following.
  - Injuries and other health problems can occur when using various equipment at home.
  - Such accidents can be avoided by adopting proper precautions.
  - Equipment such as the iron can cause domestic injuries.
  - The computer is another.

(10 minutes)

Step 15.9.2: Divide the class into three groups.
- Provide each group with copies of reading material, demy sheets and markers.
- Assign randomly the three topics to the three groups and involve them in exploration.
- Prepare groups for a whole class presentation at the plenary session.

(15 minutes)

Step 15.9.3: Get each group to present its findings.
- Request the presenters themselves to fill in any gaps they have left.
- Invite constructive comments from the other groups.
Conduct a discussion to highlight the following.

- Using a computer can affect different parts of our body like fingers, hands, wrists, arms, shoulders, neck, back and eyes.
- Correct posture when sitting can prevent physical inconveniences.
- Some hints on staying healthy at the computers are
  - sitting comfortably in your chair.
  - keeping keyboard close in front of us.
  - Trying to keep your wrists straight and level with your lower arms while typing.
  - Eye strains could be minimized by exercising some precautionary measures such as blinking eyes frequently.

Criteria for Assessment and Evaluation

- Names and describes the hazards we experience when using ICT technology tools.
- Accepts that precautionary actions will prevent health hazards.
- Takes precautionary actions while using computers.
- Uses ICT tools with utmost care.
- Makes optimal use of resources through awareness of their potential.
Annexe 15.9.1

Instructions for the Group Exploration

Let's investigate health and safety issues related to ICT

- You will be working in three groups with the following topics assigned randomly across the groups.
  - Bodies and sitting
    - Correct posture
    - Fitting the right chair
    - Position of the System and Computer slump
  - Keyboarding and mousing using fingers
    - Straight Shot
    - Squeeze Play
    - Natural Curve
  - Eye strains
    - Monitor position
    - Blinding Light Washout
    - Break Away
- Study the reading material provided to understand the topic well.
- Reflect on your prior experiences on the topic to make a brief presentation to the small groups.
- Listen to the presentations made by your peers to collect ideas.
- Write down the key points relevant to the topics discussed with your peers.
- Be prepared to make an innovative whole class presentation.

Annexe 15.9.2

Reading Material

Health and safety issues inherent in ICT

Using a computer can affect different parts of your body, like your fingers, hands, wrists, arms, shoulders, neck, back, and eyes. While computers look safe enough, there are some dangers that are good to know about, and you will want to avoid them as much as possible. Read on for some hints on staying healthy at the computer.
Repetitive Stress Injuries

Bodies

- If you have to use unsuitable chairs and desks for computing, you may be uncomfortable sitting and have awkward arm and head positions.
- There are some things you can do to feel more comfortable and protect your body at the same time. Let us see what can go wrong and how we can fix it!

Sitting

- Your body does not move much when using the computer, so you want to make sure you are sitting comfortably in your chair. Fitting the Chair to You

  - Pillows, pads, boxes, and big books can be used to help make the chair fit you better. If your feet don't reach the floor, use a footrest, or ask if you can stack up some thick books or a box under your feet.
  - Pillows and pads can take up all that extra seat room. This way you have something to lean back against and your feet to rest on.

Fitting the Chair to the Computer

- If you have a chair that fits you, but the computer is on a table that is too high, pillows and pads can also be used to help you sit higher if you need to. If that does not work, try a larger chair or maybe a smaller computer table can be found.
- The computer keyboard should be about as high as your belly -- not chest or shoulder height where you have to reach up to use it. Your arms, shoulder, and neck can get sore fast if the keyboard is too high for you!
Perfect Fit!

- If you don't have any of the problems above, you may be one of the lucky ones that actually have a chair and computer table that fits!

![Computer Slump Image]

**Computer Slump**

- Even with the perfect chair and computer table, you need to remember to lean back in your chair and rest on the backrest when you are typing. Don't slouch or lean forward, as this is bad on your back! Get into the habit of keeping a good back posture now and you will be happy for a long time.

- *But this is not the only thing you need to watch . . .*

  **Keyboarding**

  - When you use the keyboard, keep it close in front of you. Don't put it so far back that you need to reach forward to use it.

  **Straight Shot**

  - Try to keep your wrists straight and level with your lower arms while you type. Avoid bending your wrists too much as it makes it harder for your fingers to work and could hurt your wrist over time. Some kids like wrist rests in front of keyboards to help keep their wrists straight, but don't rest on them while typing.

  ![Straight Shot Images]

  **Natural Curve**

  - Your fingers have a natural curve, like a rainbow or waterfall. Allow your fingers to keep their curve as you type -- don't stretch and flatten them too much while typing.

  ![Natural Curve Images]

  **Home Stretch**

  - If you know how to rest on the home row and touch type, remember to move the whole hand to reach far-away keys . . . don't make your fingers stretch too far from home. Sometimes keyboards are too big for small fingers, move the hand to the keys and keep your fingers happy.

  **Thor's Hammer vs. Butterfly Dance**
• Type lightly. You don't need to pound on the keys like thunder . . . a light touch will work fine -- think of your fingers as butterflies dancing on the keys.

Mousing

• Almost all computers have mice now. They are nice to point with and move things around on the computer, but you need to watch how you use them -- otherwise they might turn around and bite you.

Squeeze Play

• Some people like to hold the mouse tightly. However, like hitting keyboard keys too hard, it is not a good idea. Use a light touch on the mouse while holding it as well as clicking its button(s). Too much force on the mouse tires the hands and arms using it -- a form of mouse bite!
• Computer mice may be too big for hands. You might try looking for a smaller mouse or use a trackball that does not need to be held, and you can also use several fingers at once to move the ball.

Straight Shot

• Like when using the keyboard, try to keep your wrists straight and level while mousing around!
Wrist rests can be helpful here as well. Many mouse pads come with built-in wrist rests to help keep straight wrists.

Eye Strains

Left, Right, High, Low . . . Where does the Monitor Go?

• The computer monitor (screen) should be right in front of you and a little lower than your eyes. By having the monitor off to the side or too high or low, you can end up being a real headache . . . not to mention that the neck and shoulders will surely hurt as well.
• Remember that where the eyes go, the body follows. If you have to look to the side, up, or down, then your head and neck turn as well. Having the monitor too low can also cause you to slump in your chair as well.
• Sometimes the monitor sits on the
computer case, so by moving the computer case to the side, the monitor can be lowered. If you need to raise the monitor, a few books underneath it will usually do the trick. There is also the option of adjusting yourself -- maybe you can adjust the height of your chair until you are in the right place.

**Blinding Light**

- Windows and indoor lights can make it harder to use computer monitors. It is hard on the eyes to try to adapt to see the monitor when there is a bright light that can also be seen at the same time (direct glare). There should be about the same amount of light coming from the screen and the area you can see around the computer monitor. Moving the computer so that windows and lights are not in front of you, or putting a shade over windows and lights, can help to avoid this problem.

**Washout**

- Another problem with light is that it can come from behind you and bounce off of the computer screen (indirect glare). When this happens it becomes harder to read what is on the screen. Moving the light or the computer may also be possible to solve the problem. Otherwise, a monitor hood or glare screen may be needed.

**Break Away**

- Time can pass very fast when you are at the computer, or playing video games. It is important to do lots of different things during the day. Our bodies are not intended to hit keyboard, mice, and game controller keys for hours straight. Take a break and get away from the computer about every 30 minutes or so -- whether or not you feel an ache or pain. And if you do feel an ache or pain, that's a sure clue that you need to stop for a little while! Make sure to listen to your body's signals . . . it may be a cry for help!

**Get up and move around for a few minutes, some ideas are:**

- Take a quick walk around the house or apartment
- Call a friend and see how her work on the computer is going
- If you're hungry, grab a snack to give you some energy
- Anything you do is OK, as long as it gets you to rest the muscles you've been using and use the muscles you've been resting.
- Pay special attention to your eyes, too: if they hurt or your eyelids twitch, you should stop for a bit. Looking away from the monitor every once in a while and focusing on something far away for a few seconds or blinking eyes frequently should give your eye muscles enough of a workout to keep them feeling OK.

**Real World**

- Cyberspace and other computer uses can be educational and fun, but nothing compares to adventures and activities in the "real world". Don't get lost in cyberspace . . . get out and explore the world around you.
Health

- Eating good food and exercise are great ways to stay healthy. The healthier you are and the more you vary your activities throughout the day will help in avoiding problems from using the computer.
- Taking care of your body while at the computer means you'll feel better - and be able to work and play better.
Competency 15: Compares and contrasts benefits and issues related to ICT in society

Competency Level 15.10: Assesses social issues inherent in ICT use.

Activity 15.10: Let’s investigate the social issues inherent in ICT

Time: 40 minutes.

Quality Inputs:
- Two pictures of two children Annexe 15.10.1
- Two copies of the group exploration instructions in Annexe 15.10.2
- Two copies of reading materials in Annexe 15.10.3
- Demy sheets and markers.

Learning – Teaching Process:

Step 15.10.1:
- Expose the two pictures to the class.
- Conduct a discussion to highlight the following.
  - There are rich and poor people in the world.
  - The rich people have everything where as poor people suffering from hunger.
  - Poverty is a serious social issue in the world.
  - Many organizations and all the governments try to solve this issue.

(10 minutes)

Step 15.10.2:
- Divide the class into two groups.
- Provide each group with copies of group exploration instructions, reading material, demy sheets and markers.
- Assign randomly the two topics to two groups and involve them in exploration.
- Prepare groups for a presentation at the plenary session.

(15 minutes)

Step 15.10.3:
- Get each group to present its findings.
- Request the presenters themselves to fill in any gaps they have left.
- Invite constructive comments of other groups.
- Conduct a discussion to highlight the following.
The Digital Divide is the gap between those individuals and communities that have, and those that do not have, access to the information technologies.

The action taken to fill this gap is called the digital bridge.

Many traditional jobs are in trouble due to the techno-rich employment opportunities.

Criteria for Assessment and Evaluation

- Names and describes the social issues related to ICT.
- Accepts that there is a gap between those who use ICT and those who do not use.
- Demonstrates the ability to reduce the digital divide
- Get used to Minimizing the disparity
- Escapes social evils.
Instructions for the Group Exploration

Let’s investigate the role of ICT in health Services

• You will be working in three groups with the following issues assigned randomly across the groups

The Digital Divide is most commonly defined as the gap between those individuals and communities that have, and those that do not have, access to the information technologies that are transforming our lives.
  - Digital Divide
  - Bridging Digital Divide
  - Techno-rich employment

• Go through the reading material provided to understand the topic well.

• Reflect on your prior experiences on the topic to make a brief presentation to the small groups.

• Listen to the presentations made by your peers to get ideas about the following
  - What is digital divide
  - Actions that can be taken against the digital divide
  - New employment opportunities based on ICT and the social issues arising from it

• Be prepared to make an innovative whole class presentation.

Reading Material

What is the Digital Divide?
Simply speaking; Digital Divide refers to the inequality in access to information technology, including computers, Internet and other digital equipments. Those who have access to and have the ability to use digital information easily are referred to as the “haves”, while the others are the “have-nots”.

Bridging the Digital Divide

Raise awareness of the issue in the community
“Together we are better”. A united effort is needed to bridge the Digital Divide. Get empowered with knowledge so you can educate and rally your peers to bridge the gap.

Donate used computers to schools
Second-hand computers can be donated to organizations, which in turn distribute them to schools in need.
Build websites for specific social groups
Lack of Websites of interest discourages users from minor social groups to use information technology. By building Websites of interest targeting these at these users, you can help to bridge the content gap.

Use IT in teaching
There is a significant shortage of teachers with IT literacy who can enrich the students’ learning experience with modern technology.

Building Computer Skills of Low-Income People.

Techno-rich employment opportunities
With the development of Information and Communication Technology lot of new employment opportunities have surfaced. Some of them are,

1. Data entry operator
2. Computer operator
3. Programmer
4. Software developer
5. System analyst
6. Software engineer
7. Hardware engineer
8. Network administrator
9. IT manager
10. Web developer
11. Desktop publishing
12. Computer applications assistant

The new technological employment advance has become a threat to talented person’s jobs. For example a creative artist loses his job because of the modern features available in desktop publishing. So this issue should be solved.
Part 3

Assessment and Evaluation
Introduction

Assessment and Evaluation can be identified as two interconnected programs that can be conveniently implemented in the classroom in order to identify the levels of competence achieved by students to ensure that the students have actualized the expected learning outcomes through the learning-teaching process. If the assessment is implemented properly, it is not difficult for all the students studying in the class to acquire a competency at least proximate to the relevant skill. On the other hand, what evaluation expects is to identify what the levels of competency the students have achieved are.

Teachers involved in assessment can provide their students with guidance of two types. This guidance is commonly called “feedback” and “feed forward”. When the weaknesses and abilities of students are discovered, it is the task of the teacher to provide feedback in order to overcome their learning difficulties and to provide feed forward to improve their skills when their abilities and strengths are discovered.

It is necessary that students find out as to which competencies in the course they have been able to actualize and the relevant levels for the success of the learning-teaching process. Accordingly, determination of the levels of competency students have achieved through the program of evaluation and the communication of student progress to parents as well as other relevant sections, is expected of the teacher.

This curriculum comprises a student centered, competency-based, activity oriented approach. The transformation role of the teacher and learning through action becomes the core for the purpose of making life meaningful.

An attempt has been made to integrate assessment and evaluation with the learning and teaching of the curriculum implemented through a series of activities developed in the past. When students are involved in exploration under the second step of each activity, the teacher will be able to subject them to assessment, and to evaluation when students present their findings and subject same to elaboration.

The teacher is expected to move among the students engaged in exploration, observe the tasks they are involved in, help them to solve, in the classroom itself, any problems they happen to encounter and provide them facilities and guidance.

Five common criteria are suggested to facilitate the task of assessment and evaluation. Out of these criteria, the first three criteria are based on knowledge, skills and attitudes that combine to develop
each competency. The two final criteria support students in the inculcation of two attitudes important in their life. The teacher should make an effort to identify these criteria and the five behavioral changes within the classroom itself while the students are active and strengthen them under assessment and quantify these behaviors under evaluation.

The third part of the course guide has been planned in order to introduce the suggested evaluation points and instruments of evaluation selected for this purpose. In this manner, students will be able to involve themselves in learning with interest and motivation while the learning teaching process is further broadened as a result of the evaluation process being implemented between as well as in the course of activities.
Instruments for Extension of Learning and Teaching

1. **Extension Stage**: Term 1, Instrument 1

2. **Objectives**
   - To develop a solution to a given problem using a suitable algorithm
   - To design an interface and convert the algorithm into a program
   - To test the program using the computer.

3. **Competency levels covered**: 10.1, 10.2, 10.4, 10.5, 10.6, 10.7, 10.8, 10.9, 10.10, 10.11, 10.12, 10.13, 10.14

4. **Subject content covered**
   - Definition of algorithm.
   - Control structures used for developing algorithms
   - Tools for developing algorithms
   - Components of Integrated Development Environment (IDE)
   - Selection of controls and setting their properties
   - Controls for data input, output
   - Conversion process
   - Data types, variables and constants
   - Types of operators and operator precedence
   - Events of controls and methods
   - Selection of control structures
   - Methods for using multiple conditions
   - Repetitions
   - Arrays

5. **Nature of Instrument**: Practical test to investigate ability in the use of programming languages for problem solving.

6. **Instructions for implementation**:
   - **For teachers:**
     - At the commencement of activity 10.1, tell students that they have to develop a program to solve a problem identified on the basis of one of the samples given below. Tell students that they should
       - Provide the algorithm by a flow chart.
       - Provide Visual Basic (VB) codes for the algorithm.
       - Demonstrate VB program on the computer.
       - Also inform them of the following aspects to be included in the solution developed.
       - Use of all three control structures (sequence, selection and iteration)
       - User interface for input and output
       - Use of arrays
       - The problem selected by the student for developing the VB program should represent one of the following examples.
Example 1

- To store heights of students in an array.
- To calculate the average height of students.
- To find out the number of students in the short, medium and tall categories using the following criteria.
  - Short: Below or equal to 5 feet
  - Medium: above 5 feet and below 5 feet 6 inches
  - Tall: above 5 feet 6 inches
- Develop a method for rejecting impossible values for height input.

Example 2

- To record the teacher led instructional periods per month for one's own class.
- To calculate the average number of such periods a day.
- To categorize the number of instructional periods a day as follows:
  - Less than four: Bad
  - Four to six: Good
  - Seven to eight: Excellent
- Your program should have a method for rejecting impossible values for the number of periods a day.

- Schedule the practical test and inform the date well in advance to the students.
- Use the criteria suggested under section 6 to give feedback on both theoretical and practical abilities developed by students.

❖ For students:

- Identify a problem similar to the examples given.
- List the inputs and outputs of the program.
- Develop the algorithm and draw the relevant flow chart.
- Write the relevant VB code on a sheet.
- Design the user interface.
- Prepare to demonstrate your program on the computer, to justify your actions and to present the problems you have encountered with methods for solving them.
- Discuss the proficiency level you have reached with your teacher and take action for further improvement.
6. Format for assessment and evaluation:

<table>
<thead>
<tr>
<th>Student Names</th>
<th>Use of keywords and syntax in the program</th>
<th>Design of input/output interface</th>
<th>Design of correct algorithm</th>
<th>Presentatio n of program, problems and solutions</th>
<th>Justification of one’s own actions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Proficiency Levels**
  - A – Excellent
  - B - Good
  - C - Average
  - D - Should Improve
Instruments For the Extension of the Learning-Teaching Process

1. **Extension Stage**: Term 2, Instrument 2

2. **Objectives**: To develop a simple website incorporating multimedia technology

3. **Competency levels covered**: 12.1 and 12.2

4. **Subject content covered**: Using Search engines, Accessing websites, Downloading and saving information, Sending mails with attachments

5. **Nature of Instrument**: Practical test for searching a web site for sending relevant information to an outsider.

6. **Instructions for implementation**:

   - **For teachers**:
     - At the commencement of activity 12.1 tell students that they have to get information from websites to be sent to an outside party via e mail.
     - Tell students that they have to access the website of the Department of Examinations from the Internet to inform a friend presently residing in the UK of his/her GCE (OL) results.
     - Get students to use the index number to download the detailed results and save it as a word file.
     - Ask them to send an email to the friend in the UK with the detailed result as an attachment.
     - Tell them that their performance in the above task will be evaluated on the basis of the criteria given in section 6.
     - Schedule the practical test and inform the dates to the students well in advance.
     - On the day of the practical test, get students to explain what they have done, justify their actions and the efficiency of the Internet, and report the problems that they have encountered along with the solutions tied out.
     - Use the criteria suggested to give feedback on the practical abilities acquired by the students.

   - **For students**:
     - Imagine that you have a friend in the UK who sat the GCE (OL) examination and went abroad before the results were released.
o Imagine that he/she has contacted you recently and given his index number to get his/her results as early as possible.
o Use a search engine and access the website of the Department of Examinations.
o Locate where GCE (OL) results are available.
o Enter index number and get the result needed.
o Save it in a word document
o Send same to your friend in the UK as an attachment to your email
o Discuss with your teacher and identify the proficiency level you have reached and what action you should take to improve further.

7. Format for assessment and evaluation:

<table>
<thead>
<tr>
<th>Student Name</th>
<th>Knowledge on methods used to search information</th>
<th>Skill in using search engines and downloading information</th>
<th>Skill in sending email with attachment</th>
<th>Ability to make clear presentations</th>
<th>Ability to demonstrate the efficiency of the Internet in dealing with information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Proficiency Levels
  A - Excellent
  B - Good
  C - Average
  D - Should Improve
Instruments for the Extension of Learning and Teaching

1. **Extension Stage**: Term 2, Instrument 2

2. **Objectives**: To develop a multimedia product with animation and sound

3. **Competency levels covered**: 13.1, 13.2, 13.3, and 13.4

4. **Subject content covered**: Designing graphics and logos
   Photograph editing.
   Creating animations
   Sound recording and editing
   Integration of Multimedia contents

5. **Nature of Instrument**: Practical test to identify knowledge and skills acquired for developing a multimedia product.

6. **Instructions for implementation**:
   
   ❖ **For teachers**:
   
   - At the commencement of activity 13.1, tell students that they have to develop a multimedia product to cover the following.
   - Illustrations – graphics, text, animations and audio – relevant to the product with sub titles in own words.
   - Still graphics and audio clips supplied or similar items selected by themselves.
   - Also inform them of the need to justify the items they have selected.
   - Tell them that their performance with respect to the above task will be evaluated on the basis of the criteria given in section 6.
   - Schedule the practical test and inform the students of the dates well in advance.
   - Get students to present what they have done, justify their actions, and report on problems encountered with solutions tried out for the problems.
   - Use criteria suggested to provide feedback on the practical abilities developed by students.

   ❖ **For students**:
   
   - Decide on a suitable multimedia product that incorporates graphics, text, animations and audio.
   - Use the still graphics and the audio clips supplied to develop the product or select suitable items indicating their sources.
   - Use a still graphic as the background of your animation.
   - Identify suitable objects and create them for animation.
   - Integrate sounds to suit the animation created.
   - Ensure that the final product covers the four areas mentioned previously.
   - Justify the multimedia contents you have used in the product.
   - Discuss with your teacher the proficiency level you have reached and what action you should take for further improvement.
7. Format for assessment and evaluation:

<table>
<thead>
<tr>
<th>Student Name</th>
<th>Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The value of the idea expressed by the product as a whole</td>
</tr>
</tbody>
</table>

- **Proficiency Levels**
  - A - Excellent
  - B - Good
  - C - Average
  - D - Should Improve
Instruments For the Extension of the Learning-Teaching Process

1. Extension Stage : Term 3, Instrument 1

2. Objectives : To develop a simple website incorporating multimedia technology

3. Competency levels covered: 14.1, 12.2, and 14.3

4. Subject content covered : Components of a web site
   Text organization techniques
   Integrating multimedia
   Mouse pointer changes
   Links
   Web authoring tools
   HTML Tags


6. Instructions for implementation:
   ✤ For teachers:
     o At the commencement of activity 14.1, tell students that they have to develop a simple website incorporating multimedia technology.
     o Get students to select suitable topics for their websites.
     o Ask students to collect information and the topic. Information should include Image, Video, Animation, and audio as far as possible.
     o Ask students to prepare the overview of the website and get the teacher’s approval and comments.
     o The selected design should be done by students based on the review document.
     o Ask students to develop the website using the FrontPage.
     o Inform students to submit the developed website along with the designed document.
     o Provide justification for the use of multimedia and their relevance.
     o Tell them that their performance with respect to the above will be evaluated taking into consideration their work ethics.
     o Schedule the practical test and inform the dates to the students well in advance..
     o Get students to justify their actions, identify errors, and report same to the class with what they had done to overcome the errors.
     o Use the criteria suggested to give feedback on practical abilities developed.

   ✤ For students:
     o Decide on a suitable topic to create a web site.
Design the overview of website
Get teacher’s approval for the product above.
Ensure that the design is based on the overview document
Develop website using FrontPage.
Submit website developed along with designed document
Discuss with your teacher the proficiency level you have reached and what action is required to be taken to improve same.

7. Format for assessment and evaluation:

<table>
<thead>
<tr>
<th>Student Name</th>
<th>Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Demonstration of structuring techniques of information</td>
</tr>
<tr>
<td></td>
<td>Use of Text formatting, inclusion of multimedia and use of hyperlinks.</td>
</tr>
<tr>
<td></td>
<td>Simple and informative layout of Website</td>
</tr>
<tr>
<td></td>
<td>Concern for neatness in preparing documents</td>
</tr>
<tr>
<td></td>
<td>Creativity</td>
</tr>
</tbody>
</table>

- **Proficiency Levels**
  - A – Excellent
  - B - Good
  - C - Average
  - D - Should Improve
Instruments for Extension of Learning and Teaching

1. **Extension Stage**: Term 3, Instrument 2

2. **Objectives**: To develop a wall newspaper on the theoretical knowledge gained.

3. **Competency levels covered**: 15.1, 15.2, 15.3, 15.4, 15.5

4. **Subject content covered**: ICT in Health services, ICT in Education, ICT in Agriculture, ICT in Industries, ICT in Business

5. **Nature of Instrument**: Practical test based on completed assignment.

6. **Instructions for implementation**:
   - **For teachers**:
     - At the commencement of activity 15.1, tell students that they have to develop a wall newspaper to cover the following.
     - Illustrations – pictures relevant to the sections above with descriptions in own words.
     - Examples: e-channeling, e-learning, milking system, robots, on-line shopping and freight booking, e-banking,
     - Justification of their use.
     - Sources of information presented.
     - Tell them that their performance with respect to the above will be evaluated taking into consideration their work ethics.

   - **For students**:
     - Decide on a suitable format for the wall newspaper.
     - Decide on possible sources.
     - Ensure that each area gets fair coverage.
     - Collect pictures/drawings related to ICT in society.
     - Write brief descriptions to explain the pictures collected.
     - Indicate your sources of information.
     - Justify your choices for the wall newspaper.
     - Discuss with your teacher the proficiency level you have reached and what action you would take to develop it further.
7. Format for assessment and evaluation:

<table>
<thead>
<tr>
<th>Student Name</th>
<th>Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Adequacy of material collected</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Proficiency Levels**
  - A – Excellent
  - B – Good
  - C – Average
  - D – Should Improve
Prototype Question

The Past Students’ Association (PPA) of Ratna Vidyalaya decides to develop a web site to publish school information. The members want the web site to contain five web pages covering five important aspects of the school, and the PPA, SDS and the Lions’ Society listed as the major patrons in the homepage itself. Assuming that you are a member of the committee formed to develop the above website, find answers to the following questions.

(i) Design the layout of the homepage. (04 marks)
(ii) Illustrate similarities and differences between the home page and the web page designed for the past students. (01 mark)
(iii) List the two major tasks to be performed in publishing the web site. (02 marks)
(iv) Select one of the tasks mentioned under (iii) above, and explain its functions. (02 mark)
(v) Write the HTML code required to display the bulleted list of patrons indicated in the homepage. (03 marks)